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i-Tree Eco software provides a broad picture of the urban forest or trees in your study area. It is 

designed to use field data from complete inventories of trees or randomly located plots throughout 

a community along with local hourly air pollution and meteorological data to quantify urban forest 

structure, environmental effects, and value to communities. Managers or researchers can use the 

baseline data to make effective resource management decisions, develop policy, and set priorities. 

 

From project start to finish, Eco is a complete package that provides users with the following 

components: 

• Detailed, statistically based sampling and data collection protocols. These protocols allow 

for estimation of totals and variation related to urban forest structure and population effects. 

• A mobile data collector for web-enabled smartphones, tablets, or similar devices that can 

be used for field data collection. 

• A central computing engine that makes scientifically based estimates of the effects of urban 

forests using peer-reviewed scientific equations to predict environmental and economic 

benefits. 

• Summary reports including charts, tables, and a written report. 

 

 

 

 

 

 

 

 

 

Though i-Tree Eco was originally developed for the United States, growing interest among 

international urban foresters has spurred improved model functionality in other countries as time 

and limited resources have permitted. 

 

Supported Countries 

Eco v6.0 has been adapted for use throughout Canada, Mexico, Australia, the United Kingdom 

and Europe with the necessary species information, location information, and pollution and 

weather data preprocessed and available in the application.  

About i-Tree Eco 

 International Projects 

 

 

To install the i-Tree Eco software, please see the Eco Guide to Installing 

Software for system requirements and installation instructions. 

Eco Guide  

http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_InstallingEco.pdf
http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_InstallingEco.pdf
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Completing an i-Tree Eco analysis can seem like a daunting task, so here are the most important 
things you need to know about using this software: 
 

• Eco projects are highly customizable and thus require a significant amount of planning. 
 

• The Eco model uses field data to estimate forest structure, function, and benefits so you 
will be required to collect data for the individual trees in your study area. 

 
This manual will walk you through the stepwise process of completing an i-Tree Eco project by 
describing the following project phases in more detail: 
 

Phase I: Planning For Your Project 
There are many decisions to be made in order to customize your Eco project. To help you 
work through this planning phase, we have provided a simple decision tree that will guide 
you through the questions that must be answered. 
 
Phase II: Setting Up Your Project 
Once you have planned what type of project you will be doing, you can begin setting up 
your project. Depending on your answers in Phase I, you may need to gather additional 
data or create your sample. Here we will guide you through those next steps. 
 
Phase III A & B: Collecting Your Field Data 
After Phase II is complete, you are ready to move to the data collection phase! In this 
section of the manual, we will help you decide what data you will collect in the field and 
exactly how to take the necessary measurements and collect that data. 
 
Phase IV: Working with Eco 
After you have collected your field data, you will be ready to work directly with the i-Tree 
Eco software. In this section, we will describe each of the components of the user interface 
in detail and walk you through the process of entering or editing your field data.  
 
Phase V: Viewing Your Reports 
Eco provides a large variety of output data in the form of charts, tables, and reports. This 
section of the manual describes what results are available and how to view them. 

 
  

The Eco V6.0 Rundown 

 

 

Supplement the basic knowledge that can be gained from this manual with 

the topic-specific information in the Eco Guides. That way, you can choose to 

read about the topics that are relevant to your custom project. 

Tip 

http://www.itreetools.org/resources/manuals.php
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Before you get started with Eco there are several decisions that must be made. Use this simple 

decision tree as a guide for Phase I. As you can see, not every question will be relevant to your 

Eco project. In the remainder of this section of the manual, we’ll provide you with more information 

to help answer these questions. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Phase I: Planning For Your Project 

 Decision Tree 

 

 

i-Tree Eco users have developed a number of documents to help others with 

many aspects of project planning and management. These are an excellent 

resource and can be found at www.itreetools.org under Resources > 

Archives > i-Tree Eco Project Planning & Management Resources. 

Tip 

What are the boundaries of your study 

area? 

Will you stratify your 

sample? 

What type of inventory will you do? 

How big will your plots 

be? 

How many plots will you 

inventory? 

Complete Inventory Plot-Based Sample 

Inventory 
Do you have an existing 

inventory? 

Project Basics 

http://www.itreetools.org/


 

 4 

 

Designing a new i-Tree Eco project requires some early decision-making and planning. You must 

define the boundaries of your study area, determine what type of project is most suitable for your 

objectives, and decide what data you will be collecting in the field. 

What are the boundaries of your study area? 

An Eco analysis can be done for an entire city, a neighborhood, a park, or even a backyard. 

What type of Eco inventory will you do? 

A typical Eco project can involve a complete ground-based inventory simplified by dividing the 

entire Urban Forest resource into sections and inventorying every tree in each section. A plot-

based sample inventory involves inventorying a series of sample plots distributed across a city, a 

large university campus, or some other broad, diverse landscape.  

 

If you decide to do a plot-based sample inventory, skip to the Plot-Based Sample Inventory 

section. Otherwise, read the Complete Inventory section below and then go to Phase II: Setting 

Up Your Project.  

 

 
If you have decided to conduct a complete inventory, you will be collecting data for all of the 

trees located in your study area. In this type of project, you can choose to stratify or subdivide your 

trees by smaller units, such as land uses or zones, which can help clarify differences across the 

study area. Your Eco results will be estimated for all the trees in your study area as well as by 

strata. The decision to stratify should ultimately be based on your current and future project 

objectives and available resources. 

Do you have an existing inventory? 

Users interested in analyzing an existing inventory now have the option to import their existing 

complete inventory data into Eco.  

 

First, you will need to format your existing inventory. i-Tree Eco’s inventory import tool works best 

with a properly formatted dataset. This means that existing data should be saved as a specific file 

type and include all of the required variables. Each individual data variable also has its own 

formatting requirements that must be adhered to. 

 

 

 

What file type is best? 

Save your inventory data as one of the following file types: 

 Project Basics 

 Complete Inventory 
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• Excel spreadsheet (.xls or .xlsx) 

• Access database (.mdb or .accdb) 

• Comma separated values (.csv) 

 

What data are required? 

i-Tree Eco v6.0 has been modified so that users are now required to collect only two 

measurements of trees to complete an Eco project. The reduction in required data has been made 

to accommodate users with existing street tree inventory data, which oftentimes does not include 

all of the previously required tree measurements. 

The following two data variables must be included in your existing inventory: 

• Species: The species and genus names of each tree assessed. 

• Diameter at breast height (DBH): The tree stem diameter at breast height (1.37 meters 

above planted grade) for each tree. 

 

For users collecting dead trees, an additional data variable is required for your existing inventory. 

Users must collect: 

• Crown health: Tree crown health estimated as condition or dieback (i.e., dead branches) 

of the crown. 

 

The crown health variable is used to indicate which sampled trees are dead and which are not. 

Dead trees should be given either a 100% dieback or 0% condition designation depending on 

which variable you decide to provide. Refer to Phase IIIB for additional information on collecting 

crown health and designating dead trees in the field. 

 

Be aware that some additional analyses require certain data to be collected beyond species and 

DBH. Please refer to Phase IIIB for more information on the data requirements for supplemental 

analyses. 

How do I format each data variable? 

In addition to the two required data variables (species and DBH), users are allowed to import any 

or all of the inventory data shown in Table 1. Each individual data variable has its own formatting 

requirements. 

 

 

i-Tree Eco requires users to collect two tree measurements. While this approach 

allows users with limited existing inventories to run the model, it also has substantial 

limitations. The accuracy of ecosystem service estimates can be improved 

significantly by providing additional optional tree measurements. 

Caution 

 
! 
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Here are several guidelines to keep in mind: 

• Field names – Users are not required to edit the field names of their existing data to match 

those used by the Eco application; instead, users will be asked to indicate the 

corresponding Eco field name. (Note: Those Eco field names will continue to be used and 

displayed in the application.) 

 

• Data limits – Eco has rules that serve as data integrity checks which require all values to 

fall within the accepted limits. For data variables where this applies, the limits are included 

in Table 1. The import function will not work properly if the data do not adhere to the 

validation rules. 

 

• Field type – Eco data variables can often be displayed in several ways. For example, 

species data can be entered as common name, scientific name, or species code. For data 

variables where this applies, users will be asked to indicate which field type corresponds to 

their existing data. 

 

• Value mapping – Users are not required to format their field values to match those used 

by the Eco application. For example, if you have recorded your species data as species 

codes, these codes do not have to be the same ones that are built into the Eco application. 

However, they must be mapped to Eco’s values. The option to map values is available for 

all data variables in Table 1. For variables where field values are to be mapped, the data 

formatting in Table 1 need not be followed. Instead, users will be asked to map the values 

used in their existing data to those available in Eco. (Note: Those Eco values will continue 

to be used and displayed in the application.) 
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Table 1—Data Variables for Complete Inventory Projects 

The Data Variables column lists the required and optional data variables that can be imported 

from an existing inventory. For best results, the data formatting and limits described for each 

variable should be adhered to unless you choose to map values. 

 

 

Data Variables Data Formatting Data Limits 

Required fields   

Species Enter as specified in Eco Field Manual n/a 

DBH  Enter as number 0.5 to 1250 (cm) 

Optional fields   

Tree ID Enter as number 
> 0 without 
duplication 

Strata Enter as specified in Project Configuration n/a 

Crew Enter as text n/a 

Survey Date Enter as date/time n/a 

Status Enter as specified in Eco Field Manual n/a 

Land use Enter as specified in Project Configuration n/a 

Photo ID Enter as text n/a 

Latitude Enter as GPS coordinate n/a 

Longitude Enter as GPS coordinate n/a 

DBH measurement height  Enter as number 0.1 to 1.8 (m) 

DBH measured Enter as Yes (Y) or No (N) n/a 

Street tree/non-street tree 
Enter as Yes (Y) for street tree or No (N) for 
non-street tree 

n/a 

Public/private 
Enter as Yes (Y) for public tree or No (N) for 
private tree 

n/a 

Total tree height Enter as number 0 to 135 (m) 

Crown 
size 

Height to live top Enter as number 0 to 135 (m) 

Height to crown base Enter as number 0 to 135 (m) 

Crown width Enter as number 0 to 90 (m) 

Percent crown missing Enter as number 0 to 100 

Crown health Enter as specified in Project Configuration n/a 

Crown light exposure Enter as number -1, 0, 1, 2, 3, 4, or 5 

Energy 

Direction Enter as number 
1 to 360 degrees 
(must be -1 when no 
building is present) 

Distance (ft or m) Enter as number 
0.1 to 18.3 (m) (must 
be -1 when no 
building is present) 

Maintenance recommended Enter as specified in Project Configuration n/a 

Maintenance task Enter as specified in Project Configuration n/a 

Sidewalk conflict Enter as specified in Project Configuration n/a 

Utility conflict Enter as specified in Project Configuration n/a 
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Follow the Complete Inventory Import procedure outlined in Phase IV > Adding Data. 

 

 

 

If you have decided to conduct a plot-based sample inventory of a large-scale study area, one of 

the most important steps in planning your project will be deciding how to create the random 

sample of plots. This section will help you understand elements of designing a sample such as 

stratification options and the number of plots needed. Your sample design decisions should be 

based on your desired project goals (i.e., the questions you are trying to answer), the available 

resources to manage and complete the project, and the desired precision of the model estimates. 

 

 

Will you stratify your sample? 

For some studies, stratifying (subdividing) the study area into smaller units can help clarify 

differences across the area. For example, a stratified sample design with many plots may allow for 

comparison between land use types or neighborhoods and for greater precision of the model 

estimates. However, there will be associated project considerations such as the additional 

resources that will be needed to create maps, obtain permission to access properties, travel to 

plots, and collect field data. Conversely, a simple random sample with no stratification will not 

allow for comparison of sub-units but may still provide sufficient information to achieve the project 

objectives. Ultimately, the decision to stratify should be based on your current and future project 

objectives and your available resources. 

 

  

 Plot-Based Sample Inventory 

 

 

Required fields, species and DBH, must be entered according to the formatting 

requirements in Table 1 or mapped to Eco’s values. Invalid or unmatched values will 

result in records being skipped. 

Caution 

 
! 

 

 

A technical article is available at www.itreetools.org under Resources > Archives 

that provides more detail on the effects of sample design options on project 

precision and estimates. See “Effect of Plot and Sample Size on Timing and 

Precision of Urban Forest Assessments” under the Eco resources section of that 

page. 

Tip 

http://www.itreetools.org/
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Review the following options before you decide whether or not to stratify your sample: 

• No stratification (simple random sample): In a study with no stratification, plots are laid out 

randomly across the study area. This is a simpler method and offers the advantage of true 

randomness. True randomness, however, might not provide you with a true picture of your 

urban forest. Consider, for example, an extreme case of a city that is divided into two land 

uses: single-family residential (10% of total area) and industrial (90% of total area), with all of 

the trees in the residential district. A true random sample would place 10% of plots in 

residential areas and 90% of plots in the industrial area and would result in an incorrect picture 

of the urban forest. Since in most cities the trees themselves are not distributed randomly 

across land uses or neighborhoods, stratified sampling can offer a more accurate picture of the 

urban forest. 

 

• Stratification (stratified random sample): In a study with stratification, the study area is 

subdivided into smaller units such as neighborhoods or land use classes. This can be done 

prior to determining your plots (pre-stratification) or after data is collected (post-stratification). 

 

o Pre-stratification: In this method, the study area is divided into smaller classes (or 

strata) prior to determining the plots. The number of plots in each stratum is based 

on which areas are believed to have the greatest variability or are of greatest 

interest. Often the majority of the plots are distributed within residential and forest / 

vacant land uses, as these areas tend to have the greatest density of trees. One 

disadvantage of stratification is that it might make revisiting the same plots in the 

future difficult if land uses change over time. On the other hand, if treed lands are 

slated for development, plot data outputs can be used to show the quantified loss of 

benefits. 

 

 

 

Stratification is handled differently for complete inventory projects. If you are doing 

a complete inventory project and are interested in collecting strata, please read 

about it in the Phase IIIA > Choosing Your Data section.  

Tip 

 

 

Whether you pre-stratify or post-stratify, be sure not to choose too many categories 

or strata. The number of strata used in an Eco project is typically between 5 and 10 

(for an analysis with 200 total plots) and cannot exceed 14. Too many categories 

can lead to analysis problems, as too few plots may not show in some strata. Each 

stratum should have at least 20 plots. 

Caution 

 
! 
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o Post-stratification: In this method, plots are first randomly distributed throughout 

the study area, and then strata boundaries are determined after data collection or in 

the future. Post-stratification allows you to analyze your data into multiple schemes. 

For example, you can use the same plots and field data to compare your results by 

land use types and then change the stratification to allow for analysis by political 

boundaries, neighborhoods, or management units as desired. Post-stratification 

allows you to manage the stratification boundary definitions to analyze change over 

time if your project will be reassessed in the future. For example, a land use 

category that is agricultural in an initial study may be developed in the future and 

reclassified as residential or commercial. Although post-stratification allows for 

greater flexibility, one disadvantage is that estimates may not be as accurate as a 

pre-stratified project where plot quantity is predetermined based on existing land 

types and desired objectives. 

 

How big will your plots be? 

The standard plot size for an Eco analysis is a 0.04-hectare circular plot with radius of 11.34 

meters. If necessary, smaller or larger plots can be used – for instance, if you are analyzing a small 

area in which 0.04-hectare plots would overlap. 

 

How many plots will you inventory? 

As a general rule, 200 plots (.04 hectare each) in a stratified random sample (with at least 20 plots 

per stratum) will yield a standard error of about 10% for an estimate of the entire city. As the 

number of plots increases, the standard error decreases and you can be more confident in the 

estimate for the population. The graph below provides a rough estimate of how the standard error 

of the total number of trees in a city changes based on the number of plots sampled. Note how for 

the first 100 plots, the standard error drops more rapidly than for the second 100 plots, although 

the standard error continues to drop with increased sample size. 

 

Keep in mind, however, that as the number of plots increases, so does the time and cost of field 

data collection. A crew of two people can typically measure 200 plots in one summer for a city with 

about 20% tree cover. The actual number of plots to be measured differs based on many factors, 

including the size of the city and tree cover. 

  

 

 

We recommend adding an extra 5-10% to your final number of plots.  

These extra plots can serve as replacements where another plot is inaccessible. 

 

Tip 
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So you’ve answered all of the questions in Phase I and are ready to set up your Eco project… 

 

Use Table 1 to help you through Phase II. Read the questions in the table, choose the answer that 

applies to your project, and then follow the directions. This will help guide you to the steps that are 

relevant to your project. 

 
Table 1—Guide to Next Steps 

Questions Answers Directions 

1. What type of inventory 
will you do? 

1a. Complete inventory – I will sample 
all of the trees in my study area. 

Continue to Question #2. 

1b. Plot-based sample inventory – I will 
sample the trees on plots distributed 
throughout my study area. 

Skip to Question #3. 

2. Do you have an existing 
inventory? 

2a. Yes – I will be importing an existing 
inventory. 

Go to Phase IV of this manual. 

2b. No – I need to collect field data. Go to Phase IIIA of this manual. 

3. Will you stratify your 
sample? 

3a. No – I am going to do a simple 
random sample. 

Read about The Sample Creation 
Step below, then go to Phase IIIA of 
this manual. 

3b. Yes – I am going to do a stratified 
random sample and pre-stratify my 
project. 

Read about The Sample Creation 
Step, then go to Phase IIIA of this 
manual. 

3c. Yes – I am going to do a stratified 
random sample and post-stratify my 
project. 

Read about The Sample Creation 
Step, then go to Phase IIIA of this 
manual. 

4. How big will your plots 
be? 

(as specified) 
Use this information in the Preparing 
for the Field section of Phase IIIA. 

5. How many plots will you 
inventory? 

(as specified) 
Use this information in The Sample 
Creation Step below. 

   

Phase II: Setting Up Your Project 

 Guide to Next Steps 
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Datasets that are used in conjunction with the collected field data include: 

 

• Species information 

• Location information 

• Precipitation data 

• Additional weather data 

• Pollution data 

 

These data are already incorporated in Eco for study areas in all countries listed on Page 1. 

 

i-Tree Database provides two functions. Users may choose to do one or both of the following while 

working with the tool: 

 

1  View the Species or Location databases, or 

2  Add Species, Location, Precipitation, or Pollution data to the databases. 

 

The option to view the Species or Location databases allows users to search the data used by the 

i-Tree applications. Users can see what species and locations are currently available for modeling. 

For new projects, users should check if their location and species of interest are already in the 

data. Identifying missing data will help inform decisions to add data to the databases. 

To get started, go to i-Tree Database at: http://www.itreetools.org/database. View the Species and 

Location databases in turn. Note if your project location and desired tree and shrub species are 

already in the database. 

 

 The Data Gathering Step 

 

 

Weather data is also used in i-Tree Eco and is available globally from the 

National Climatic Data Center (NCDC). All datasets from the NCDC with 

sufficient weather data have been incorporated in i-Tree Eco v6.0. Within Eco 

weather data quality is categorized as either Good, Fair, or Poor based on the 

number of missing hourly weather data. Currently, users will select from the 

available weather stations directly in the application and are not able to submit 

their own weather data.  

Tip 

 

 

Refer to i-Tree Database’s “How to Use” text by going to Menu > Help at the top of 

the webpage. 

Tip 

http://www.itreetools.org/database
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To view available species: 

1 Click on View Database at the top of the i-Tree Database webpage. 

2 Select Species from the drop-down list. 

3 Choose one of the following from the Search by drop-down: 

a Scientific Name 

b Common Name 

4 Enter the name of the species that you are trying to find based on your selection in the 

Search by drop-down (i.e., scientific or common name). 

5 Click Go. 

6 The species that match your search will be listed below the search box. 

7 Click Clear to discard the name that you entered and start over. 

 

If you are having difficulty finding a species, try searching by both scientific and common name or 

entering only part of the name, e.g. the Genus, in the search box. 

 

To view available locations: 

1 Click on View Database at the top of the i-Tree Database webpage. 

2 Select Location from the drop-down list. 

3 Define a search area by: 

a Selecting a nation from the Search by drop-down. 

b Selecting a more precise area from the list, if additional drop-down menus appear. 

4 Click Go. 

5 All of the available locations in your designated search area will be listed below the search 

box. 

6 Click Clear to discard the search area that you defined in the search box and start over. 

 

 

 

 

 

 

If you see incomplete or erroneous data in either the species or location 

information, let the i-Tree Team know! Go to the Feedback menu at the top of 

the i-Tree Database webpage and click on Comments. 

Tip 
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Species Information 

The Species database includes species information for more than 7,500 tree and shrub species. 

Though adding new species for i-Tree Eco is optional, it is necessary for your analysis if any 

species in your local area are not already included. 

 

By viewing the database, as described above, you can identify any missing tree or shrub species. 

To make those species available in Eco, collect the necessary information for those species and 

submit it using i-Tree Database.  

 

To add a new tree species to the Species database:  

 

1 Click on Add to Database at the top of the page. 

 

2 Select Species. 

 

3 Fill in all of the required fields for your new tree species. 

a If the genus name of your new species is not available in the Genus Name drop-

down list, add it to the database by doing the following: 

b Click the Add New Genus button. 

c Enter the name of the new genus in the space provided. 

d Click Save to add the entry to the database. 

e Click Cancel to discontinue the action of adding a new genus. 

 

4 Fill in any of the optional fields that you are able to – the more information you provide, the 

better! 

 

5 As you fill in the fields, if you are not satisfied with the data you’ve entered click Reset to 

clear the form. 

 

6 Click Submit when you are satisfied with the information you’ve provided. The data 

entered in the Species form will be sent to the i-Tree Team to be validated and 

incorporated into the i-Tree databases.  

 

 

If you determine that you will need to submit additional data using i-Tree 

Database, consider doing that before you collect your field data. New tree 

species are entered and submitted individually, but you may choose to submit as 

many new tree species as you like! Data submitted in i-Tree Database will need 

to be vetted by the U.S. Forest Service before it can be made available in Eco. 

This will take some time. 

Tip 
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Location Information 

The Location database includes location information for countries listed on Page 1 and is always 

expanding internationally. When you designed your Eco project, you should have decided on the 

location and boundaries of your study area. By viewing the database, as described above, you can 

identify if your location is already available in Eco. If it is, you do not need to submit any location 

information. Your Eco project can be run directly in Eco.  

 

Precipitation Data 
 

 

Internationally, precipitation data is often insufficient or absent from the weather data available in 

Eco. To supplement Eco’s existing weather data with hourly precipitation data for your location, 

collect the necessary information for the precipitation data and submit it using i-Tree Database. 

 

Precipitation data must be hourly data in meters submitted in Excel format for a complete calendar 

year. A template is provided in i-Tree Database to ensure proper data formatting. 

 

To provide properly formatted precipitation data: 

1 Go to i-Tree Database at: http://www.itreetools.org/database. 

2 Click on Add to Database at the top of the page. 

3 Select Precipitation. 

4 Click on the Template link to download the precipitation template (see Table 3 below). 

5 From the compressed file, choose the spreadsheet for the year that corresponds to the 

year your precipitation data was collected. 

6 Populate the sheet with your hourly data. Be sure your data is in meters per hour. 

7 Save a copy of your formatted precipitation data. 

 

Your spreadsheet should be uploaded in i-Tree Database for submission as described in Submit 

Additional Data using i-Tree Database. Please also provide the following fields for each dataset 

you add: 

 

 

 

 

 

 

 

 

Precipitation data is required for avoided runoff modeling and strongly recommended 

for pollution removal. Without precipitation data, the i-Tree Eco model cannot 

estimate avoided runoff. Pollution removal estimates for PM2.5 also use precipitation 

data and without the data the model will likely overestimate PM2.5 removal. 

Tip 

http://www.itreetools.org/database
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Table 3—Precipitation fields for i-Tree Database 

Field Required Description 

Continent x Continent name of location for which precipitation data is being added 

Nation x Nation name of location for which precipitation data is being added 

State x 
Primary partition (e.g., state, province, or territory) name of location for 

which precipitation data is being added 

Year x Calendar year in which new precipitation data was collected 

Weather Station x Weather station that precipitation data will be added to 

Precipitation Data x File containing new precipitation data to be uploaded 

Pollution Data 

 

Hourly air quality data can be submitted for particulate matter less than 2.5 microns (PM2.5), carbon 

monoxide (CO), ozone (O3), nitrogen dioxide (NO2), and sulfur dioxide (SO2). Data must be hourly, 

submitted in Excel format, for a complete calendar year. To provide local pollution data for your 

location, collect the necessary information for the pollution data and submit it using i-Tree 

Database. A template is provided in i-Tree Database to ensure proper data formatting (Table 4).  

 

 

 

 

 

 

 

 

 

To provide properly formatted air quality data: 

1 Go to i-Tree Database at: http://www.itreetools.org/database. 

2 Click on Add to Database at the top of the page. 

3 Select Pollution. 

4 Click on the Template link to download the pollution template (see Table 4 and 5 below). 

5 From the compressed file, choose the spreadsheet (leap year or non-leap year) that is 

appropriate for the year your pollution data was collected. 

6 Follow the formatting requirements listed below to add your hourly data.  

7 Save a copy of your formatted pollution data. 

 

 

 

 

 

 

Air quality data is required to run the pollution model. Without this data, 

pollution removal estimates will not be included in your results. 

Tip 

 

 

The pollutant particulate matter less than 10 microns (PM10) is no longer 

included because i-Tree Eco v6.0 analyzes particulate matter less than 2.5 

microns (PM2.5) which is a subset of PM10. PM2.5 is generally more relevant in 

discussions concerning air pollution effects on human health. 

Caution 

 
! 

http://www.itreetools.org/database
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Your spreadsheet should be uploaded in i-Tree Database for submission as described in Submit 

Additional Data using i-Tree Database. Please also provide the following fields for each dataset 

you add: 

 

Table 5—Pollution fields for i-Tree Database 

Field Required Description 

Continent x Continent name of location for which pollution data is being added 

Nation x Nation name of location for which pollution data is being added 

State x 
Primary partition (e.g., state, province, or territory) name of location for 

which pollution data is being added 

Year x Calendar year in which new pollution data was collected 

Pollution Data x File containing new pollution data to be uploaded 

 

 

 

Table 4—Formatting requirements for pollution template 

Column Column name Format Description Requirements 

A YEAR Number 
Year the data were 

recorded 

Must be 2005-2013 and match year of 

weather data to be used 

B MONTH Number 
Month of the year the data 

were recorded 
CANNOT BE EDITED. Must be 1-12 

C SPNAME Text Name of the pollutant 

CANNOT BE EDITED. 

Must be: 

• CO for carbon monoxide, 

• NO2 for nitrogen dioxide, 

• O3 for ozone, 

• PM2.5 for particulate matter less 

than 2.5 microns, 

• SO2 for sulfur dioxide, or 

• PM10 for particulate matter less 

than 10 microns 

D CITYNAME Text 

Name of the city where 

the pollution monitor is 

located 

Do not leave blank; if city name is 

unknown, fill in with a letter (e.g., X) 

E ADDR Text 
Address of the pollution 

monitor  

Do not leave blank; if address is 

unknown, fill in with a letter (e.g., X) 

F UNITS Number Units of the pollutant 

Must be: 

• 1 for micrograms per cubic meter 

(µg/m3) or  

• 7 for parts per million (ppm) 

G QUANTITY Number 
Value of the measurement 

in units given in Column F 

Missing values must be entered as  

-999 

H DAY Number 
Day of the month the data 

were recorded 
CANNOT BE EDITED. Must be 1-31 

I HOUR Number 
Hour of the day the data 

were recorded 
CANNOT BE EDITED. Must be 0-23 
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Avoiding Common Air Quality Data Problems  

Providing properly formatted pollution data consistently causes the most problems for international 

users. Submitting incorrect or incomplete pollution datasets may require corrections or 

resubmission and influences the amount of time before it can be made available in Eco. Here are a 

couple items to keep in mind to avoid common issues while you gather your pollution data and 

ensure timely incorporation into Eco: 

 

• Complete calendar year – Eco requires hourly pollution data for a complete calendar year 

(Jan 1 – Dec 31). The year does not have to be recent, but it needs to be complete and 

within the same calendar year for all pollutants. For example, although data available for 

June 1, 2014 to May 31, 2015 spans 365 days, the Eco model cannot process this data 

because it is taken from two separate calendar years. It is not possible for the i-Tree team 

to piece together parts of pollution data from different years if data is incomplete from one 

station. 

 

• Pollution data gaps - The pollution model can handle some time gaps without pollutant 

values for several hours (e.g., 2-3 hour gaps in data) as this is typical with most external 

pollution data sets. In these cases, the model will interpolate to fill data gaps over short 

time frames. 

 

• Missing pollutants - If you are missing data for a pollutant, such as PM2.5, the model will 

exclude that pollutant from the analysis. 

 

Valuation Data 

International users are also encouraged to provide local valuation data. Providing your own benefit 

prices allows users to localize their results. i-Tree Eco uses values from the scientific literature to 

estimate the economic value associated with tree benefits. Default values currently estimated are: 

 

• Carbon – based on the U.S. Social Cost of Carbon (SCC) 

 

• Avoided runoff – U.S. national average costs of stormwater control 

 

• Pollution removal – based on U.S. median externality values for carbon monoxide, 

nitrogen dioxide, sulfur dioxide, particulate matter less than 2.5 microns, and ozone 

removal 

 

• Energy – U.S. national average cost of electricity and fuels (e.g., heating oil, propane, 

natural gas) 

 

You can provide your own valuation data if you would like to localize your benefit estimates. If you 

do not provide your own valuation data, the default values will be used and converted to the local 

currency with a user-defined exchange rate. Unlike species, location, precipitation, and pollution 

data that are submitted in i-Tree Database, valuation data are entered directly in the i-Tree Eco 

application. By entering the data directly in Eco, it will be used for your project, but it will not be 
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added to the databases. Read about adding valuation data in Eco under Phase IV: Working with 

Eco > Navigating the User Interface. 

 

 

If you have decided to do a plot-based sample project, then you will need to create your sample. 

This step will walk you through that process.  

Randomization 

There are many ways that you can randomly distribute plots throughout your study area, whether 

you are working with a stratified or un-stratified sample. Again, your decision should be based on 

the objectives of your study and the resources available to create the layout. Some Eco users 

collaborate with local universities or government agencies for assistance to create random plot 

layouts for their projects. Three randomization methods are as follows: 

 

Random:  

For an un-stratified or post-stratified sample, plots are laid randomly within the boundaries of the 

entire study area. For a pre-stratified sample, plots are laid randomly within the boundaries of each 

individual predetermined stratum. 

 

Fixed Grid: 

First, random plots are created by laying out a fixed grid of points, equidistant over the entire 

project area. Once the grid points have been laid out, they are numbered. 

 

For an un-stratified or post-stratified sample, plots are selected for the entire study area by 

choosing points from the grid using a random number generator, which can be found online or 

within software tools such as Excel. For a pre-stratified sample, plots are selected the same way, 

but for each predetermined stratum. 

 

A potential disadvantage of this method, however, may occur if the grid unintentionally coincides 

with an existing city street grid. In that case, many plots may fall on similar land uses, which may 

not be desirable. 

 The Sample Creation Step 

Random Fixed Grid Randomized Grid 
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Randomized grid:  

In this method, an evenly spaced grid is laid over the study area. Then, plot points are selected 

randomly within each cell, which allows for a more even distribution of points throughout your 

study area with a greater degree of randomness than using a fixed grid. 

 

One advantage of the randomized grid is that it allows for multiple post-stratification schemes 

because plots are more evenly distributed. 

 

Sample Creation Methods 

Once you have designed your sample and made the necessary decisions about stratification, plot 

size, and number of plots, there are multiple methods available to help you create your plot 

sample. You can use any method you like, including paper maps and pencil, as long as it follows 

random sampling conventions.  

 

Eco offers a random plot generator that allows you to create your sample right in the application 

itself. The plot generator works with Google Maps and utilizes study area boundaries that can be 

drawn by the user or supplied from an ESRI ArcGIS shapefile. This method can be used whether 

you have decided to stratify your sample or not. However, in the Google Maps Plot Generator, 

plots are distributed randomly and cannot be distributed on a fixed grid or randomized grid. 

 

Eco plots can also be created in other programs and loaded into the application. In this case, you 

could use ESRI’s ArcGIS software to generate your plots. The end result will be three files to load 

into Eco during project set up to create a plot list for your project configuration. 

 

How you choose to create your sample ultimately depends on your randomization method, 

decisions about stratification, and available resources. For example, nearly all sample designs can 

be created using GIS, but the software can be expensive. The random type of random plot 

distribution is typically done by using Eco’s Google Maps Plot Generator or with the aid of a GIS 

system. The fixed grid type of random plot distribution can be done manually on a map or by 

using GIS. The randomized grid type of random plot distribution would most likely require GIS. 

 
  

 

 

Look at the Eco Guide to Post-stratified Samples for directions on how to create a 

post-stratified random sample of i-Tree Eco plots using Eco’s manual plot creation 

function. 

Eco Guide  

http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_PostStratifiedSamples.pdf
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Erforderliche Messgrössen 

Für die Planung Ihres Eco-Projektes ist der Entscheid über die zu erhebenden Messgrössen pro 

Baum massgebend. In jeglichen Inventuren müssen die folgenden zwei Messgrössen pro Baum 

erhoben werden: 

 

• Baumart: Identifizieren und geben Sie die Gattungs- und Artnamen jedes Baumes an. 

• Brusthöhendurchmesser (BHD): Messen und geben Sie für jeden Baum den 

Durchmesser auf Brusthöhe (1.3 m über dem Boden) an. 

 

 

Die folgenden zwei Messgrössen müssen zusätzlich für jede Stichprobenfläche [Plot] erhoben 

werden (nur für Stichprobeninventuren [plot-based sample inventories]):  

 

• Messbarer Flächenanteil [percent measured]: Identifizieren Sie für jede 

Stichprobenfläche [Plot] den Flächenanteil (in Prozent), welcher für die Feldteams 

zugänglich und messbar ist. Dies entweder direkt oder durch eine Schätzung. 

 

• Beschirmungsprozent [percent tree cover]: Identifizieren Sie für für jede Stichrobefläche 

[Plot] den Flächenanteil (%), welcher durch das Kronendach der Bäume überschirmt wird 

{Synonym ‘Deckungsgrad’ aller Bäume}.  

 

 

  

Phase IIIA: Vorbereitung der Datenerhebung 

 Auswahl der Messgrössen 

 

i-Tree Eco verlangt die Erhebung von mindestens zwei Messgrössen pro Baum. 

Dieser Ansatz erlaubt es dem Nutzer zwar, auch mit wenig bestehenden 

Inventardaten, das Model laufen zu lassen, jedoch besitzt dieser Ansatz grosse 

Beschränkungen. Die Genauigkeit der Schätzung der Ökosystemleistungen kann 

wesentlich erhöht werden, wenn weitere optionale Messgrössen erhoben werden. 

 

Lesen Sie bitte mehr zu den Daten-Beschränkungen im Eco Guide to Data 

Limitations. 

Achtung 

 
! 

http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_DataLimitations.pdf
http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_DataLimitations.pdf
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Ergänzende Analysen 

i-Tree Eco stellt für die erhobenen Daten hinsichtlich Struktur, Funktion und Nutzen [benefits] Ihres 

‘Urban Forests’ unterschiedliche Analysen zur Verfügung:  

• Anzahl Bäume [number of trees] 

• Baumartenzusammensetzung [species composition] 

• Blattfläche und Blattbiomasse [leaf area and biomass] 

• Luftschadstofffilterung und monetärer Wert [Pollution removal and value] 

• Kohlenstoffspeicherung, Kohlenstoffsequestierung und monetärer Wert [Carbon storage, 

sequestration, and value] 

• Effekte auf Hydrologie und monetärer Wert [Hydrology effects and value] 

• Emissionen von flüchtigen organischen Verbindungen [Volatile organic compound 

emissions] 

• Sauerstoffproduktion [Oxygen production] 

• UV-Effekte (Ultraviolet) [Ultraviolet (UV) effects] 

 

 

Es gibt weitere ergänzende Analysen, welche Sie in Ihr massgeschneidertes Eco-Projekt 

einbeziehen können. Beachten Sie die nachfolgenden Ausführungen, um zu entscheiden, welche 

Analysen relevant für die Ziele Ihres Projektes sind. 

 

Energie [energy] (Verfügbar für Voll- sowie Stichprobeninventuren [complete und plot-based 

sample inventories]): 

Bäume, die sich in der Nähe von Gebäuden befinden, können die Energiemenge beeinflussen, 

welche zum Erwärmen oder Abkühlen der Gebäude benötigt wird, indem Lufttemperaturen 

gesenkt, Winde blockiert werden sowie Schatten gespendet wird. Wenn Sie die Auswirkungen 

Ihres ‘Urban Forest’ auf den Energieverbrauch beurteilen möchten, müssen Sie Informationen zu 

nahegelegenen Gebäuden sammeln (z.B. Abstand und Ausrichtung zu den Bäumen). (Hinweis: 

Energieeffekte werden nur für Wohngebäude berechnet). 

 

Tierwelt [Wildlife] (Verfügbar für Stichprobeninventuren [plot-based sample inventories]): 

Eco schätzt die Gebietseignung zur Erhaltung von Populationen anhand von neun verschiedenen 

Vogelarten auf der Grundlage von Habitatmerkmalen ein, die sich auf die Abundanzmuster der 

Arten beziehen und diese beeinflussen. Diese Schätzungen basieren auf dem Bewegungsradius 

der Arten, der lokalen Waldstruktur sowie auf der Deckung der Baum-, Strauch- und 

Bodenvegetation im Untersuchungsgebiet. Um die Habitateignung für Wildtiere zu beurteilen, 

müssen der Deckungsgrad der Strauchvegetation sowie die Zusammensetzung der 

Bodenvegetation erhoben werden. Zusätzliche Messgrössen pro Baumart werden für eine bessere 

Schätzungen dringend empfohlen (konsultieren Sie hierfür die nachfolgende Tabelle 3). 

 

 

Für diese zusätzlichen Analysen müssen Sie mehr Messgrössen pro Baum erheben, 

als die bereits genannten ‘Baumart’ und ‘BHD’. Die Tabellen 3 und 4 des 

nachfolgenden Abschnittes unterstützen Sie in Ihrer Entscheidungsfindung. 

Achtung 

 
! 
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Prognosen [forecast] (Verfügbar für Voll- sowie Stichprobeninventuren [complete und plot-based 

sample inventories]): 

Das Prognosemodell verwendet strukturelle Schätzungen, die von Eco generiert werden, 

zusammen mit Wachstums- und Sterblichkeitsraten, um abzuschätzen, wie Ihr ‘Urban Forest’ in 

Zukunft aussehen wird. Wenn Sie Ihren zukünftigen ‘Urban Forest’ erkunden möchten, wird die 

Erhebung zusätzlicher Informationen empfohlen (siehe Tabelle 3 und 4 unten). 

 

Sträucher [shrubs] (Verfügbar für Stichprobeninventuren [plot-based sample inventories]) 

Eco analysiert zwar hauptsächlich Bäume in Ihrem Untersuchungsgebiet, aber auch Sträucher 
sind eine weitere wichtige Ressource und bieten einen vielfältigen Nutzen [benefits]. Wenn Sie 
Sträucher in Ihrem Untersuchungsgebiet analysieren möchten, müssen Sie Informationen zu Art, 
Höhe und Deckung der Sträucher in der Stichprobenflächen [plot] sammeln. 
 

Bepflanzbare Fläche [plantable space] (Verfügbar für Stichprobeninventuren [plot-based sample 

inventories]) 

Wenn Sie für Ihr Untersuchtungsgebiet die verfügbare bepflanzbare Fläche abschätzen möchten, 
müssen Sie in jedem bepflanzbaren Teilgebiet der Stichprobenfläche entsprechende 
Informationen erheben. 
 
Deckungsgrad Unterwuchs [cover under canopy] (Verfügbar für Stichprobeninventuren [plot-

based sample inventories]) 

{Der ‘Deckunsgrad des Unterwuchses’ kann derzeit nur in US-Projekten erhoben werden, da diese 

Messgrösse nur im i-Tree Tool ‘Hydro’ verfügbar ist.}  

Neben ‘Eco’ ist ‘Hydro’ eine weitere Applikation von i-Tree. Mit ‘Hydro’ lassen sich die Effekte von 

Urban Forests sowie versiegelter Flächen auf die stündlichen Abflussraten [stream flow] und die 

Wasserqualität ermitteln. Falls Sie eine Analyse mit ‘Hydro’ durchführen möchten, müssen Sie für 

Ihr Untersuchungsgebiet Daten zum durchschnittlichen Prozenanteil versiegelter Flächen sowie 

zur Deckung der Strauchschicht unterhalb der Kronentraufe bereitstellen. Da solche Informationen 

oftmals schwer zu bekommen sind, wurde es ermöglicht, dass Sie diese Daten innerhalb eines 

Eco-Projektes erheben können. Beachten Sie jedoch, dass falls diese Analyse aussagekräftig sein 

soll, der Perimeter [project boundary] Ihres Eco-Projekts dem Perimeter Ihres Hydro-Projekts 

entsprechen muss (z. B. Wassereinzugsgebiet [watershed] oder [community]). 
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Optionen zur Datenerhebung 

Es gibt viele weitere Messgrössen, die optional erhoben werden können. Jede weitere 

Messgrösse verbessert einerseits Ihre Analyse, andererseits erhöhen sich dadurch auch die 

Kosten ihres Projektes. Beachten Sie, welche Messgrössen für die von Ihnen gewählten Analysen 

erforderlich sind.  

Table 3. Stichprobeninformationen (Projekte mit Stichprobeninventuren [plot based sample project]) 
Nutzen Sie diese Tabelle, um Ihre Entscheidungsfindung bei der Datenerhebungn zu unterstützen: 
In der Spalte ‘Beschreibung’ finden Sie weitere Informationen zu jeder Messgrösse. Die in den rechten 
Spalten dargestellten zusätzlichen Modellkomponenten erfordern die Erhebung bestimmter optionaler 
Messgrössen. Die optionalen Messgrössen, die für jede zusätzliche Modellkomponente erhoben werden 
müssen, sind mit einem "x" gekennzeichnet. 
 
{Die Modellkomponente ‘Luftschadstoffilterung durch Gräser/Krautige’ ist derzeit nur für US-Projekten 
verfügbar. Bitte erheben Sie hierzu keine Daten.} 
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Messgrössen Beschreibung 

Minimal erforderliche Felder   

Messbarer Flächenanteil 
[percent measured] 

Anteil der Stichprobenfläche, welcher zugänglich und 
messbar ist und/oder in die Studie einbezogen werden kann 

Erforderlich 
 

Beschirmungsprozent 
[percent tree cover] 

Der Anteil der Stichprobenfläche, welcher von den 
Baumkronen beschirmt ist (in %) 

Erforderlich 
 

Allgemeine Felder   

Land-nutzung 
[land use] 

aktuelle Land-nutzung 
[actual land use] 

Landnutzungstypen, welche im Untersuchungsgebiet 
beobachtet werden können 

    

Prozentanteil an 
Stichprobenfläche 
[percent of plot] 

Prozentanteil der jeweiligen Landnutzungstypen in der 
Stichprobenfläche 

    

Deckungsgrad Strauchschicht  
[percent shrub cover] 

Prozentanteil der Strauchschicht in der Stichprobenfläche x  x  

Prozentanteil der bepflanzbaren Fläche 
[percent plantable space] 

Prozentanteil der Stichprobenfläche, welcher mit Bäumen 
bepflanzt werden kann (d.h. bepflanzbare Erde, welche 
nicht unmittelbar unterhalb einer Baumkrone oder sonstigen 
überliegenden Restriktionen [overhead restrictions] liegt und 
das Pflanzen/ Aufwachsen von Bäumen nicht durch die 
Landnutzung eingeschränkt ist, wie z.B. ein Fussballfeld) 

 x   

Adresse der Stichprobenfläche 
[Plot address] 

Strassenadresse der Stichprobenfläche oder Informationen 
zum Auffinden der Stichprobenfläche in Gebieten ohne 
Strassenadressen  

    

GPS Koordinaten Längen- und Breitengrad des Stichprobenzentrums     

Referenz Objekte 
[reference 
objects] 

Objekttyp  
[object type] 

Sichtbare Orientierungshilfen, wie z.B. Stoppschilder oder 
Haltestellen, welche vom Stichprobenzentrum aus zu sehen 
sind 

    

Richtung [direction] Die Richtung vom Stichprobenzentrum zum Referenzobjekt     

Distanz [distance] Die Distanz vom Stichprobenzentrum zum Referenzobjekt     

BHD [DBH] 
Brusthöhendurchmesser falls das Referenzobjekt ein Baum 
ist 

    

Bodenbe-deckung 
[ground cover] 

Bodenbedeckung [ground 
cover] 

Bodenbedeckungsklassen, welche im Untersuchungsgebiet 
vorkommen 

  x x 

Flächenanteil in % 
[percent of plot] 

Flächenanteil (%) der Stichprobenfläche, welcher von der 
jeweiligen Bodenbedeckungsklasse eingenommen wird.  

  x x 

Details zu 
Sträuchern [shrub 
details] 

Arten [species] Artname der Sträucher x    

Höhe [height] 
Durchschnittliche Höhe einer Strauchgruppe (d.h. einer 
Menge an Sträucher der gleichen Art) 

x    

Flächenanteil in % 
[percent of area] 

Prozentanteil Strauchfläche, der pro Stichprobe durch die 
jeweilige Strauchgruppe abgedeckt wird 

x    

Fehlender Volumenanteil 
[percent missing] 

Prozentanteil des fehlenden Strauchgruppenvolumens (d.h. 
nicht mit Blättern besetzt) 

x    
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Table 3 (Fortsetzung): Bauminformationen (Projekte mit Stichprobeninventuren [plot based sample project]). 
Nutzen Sie diese Tabelle, um Ihre Entscheidungsfindung bei der Datenerhebungn zu unterstützen: 
In der Spalte ‘Beschreibung’ finden Sie weitere Informationen zu jeder Messgrösse. Die in den rechten Spalten 
dargestellten zusätzlichen Modellkomponenten erfordern die Erhebung bestimmter optionaler Messgrössen. Die 
optionalen Messgrössen, die für jede zusätzliche Modellkomponente erhoben werden müssen, sind mit einem "x" 
gekennzeichnet. 
{Das i-Tree Tool ‘Hydro’ ist derzeit nur für US-Projekten verfügbar. Bitte erheben Sie hierzu keine Daten, wie z.B. 
‘Deckungsgrad Unterwuchs’. EU-Projekte werden informiert sobalt ‘Hydro’ auch hier verfügbar ist. } 
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Messgrössen Beschreibung 

Minimal erforderliche Felder 

Arten [species] 
Identifizieren und geben Sie die Arten- und Gattungsnamen von jedem 
Baum an 

Erforderlich 

BHD [DBH] 
Messen Sie den Brusthöhendurchmesser und geben Sie die Werte für 
jeden Baum an 

Erforderlich 

Felder zum Untersuchungsgebiet 

Landnutzung [land use] Landnutzungsart am Ort, wo sich der Baum befindet.    

Status [status] Art der Verjüngung durch Pflanzung oder Naturverjüngung    

Distanz zum Stichprobenmittelpunkt [distance 
to plot center] 

Distanz vom Baum zum Stichprobenmittelpunkt    

Richtung zum Stichprobenmittelpunkt 
[direction to plot center] 

Richtung vom Baum zum Stichprobenmittelpunkt    

Strassenbaum / kein Strassenbaum 
 [Street tree/non-street tree] 

Identifizieren Sie, ob es sich um einen Strassenbaum handelt oder 
nicht (J/N) 

   

Öffentlich/Privat [public/private] 
Klassifizieren Sie für jeden Baum, ob er unter städtischer 
Beaufsichtigung (öffentlich) steht oder nicht (Privat) 

   

Deckungsgrad 
Unterwuchs [cover 
under canopy] 

Flächenanteil 
Versiegelung in % [percent 
impervious] 

Der prozentuale Flächenanteil an versiegelter Flächer unterhalb der 
Kronentraufe 

  x 

Flächenanteil Sträucher in 
% [percent shrub] 

Der prozentuale Flächenanteil unterhalb der Kronentraufe, welcher mit 
Sträuchern bedeckt ist 

  x 

Felder zu Baumdetails 

Gesamtbaumhöhe [total tree height] 
Die Höhe des Baumes gemessen vom Boden bis zur Spitze (tot oder 
lebendig) 

   

Kronenaus-
dehnung [crown 
size] 

Lebendkronen-Baumhöhe 
[height to live top] 

Höhe gemessen vom Boden bis zur lebenden Baumspitze    

Höhe Kronenansatz 
[height to crown base] 

Höhe gemessen vom Boden bis zum Ansatz der lebenden Baumkrone    

Kronenbreite  
[crown width] 

Breite der Baumkrone in zwei Richtungen gemessen: von Nord-Süd 
und von Ost-West 

   

Kronenverlust (%) [percent 
missing] 

Der prozentuale Anteil des Kronenvolumens, welcher nicht mit Ästen 
oder Blätter besetzt ist 

   

Kronengesundheit 
[crown health] 

Wipfeldürre  
[crown dieback] 

Schätzung des Prozentanteils der Krone mit Totenästen  
 

 

Lichtexposition der Krone [crown light 
exposure CLE] 

Anzahl Baumseiten, die Sonnenlicht von oben erhalten (maximal 5)    

Energie [energy] 

Richtung [direction] Richtung vom Baum zum nahegelegensten Teil des Gebäudes x   

Distanz [distance] 
Kürzeste Distanz zwischen Baum und dem nahegelegensten 
Gebäudeteil 

x   

Felder zum Baummanagement 

Baumpflegeempfehlungen [Maintenance 
recommended] 

Nutzerdefinierte allgemeine Baumpflegeempfehlungen (z.B. 
regelmässiger Kronenschnitt)  

   

Baumplegeaufgaben  
[Maintenance task] 

Nutzerdefinierte prioritären Baumpflegeaufgaben (z.B. 
Schädlingsbekämpfung {oder Risiko-Assessement})  

   

Konflikte mit Wegeinfrastrukturen  
[Sidewalk conflict] 

Ausmass des Konflikts zwischen dem Wurzelanlauf des Baumes / 
Wurzeln erster Ordnung und den umgebenden Wegeinfrastrukturen 
(Hartbelag / Bürgersteig) 

   

Konflikte mit Freileitungen  
[Utility conflict] 

Mögliche oder vorhandene Konflikte zwischen Baumzweigen/Ästen 
und Freileitungen. Eco bietet 3 Standardklassen zur Auswahl. 

   

Nutzer ID [user ID] Einmalige Baum ID    

Schadorganismen 
(IPED) 
[pest (IPED)] 

Anzeichen und Symptome 
für Baumstress 

Fehlen oder Vorhandensein von Anzeichen oder Symptomen von 
Wipfeldürre, Reiterationstrieben, Blattwelken sowie umwelt- oder 
menschbedingtem Stress 

 x  

Anzeichen und Symptome 
am Blattwerk/ Zweigen 

Fehlen oder Vorhandensein von Anzeichen oder Symptomen von 
Entlaubung, Blattverfärbung, abnormalem Blattwerk oder 
Schadinsekten sowie das Ausmass des betroffenen Blattwerkes 

 x  

Anzeichen und Symptome 
an Ästen/Stamm 

Fehlen oder Vorhandensein von Anzeichen oder Symptomen von 
Insekten oder Krankheiten an Ästen/ Stamm sowie der Ort der 
Anzeichen und Symptome. 

 x  
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Table 4. Bauminformationen (Vollinventur [complete inventory project]).  
Nutzen Sie diese Tabelle, um Ihre Entscheidungsfindung bei der Datenerhebungn zu unterstützen: 
In der Spalte ‘Beschreibung’ finden Sie weitere Informationen zu jeder Messgrösse. Die in den rechten Spalten 
dargestellten zusätzlichen Modellkomponenten erfordern die Erhebung bestimmter optionaler Messgrössen. Die 
optionalen Messgrössen, die für jede zusätzliche Modellkomponente erhoben werden müssen, sind mit einem "x" 
gekennzeichnet. 
 
{Das IPED-App ist in ‘i-Streets’ integriert und derzeit nur für US-Projekte verfügbar. Baummanagementkategorien 
können aber durch die Nutzer selber definiert werden, um Angaben zu Schadorganismen machen zu können.} 
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Messgrössen Beschreibung 

Minimal erforderliche Felder 

Arten [species] 
Identifizieren und geben Sie Art- und Volksnamen von jedem 
Baum an. 

Erforderlich 

BHD [DBH] 
Messen Sie den Brusthöhendurchmesser und geben Sie die Werte 
für jeden Baum an 

Erforderlich 

Allgemeine Felder 

Stratifizierung [strata] 
Straten, in die das Untersuchungsgebiet für die Analyse unterteilt wird 
(z.B. nach Landnutzung, Quartieren) 

  

Landnutzung [land use] Landnutzungstyp am Ort, wo sich der Baum befindet   

Status [status] Status des Baumes, entstanden durch Pflanzung oder Naturverjüngung.    

GPS Koordinaten Längen- und Breitengrad des Baumes   

Strassenbaum / kein Strassenbaum 
[Street tree/non-street tree] 

Identifizieren Sie, ob es sich um einen Strassenbaum handelt oder nicht 
(J/N) 

  

Öffentlich/Privat [public/private] 
Klassifizieren Sie jeden Baum, ob er unter städtischem Management 
(öffentlich) steht oder nicht (Privat) 

  

Felder zu Baumdetails 

Baumadresse [tree address] 
Strassenadresse des Baumes oder Notizen zur Loakilisierung für 
Bäume ohne Adresse 

  

Gesamtbaumhöhe [total tree height] 
Die Höhe des Baumes gemessen vom Boden bis zur Spitze (tot oder 
lebendig) 

  

Kronenaus-
dehnung [crown 
size] 

Lebendkronen-
Baumhöhe [height to 
live top] 

Höhe gemessen vom Boden bis zur lebenden Baumspitze   

Höhe Kronenansatz 
[height to crown 
base] 

Höhe gemessen vom Boden bis zum Ansatz der lebenden Baumkrone   

Kronenbreite  
[crown width] 

Breite der Baumkrone in zwei Richtungen gemessen: von Nord-Süd und 
von Ost-West 

  

Kronenverlust (%) 
[percent missing] 

Der prozentuale Anteil des Kronenvolumens, welcher nicht mit Ästen 
oder Blätter besetzt ist 

  

Kronengesundheit 
[crown health] 

Wipfeldürre  
[crown dieback] 

Schätzung des Prozentanteils der Krone mit Totenästen   

Lichtexposition der Krone [crown light 
exposure CLE] 

Anzahl Seiten eines Baumes, die Sonnenlicht von oben erhalten 
(maximal 5) 

  

Energie [energy] 

Richtung [direction] Richtung vom Baum zum nahegelegensten Teil des Gebäudes x  

Distanz [distance] 
Kürzeste Distanz zwischen dem Baum und dem nahegelegensten Teil 
des Gebäudes 

x  

Felder zum Baummmanagement 

Baumpflegeempfehlungen [Maintenance 
recommended] 

Nutzerdefinierte allgemeine Baumpflegeempfehlungen (z.B. 
regelmässiger Kronenschnitt)  

  

Baumplegeaufgaben  
[Maintenance task] 

Nutzerdefinierte prioritären Baumpflegeaufgaben (z.B. 
Schädlingsbekämpfung {oder Risiko-Assessement})  

  

Konflikte mit Wegeinfrastrukturen 
[Sidewalk conflict] 

Schadenausmass, welches die Bäume an umgebenden 
Wegeinfrastrukturen verursachen 

  

Konflikte mit Freileitungen  
[Utility conflict] 

Nutzerdefinierte potentielle oder existierende Konflikte zwischen Äste 
und Freileitungen 

  

Nutzer ID [user ID] Einmalige Baum ID   

Schadorganismen 
(IPED) 
[pest (IPED)] 

Anzeichen und 
Symptome für 
Baumstress 

Fehlen oder Vorhandensein von Anzeichen oder Symptomen von 
Wipfeldürre, Reiterationstrieben, Blattwelken sowie umwelt- oder 
menschbedingtem Stress 

  

Anzeichen und 
Symptome am 
Blattwerk/ Zweigen 

Fehlen oder Vorhandensein von Anzeichen oder Symptomen von 
Entlaubung, Blattverfärbung, abnormalem Blattwerk oder Schadinsekten 
sowie das Ausmass des betroffenen Blattwerkes 

  

Anzeichen und 
Symptome an 
Ästen/Stamm 

Fehlen oder Vorhandensein von Anzeichen oder Symptomen von 
Insekten oder Krankheiten an Ästen/ Stamm sowie der Ort der Anzeichen 
und Symptome. 

  



 

 28 

 

 

 

Stratifizierung bei Vollinventuren [collecting strata for complete inventories] 

Stratifizierung [strata] ist eine der Messgrössen, die in Tabelle 4 beschrieben wird. Diese Daten 

können in Vollinventuren [complete inventories] erhoben werden, um die Bäume Ihres 

Untersuchungsgebiets in verschiedene Straten zu unterteilen, wie z.B. nach Landnutzung oder 

Quartieren. 

In einigen Studien kann das Stratifizieren (unterteilen) von Bäumen in Zonen dabei helfen, 

Unterschiede zwischen verschiedenen Gebieten aufzuzeigen. Zum Beispiel ermöglicht eine 

stratifizierte Vollinventur mit vielen Bäumen, einen Vergleich zwischen verschiedenen Quartieren 

oder Landnutzungstypen. Der Entscheid zur Stratifizierung sollte von Ihren aktuellen oder 

künftigen Projektzielen sowie von Ihren verfügbaren Ressourcen abhängen.  

 

 

 

Wir empfehlen sehr, die folgenden Bauminformationen zu sammeln, um die Genauigkeit 

Ihrer Eco-Schätzungen zu verbessern! Lesen Sie mehr dazu unter Eco Guide to Data 

Limitations. 

• Aktuelle Landnutzung [actual land use] 

• Gesamtbaumhöhe [total tree height] 

• Lebendkronen-Baumhöhe [height to live top] 

• Höhe Kronenansatz [height to crown base] 

• Kronenausdehnung [crown width] 

• Kronenverlust (%) [percent crown missing] 

• Lichtexposition der Krone [crown light exposure] 

• Kronengesundheit (Wipfeldürre % [percent dieback])  

Tipp 

 

 

Die Stratifzierung wird bei Projekten mit Stichprobendesign [plot-based sample 

projects] unterschiedlich gehandhabt. Falls Sie ein Projekt mit Stichprobendesign 

durchführen und an einer Stratifizierung Ihrer Studie interressiert sind, lesen Sie 

mehr dazu unter Phase I > Plot-Based Sample Inventory. 

Tipp 

 

Im Eco Guide to Stratifying a Complete Inventory finden Sie Hinweise, wie Sie Ihr 

Projekt mit einem Vollinventurdesign vor- oder nachstratifizieren können. 

Eco Guide  

http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_StratifyingCompleteInventory.pdf
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Wenn Sie die Feldarbeiten vorbereitet haben und soweit sind, im Feld die Baumdaten zu erheben, 

stehen ihnen verschiedene Möglichkeiten zur Dateneingabe zur Verfügung. Überprüfen Sie die 

Beschreibungen sowie die Vor-/Nachteile jeder Methode, bevor Sie sich für eine Art der 

Dateneingabe entscheiden. 

 

Nutzung des ‘Mobile Data Collectors’ 

i-Tree Eco stellt Ihnen den ‘Mobile Data Collector’ für die Datenerhebung im Feld zur Verfügung. 

Damit können Projekte mit einem internetfähigen, mobilen Gerät durchgeführt werden. Es handelt 

sich hierbei nicht um eine App, die Sie herunterladen müssen, sondern um eine internet-basierte 

Inventurplattform zur Datenerhebung. Die einzige Anforderung ist ein mobiles Gerät mit einem 

Web-Browser, welcher HTML5 kompatibel ist. Zu den kompatiblen Browsern zählen die neuesten 

Versionen von Chrome und Firefox (für Android Telefone und Tablets), Safari (i-Phones, i-Pads) 

und in einem gewissen Umfang auch der Internet Explorer (IE) 9 und 10 (für Windows Telefone 

und Tablets). Der Internet Explorer hat nur beschränkte Möglichkeiten, Cache-Daten offline 

abzulegen – Nutzer müssen somit während der Datenerhebung im Feld «online» bleiben. Falls Sie 

IE benutzen, sollten Sie deshalb möglichst häufig Ihre Daten von Ihrem Mobilgerät auf den Server 

transferieren. Beachten Sie, dass eine Unterbrechung Ihrer Internet-Verbindung dazu führt, dass 

all Ihre nicht gespeicherten Daten verloren gehen. 

 

 

Vorteile 

• Einfaches Importieren der Daten in Eco 

 

Nachteile 

• Erfordert zusätzliche Technologien im Feld – Sie benötigen ein internetfähiges Gerät wie 

z.B. ein Tablet oder Smartphone.  

Nutzung von Papierformularen 

i-Tree stellt Ihnen ebenfalls ein Papierformular zur Datenerhebung zur Verfügung, welches eine 

einfache und günstige Methode zur Dateneingabe darstellt. 

 

Vorteile 

• Einfach zu verwenden 

• Benötigt keine weiteren Technologien im Feld – nur Papier und etwas zum Schreiben! 

 Art der Dateneingabe 

 

 

Für eine aktuelle Liste kompatibler Geräte, besuchen Sie das i-Tree Forum 

forum.itreetools.org oder lesen Sie das Dokument zu den Systemanforderungen 

www.itreetools.org/resources/manuals.php. 

Tip 

http://forums.itreetools.org/
http://www.itreetools.org/resources/manuals.php
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Nachteile 

• Daten müssen nachträglich manuell in Eco eingegeben werden. 

 

Zusätzliche Optionen 

PDAs 

Ältere Versionen von Eco unterstützten noch den Gebrauch von PDA (Personal Digital Assistant), 

welche ohne Weiteres auch mit der Desktop-Applikation funktioniert haben. Eco v6.0 ist mit PDA 

nicht mehr kompatibel.  

 

Andere Inventur-Plattformen ausser i-Tree 

Wenn Sie nicht über die finanziellen Mittel zur Beschaffung von mobilen Geräten oder PDAs 

verfügen oder Sie einfach eine alternative Methode bevorzugen, ist das kein Problem. Inventuren 

können auch mit eigenen erstellten Papierformularen oder Inventur-Tools durchgeführt werden. 

Die Desktop-Applikation von Eco beinhaltet eine nutzerfreunliche Eingabemaske, um den 

Eingabeprozess der Daten zu vereinfachen. 

 

 

 

Der letzte Schritt bevor Sie ins Feld gehen, ist das Vorbereiten ihrer Materialien zur 

Datenerhebung. Falls Sie ein Projekt mit Stichprobendesign [plot-based sample project] in Angriff 

nehmen, lesen Sie bitte den untenstehenden Abschnitt zur Erstellung von Feldplänen mit den 

Stichprobenflächen. Ansonsten können Sie unter Einstieg in Eco [Getting Started in Eco] 

weiterfahren. 

 

Erstellung von Feldplänen mit den Stichprobenflächen 

Für Projekte mit Stichprobendesign [sample inventory projects] müssen vor der Datenerhebung im 

Feld noch Karten mit der Lage der Stichproben erstellt werden, um die Standorte der Stichproben 

genau aufzeigen zu können. Falls die Stichproben im GIS randomisiert erstellt wurden, können 

Luftbildaufnahmen mit den entsprechenden Stichproben-Shapefiles überlagert werden. Dies hilft 

den Erhebungsteams die Stichproben und Stichprobenmittlepunkte im Feld aufzufinden. 

Ebenso können Stichprobenflächen, welche mit dem Google Maps Plot Generator randomisiert 

erstellt wurden, in GIS-Anwendungen geladen und mit Luftbildaufnahmen überlagert werden. 

Feldpläne mit den Stichprobenflächen können ausserdem dabei hilfreich sein, die verschieden 

Flächenanteile (%) pro Plot [plot cover percentages] abzuschätzen. Beispiele von solchen 

 Vorbereitung der Felderhebung 

 

 

Andere i-Tree Nutzer haben zur Dateneingabe bereits modifizierbare Datenblätter 

entwickelt. Diese sind auf www.itreetools.org zu finden unter Ressources > 

Archives. 

Tipp 

http://www.itreetools.org/
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Feldplänen finden Sie auf www.itreetools.org unter Resources > Archives > Eco Project 

Planning & Management Resources. 

Falls keine keine digitalen Luftbilder verfügbar sind oder Sie die Stichproben manuell erstellt 

haben, können Sie auch anderes digital oder analog verfügbares Kartenmaterial als Hintergrund 

(Landeskarten LK25 oder Übersichtspläne UP5) für die Darstellung der Stichproben nutzen. Die 

Grenzen sowie Mittelpunkte der Stichproben sollten jedoch identifiziert werden. 

 

 

Einstieg in Eco 

Falls Sie sich für den ‘Mobile Data Collector’ oder die Papierformulare von Eco entschieden 

haben, empfehlen wir Ihnen wie folgt fortzufahren: 

 

Erstellen Sie zunächst ein neues Project in Eco. Öffnen Sie die i-Tree Software indem Sie auf 

Ihrem Computer auf Start >(alle) Programme > i-Tree > i-Tree Eco v6 klicken. 

 

Um ein neues Projekt in Eco v6 zu starten: 

1 Klicken Sie auf File > New Project. 

2 Definieren Sie Ihren Projekttyp, indem Sie von der Auswahlliste den entsprechenden 

auswählen. 

3 Suchen Sie den Ordner, wo Ihr Projekt abgelegt werden soll und geben Sie einen 

Dateinamen ein. Klicken Sie nun auf Save. 

 

Um Ihr Projekt zu konfigurieren: 

1 Klicken Sie auf den Tab Project Configuration. 

2 Klicken Sie auf die Funktion Project Definition. 

3 Arbeiten Sie sich von links nach rechts durch die Tabs Project Settings, Location und 

Data Collection Options.  

4 Schliessen Sie die Funktion Project Definition, wenn Sie fertig sind und speichern Sie Ihre 

Einstellungen, indem Sie in der oberen rechten Seite auf OK klicken.  

5 Arbeiten Sie sich von links nach rechts durch die Tabs Project Configuration durch, um 

zusätzliche Informationen anzugeben, welche für Ihr Projekt relevant sind. 

 

 

 

Hinweis zum Erstellen von randomisierten Stichprobepunkten mit dem Google 

Maps Plot Generator oder GIS (ESRI) sind in den folgenden Handbüchern von Eco 

zu finden. 

• Eco Guide to Unstratified Samples 

• Eco Guide to Pre-stratified Samples 

Eco Guide 
 

http://www.itreetools.org/
https://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_UnstratifiedSamples.pdf
https://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_PreStratifiedSamples.pdf
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Papierformulare vorbereiten 

 

Falls Sie sich dazu enschieden haben, die Papierformulare von Eco zu benutzen und Sie Ihr 

Projekt bereits konfiguriert haben (wie oben beschrieben in Einstieg in Eco):  

 

1 Klicken Sie auf den Tab Data. 

2 Klicken Sie die Funktion Paper Form an. 

 

Im Aktionsfeld auf der rechten Seite erscheinen nun die Links zu den verschiedenen 

Datenblättern.Klicken Sie einen Link an, um die Formulare in Ihrem Web-Browser zu öffnen.  

Die folgenden Arten von Formularen sind verfügbar: 

 

• Für Nutzer, welche ein Projekt mit Vollinventurdesign [complete inventory project] 

durchführen, gibt es einzelne Datenblätter im xlsx-Format zur Eingabe der Baumdaten. 

• Für Nutzer, welche ein Projekt mit Stichprobendesign [plot-based sample project] 

durchführen, gibt es zwei Datenblätter. Das Excel-Formular (xlsx) ist für die Eingabe der 

Baumdaten bestimmt, das Word-Formular (doc) für die Eingabe der Stichprobendaten. 

 

Den ‘Mobile Data Collector’ vorbereiten 

 

 

 

Während Ihrer Arbeit in Eco, benutzen Sie den Hilfetext auf der linken 

Bildschirmanzeige. Für jeden Knopf und Funktion gibt der Hilfetext Schritt für 

Schritt Anweisungen.  

Tipp 

 

 

Benutzen Sie Informationen in Phase IV > Navigating the User Interface, um sich 

durch die Project Configuration Tabs zu navigieren.  

Tipp 

 

 

Bevor Sie mit dem ‘Mobile Data Collector’ arbeiten können, müssen Sie Ihre 

Projektkonfiguration einreichen [submit]. Falls Sie Ihr Projekt nicht einreichen, haben Sie 

mit Ihrem Mobilgerät keinen Zugriff auf den ‘Mobile Data Collector’. 

Achtung 

 
! 
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Falls Sie sich dazu entschieden haben, Ihre Daten mit dem ‘Mobile Data Collector’ einzugeben 

und Sie bereits Ihr Projekt konfiguriert haben (wie oben beschrieben in Einstieg in Eco): 

 
1 Klicken Sie auf den Tab Data. 

2 Klicken Sie auf die Funktion Submit to Mobile. 

3 Geben Sie Ihre E-Mail-Adresse in das dafür vorgesehene Feld ein und bestätigen Sie 

diese. 

4 Geben Sie Ihr Passwort in das dafür vorgesehene Feld ein und bestätigen Sie dieses.  

5 Kreuzen Sie die Kästchen neben den Datensätzen an, welche Sie einreichen möchten. 

6 Klicken Sie auf Submit Project.  

7 Öffnen Sie das von Ihnen angegebene E-Mail-Konto und lesen Sie die Instruktionen zum 

Benutzen des ‘Mobile Data Collectors’. 
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In Phase IIIB wird beschrieben, wie die für Ihr Eco-Projekt erforderlichen Messgrössen [data 

variables] erhoben und erfasst werden. Die beschriebene Methodologie dient dazu allen 

Benutzern standardisierte Protokolle zur Erhebung ihrer Daten zur Verfügung zu stellen. 

 

An diesem Punkt sollten Sie bereits: 

• sich entschieden haben, welche Messgrössen Sie im Feld erheben werden. 

• sich entschieden haben, wie Sie Ihre Daten erheben und eingeben werden. 

• ihre Stichprobenflächen [plot samples] bestimmt haben (nur für Eco-Projekte mit 

Stichprobendesign [plot-based sample projects]).  

• ihre Materialien zur Datenerhebung im Feld vorbereitet haben. 

 

Nachfolgend sind die verschiedenen Methodologien beschrieben, welche zur Erhebung aller 

erforderlichen und optionalen Messgrössen eines Eco Projektes nötig sind. Die Messgrössen 

können sowohl in Projekten mit (A) einem Stichprobendesign [plot-based sample inventory 

projects], (B) einem Vollinventurdesign [complete inventory projects] als auch (C) mit beiden 

Inventurdesigns erhoben werden. Benutzen Sie das Eco User’s manual, um sicherzugehen, dass 

Sie diejenigen Messgrössen erheben, welche für Ihr Projekt angemessen sind. 

 

Die Messgrössen sind in Phase IIIB in vier Kategorien unterteilt: 

• Aufnahmeinformationen [survey information] 

• Stichprobeninformationen [plot information] 

• Bauminformationen [tree information] 

• Managementinformationen [management information] 

 

Jede Messgrösse wird im Detail beschrieben und es werden Informationen zur Dateneingabe mit 

den Papierformularen oder dem ‘Mobile Data Collector’ von Eco bereitgestellt. 

  

Phase IIIB: Erhebung der Felddaten 

 Durchführung der Feldarbeiten 
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Falls Sie sich bei der Felddatenerhebung für den ‘Mobile Data Collector’ von Eco entschieden 

haben, müssen Sie auch ein internetfähiges, mobiles Gerät, wie z. B. ein Smartphone oder ein 

Tablet benutzen. Es gibt ein paar wichtige Dinge, die Sie wissen sollten, wenn Sie Eco in einem 

mobilen Gerät benutzen.  

Um den Zugang zu Eco für möglichst viele Geräte zu ermöglichen, haben wir uns dazu 

entschieden, den ‘Mobile Data Collector’ als Web-Form aufzubauen, auf den Sie von Ihrem 

Internet-Browser Zugriff habe und nicht als ein App. Dies hat folgende Konsequenzen für die 

Benutzung: 

 

• Bei der Dateneingabe werden die Daten im Zwischenspeicher [cache] Ihres 

Internetbrowsers temporär gespeichert. Die Menge an Daten, welche zwischengespeichert 

werden kann, ist abhängig von den jeweiligen Geräten, dem Browser und den 

Einstellungen, die Sie nutzen. Sie können die Menge an möglichem Speicherplatz 

vergrössern, indem Sie zuvor Ihren Browser-Verlauf und andere Daten bereinigen. Falls Ihr 

Speicher aufgrund des Browser-Verlaufs oder anderer Daten voll ist, ist Ihre Dateneingabe 

auf wenige Einträge beschränkt. Mit dem bereinigten Browser-Verlauf und Daten können 

Sie mehrere Hundert Einträge eingeben und speichern. 

 

 

• Für Nutzer von Chrome, Firefox und Safari: Obwohl Sie mit einer Webseite arbeiten, sind 

Sie nicht durch die Internetverbindung limitiert (via WiFi oder einer highspeed 

Datenverbindung, wie zum Beispiel 3G oder höher). Der Cache Ihres Browsers erlaubt 

Ihnen, wie oben beschrieben, temporär auch ohne eine Internetverbindung zu arbeiten. 

Wegen einer kurzen Internetunterbrechung müssen Sie sich keine Gedanken machen, 

aber Sie brauchen später zwangsläufig eine Verbindung, um Ihre Daten einzureichen.  

 

• Für Nutzer vom Internet Explorer (IE) trifft dies leider nicht zu. IE ist kann Offline-Daten im 

Cache nur begrenzt speichern. Benutzer von IE müssen während der Felddatenerhebung 

stets mit dem Internet verbunden bleiben. Falls Sie IE benutzen, müssen Sie deshalb Ihre 

Daten von Ihrem mobilen Gerät möglichst oft beim Server einreichen, da Sie ansonsten 

Tipps zur Dateneingabe 

 Benutzung des ‘Mobile Data Collectors’ 

 

 

Reichen Sie Ihre Daten regelmäßig beim Server ein [submit data], um 

Datenverluste zu vermeiden oder den Cache Ihres Browsers unnötig zu füllen. 

Weitere Informationen finden Sie in den Ausführungen unter Menü ‘Options’ 

weiter unten. 

Tipp 
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alle bereits erhobenen Daten seit der letzten Einreichung verlieren, falls Ihre Verbindung 

zum Internet unterbrochen wird. 

 

 

• Sobald Ihr Cache zu voll wird, erscheint eine Meldung, welche Sie darauf hinweist, dass 

Sie Ihren Browserverlauf und temporäre Dateien [cache] löschen sollen. WARNUNG: Sie 

müssen zuvor ihre Daten einreichen, sonst gehen diese verloren! 

 

Einstieg 

Der ‘Mobile Data Collector’ in Eco ist keine App – es handelt sich hierbei um eine Web-Form auf 

die Sie mit dem Internet Zugriff haben und das speziell für Ihr Projekt entwurfen wurde. Gehen Sie 

wiefolgt vor, um auf den ‘Mobile Data Collector’ zuzugreifen und mit der Datenerhebung beginnen 

zu können: 

 

1 Öffnen Sie Ihr E-Mail-Konto auf Ihrem mobilen Gerät.  

 

2 Öffnen Sie die E-Mail mit dem Link zu Ihrem projektspezifischen Web-Form.  

 

3 Ein neues Fenster öffnet sich daraufhin in dem Browser Ihres Gerätes. Um anfangen zu 

können, geben Sie Ihr Benutzernamen in der Surveyor Box ein und klicken sie auf Login. 

 

Menü ‘Options’ 

Das Zahnrad-Symbol oben Links gibt Ihnen Zugriff auf das Menü ‘Options’, unter dem Sie 

wichtige übergeordnete Funktionen betätigen können, wie zum Beispiel das Einreichen Ihrer 

Daten, das Neuladen Ihrer Projektkonfigurationen sowie das Ändern der Anzahl angezeigter 

Einträge pro Seite. 

 

Settings [Einstellungen]: Unter Settings können Sie die Anzahl der Stichproben und Arten 

pro Seite ändern, die angezeigt werden sollen (10 ist die Grundeinstellung). Des Weiteren 

können Sie einstellen, ob die Arten nach ihren wissenschaftlichen Namen, ihren Volksnamen 

oder ihrer Art-Codes aufgelistet werden sollen. 

 

Submit data [Daten einreichen]: Es ist wichtig, dass Sie Ihre Daten möglichst oft im Web-

Server einreichen! Verifizieren Sie im Fenster Submit Data die Anzahl einzureichender 

Stichproben und klicken anschliessend auf Submit. 

 

Reload project [Projekt neu laden]: Falls gewisse Aspekte Ihrer Projektkonfiguration sich 

 

 

Wenn Sie Probleme mit dem Internetbrowser Ihres Mobilgeräts haben, können Sie 

im App Store Ihres Geräts, den Internetbrowser herunterladen, der für Sie am 

besten geeignet ist. 

Tipp 



 

 37 

ändern, nachdem Sie bereits mit der Datenerhebung begonnen haben, müssen Sie das 

Projekt neu laden, um die Veränderungen miteinzubeziehen. Veränderungen in Ihrer 

Projektkonfiguration müssen in der i-Tree Eco Applikation gemacht und über die Registerkarte 

Data eingereicht werden. Nachdem das Projekt eingereicht wurde, klicken Sie im ‘Mobile Data 

Collector’ auf Reload Project und Ihre Konfiguration wird auf dem neuesten Stand sein.   

Hauptfenster [main window] 

Für Projekte mit Stichprobendesign [sample inventory projects] mit bereits vorgängig 

geladenen Stichprobenflächen, wird im Hauptfenster eine numerische Liste aller Stichproben 

angezeigt. Klicken Sie die entsprechende Stichprobennummer an und beginnen Sie mit der 

Dateneingabe. Bei Projekten mit einem Vollinventurdesign [complete inventory projects] 

beginnt die Dateneingabe, sobald Sie auf der oberen rechten Seite, auf das Plus Zeichen (+) 

klicken, um den ersten Baum hinzuzufügen. 
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Beschreibung:  

Datum der Datenerhebung. 

 

Wie dokumentieren 

• Papierformular (für Stichproben- und Vollinventur [sample and complete]): Eingabe unter 

DATE auf der ersten Seite. 

• ‘Mobile Data Collector’ (für Stichproben- und Vollinventur [sample and complete]): Das 

Datum wird automatisch nach dem Einloggen aufgezeichnet. 

 

 

Beschreibung: 

Namen oder Anzahl der Teammitglieder, welche die Erhebung durchführen. 

 

Wie dokumentieren 

• Papier (für Stichprobeninventur [sample]): Eingabe unter CREW auf der ersten Seite. 

• Papier (für Vollinventur [complete]): Eingabe unter CREW/DATA COLLECTOR ganz oben 

auf der Seite. 

• ‘Mobile Data Collector’ (für Stichproben- und Vollinventur [sample and complete]): Der 

Name wird zu Beginn der Inventur unter Surveyor beim Login eingegeben. 

 
 

 
Die Stichprobeninventur [Sample inventorying] beginnt mit dem Einrichten der 

Stichprobenfläche. Falls Sie eine Vollinventur [complete inventory] machen, können Sie alles 

bis zu ‘Bauminformationen’ [Tree Information] überspringen. 

Falls Sie eine Stichenprobeninventur [plot-based sample inventory] durchführen, beschaffen Sie 

sich, wenn nötig, eine Erlaubnis zum Betreten der Grundstücke (vom Eigentümer oder den 

Bewohnern). 

Aufnahmeinformationen [survey information] 

 Aufnahmedatum  

 Team 

Stichprobeninformationen [plot information] 
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Bestimmen Sie zunächst den Stichprobenmittelpunkt sowie die Stichprobengrenzen. Falls Sie die 

einzelnen Stichproben, wie in Phase IIIA beschrieben (siehe Vorbereitung der Feldaufnahmen > 

Erstellung von Feldplänen mit den Stichprobenkartenflächen) auf Feldplänen dargestellt 

haben, helfen die Luftbilder und/oder Pläne Ihnen nun beim Einrichten der Stichprobe. Falls die 

Stichprobe geneigt ist, messen Sie die Hangneigung mit einem Neigungsmesser und passen Sie 

den Radius der Stichprobe entsprechend an. Der angepasste Stichprobenradius kann in der 

folgenden Tabelle abgelesen werden: 

Neigung % 5 10 12 15 17 20 22 25 27 30 

Winkel der Neigung 2.9 5.7 6.8 8.5 9.7 11.3 12.4 14.0 15.1 16.7 

Angepasster Radius (SP-Grösse von 0.04 ha) 11.37 11.37 11.40 11.40 11.43 11.46 11.49 11.52 11.55 11.58 

Angepasster Radius (SP-Grösse von 0.067 ha) 14.66 14.69 14.69 14.72 14.75 14.78 14.81 14.87 14.90 14.97 

 

In einigen Fällen kann sich der Stichprobenmittelpunkt an einem für Sie unzugänglichen Ort 

befinden, wie zum Beispiel in der Mitte eines Gebäudes oder einer Autobahn. Wählen Sie in einem 

solchen Fall keine andere Stichprobe, sondern befolgen Sie die nachfolgenden Anweisungen 

unter ‘Unzugängliche Stichprobenmittelpunkte’ (siehe unterstehender Kasten), um stattdessen 

einen Baummesspunkt [Tree Measurement Point] (TMP) für die weitere Datenerhebung zu 

bestimmen. 

 

Ersatzstichproben hinzufügen 

Falls es Ihnen absolut unmöglich ist eine Stichprobe zu betreten oder die Daten aus der Ferne zu 

ermitteln, wählen Sie eine Ersatzstichprobe aus. Erstellen Sie hierzu vorgängig eine Liste mit 

möglichen Ersatzstichproben und beginnen Sie mit der ersten Stichprobe in der Liste der 

entsprechenden Landnutzungsklasse. Bei einem Rasterflächendesign zur Festlegung der 

Stichprobeflächen sollte die Ersatzstichprobe sowohl im gleichen Raster liegen als auch die 

gleiche Landnutzung aufweisen, wie die unzugängliche Stichprobe. Halten Sie sich an die 

Reihenfolge, der in der Liste angegebenen Ersatzstichproben. 

 

Falls Sie während der Projektkonfiguration keine Ersatzstichproben definiert haben, können Sie 

neue Stichproben manuell zur Datenbank hinzufügen, sobald Sie wieder an Ihrem Arbeitsplatz 

sind. Öffnen Sie hierfür in der Eco Applikation die Funktion ‘Plots’ im Registerblatt ‘Data’. In der 

 Einrichten der Stichprobe 

 

 

Beispiele für entsprechende Informationsbriefe [notification letters and access 

response letters] wurden bereits durch andere Eco-Nutzer erstellt. Diese sind im 

Internet auf www.itreetools.org unter Resources > Archives zu finden {auf 

Englisch}. 

Tipp 

https://www.itreetools.org/index.php
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Multifunktionsleiste sollte nun ‘Actions’ erscheinen. Benutzen Sie die Funktion ‘New’, um eine 

neue Stichprobe zur Stichprobentabelle hinzuzufügen.  

 
Sobald die Stichprobenmittelpunkte, Stichprobengrenzen und TMPs (falls nötig) bestimmt sind, 
können Sie mit der Datenerhebung beginnen. 
 

Unzugängliche Stichprobenmittelpunkte 
In manchen Fällen befindet sich der Stichprobenmittelpunkt an einem für Sie unzugänglichen Ort, wie zum Beispiel in 

der Mitte eines Gebäudes oder einer Autobahn. Nachfolgend wird beschrieben, wie man die Stichprobengrenzen sowie 

die Position der Bäume bestimmt, wenn der Stichprobenmittelpunkt unzugänglich ist (Abb. 1). (Achten Sie darauf, dass 

die Zahlen im folgenden Beispiel, sich auf eine 0.04 ha grosse Stichprobe beziehen.) 

 

Bestimmen Sie «a», indem Sie, mittels Karten oder Luftbildaufnahmen, die ungefähre Position des wahren 

Stichprobenmittelpunktes schätzen. Berechnen Sie «b», indem Sie «a» vom Stichprobenradius substrahieren (zum 

Beispiel 11.3 m – «a» m bei einer 0.04 ha grossen Stichprobe). Somit ist «b» der Abstand zwischen der 

Stichprobengrenze und der Gebäudewand.  

 

Um die generelle Stichprobengrenze 

festzulegen, laufen Sie 8.0 m (y1) parallel 

und dann 3.3 m (x1) senkrecht zum 

Gebäude. Das sollte einem Punkt auf der 

Stichprobengrenze entsprechen, der circa 

in einem 45˚ Winkel zum Startpunkt liegt. 

Wenn Sie dann 3.3 m (y2) parallel und 

dann 8.0 m (x2) senkrecht zum Gebäude 

laufen, so erreichen Sie einen weiteren 

Punkt auf der Stichprobengrenze, welcher 

in einem 90˚ Winkel zum Startpunkt liegen 

sollte. 

 

Um die Bäume, die sich innerhalb der 

Stichprobe befinden einfacher zu 

lokalisieren, sollte das Team, wie oben 

beschrieben, zuerst die Stichproben-

grenzen bestimmen und dann einen Punkt 

auswählen, von dem aus Distanz und 

Richtung möglichst einfach gemessen 

werden können und der als 

Baummesspunkt (TMP [tree measurement 

point]) dient. In der Abbildung wurde eine 

Gebäudeecke als Baummesspunkt (TMP) 

ausgewählt. (Geben Sie den TMP in Ihren 

Notizen an, z.B. nordwestliche Ecke des 

Gebäudes) 

 

Achten Sie darauf, dass Sie nur diejenigen 

Bäume angeben, welche sich innerhalb des Radius des wahren Stichprobenmittelpunktes befinden. Die Bäume c, d und 

f befinden sich alle innerhalb der wahren Stichprobengrenze und müssen ins Inventar aufgenommen werden. Der Baum 

e befindet sich zwar innerhalb von 11.3 m vom TMP aber nicht vom wahren Stichprobenmittelpunkt entfernt. Er liegt also 

ausserhalb der Stichprobengrenze und wird nicht zu dieser Stichprobe hinzugezählt. 

 

Abb. 1— Die Bestimmung des Baummesspunktes (TMP) und der 

Stichprobengrenzen 
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Beschreibung: 
ID Nummer pro Stichprobe (muss ein einmaliger Identifikator sein). 
 
Wie dokumentieren 

• Papier: Eingabe der einmaligen Nummer unter PLOT ID in der oberen Hälfte der ersten 

Seite.  

• ‘Mobile Data Collector’: Auswahl der Plot ID im Hauptfenster aus der Liste der generierten 

Stichproben.  

 

 

 

Beschreibung:  

Strassenadresse sowie jegliche Informationen zum Auffinden der Stichprobe falls keine 

Strassenadresse vorhanden ist. Diese Variable ist besonders hilfreich beim mehrmaligen 

Aufsuchen der Stichproben oder beim Erstellen von permanenten Stichproben.  

 

Wie dokumentieren 

• Papier: Eingabe der Adresse unter Plot address auf der ersten Seite. 

• ‘Mobile Data Collector’: Eingabe unter Plot Info > Address. 

 

 

Beschreibung: 

Geben Sie hier an, ob die permanenten Stichproben mit einer permanenten Markierung [identifier] 

gekennzeichnet wurden (Y/N). 

 

Wie dokumentieren 

• Papier: Eingabe von Ja (Y) oder nein (N) unter Permanent stake used auf der ersten 

Seite. 

• ‘Mobile Data Collector’: Klicken Sie auf Ja oder Nein unter Plot Info > Stake. 

 

 

Beschreibung: 

Längen- und Breitengrad des Stichprobenmittelpunkts. Diese Variable ist besonders hilfreich beim 

mehrmaligen Aufsuchen der Stichproben oder beim Erstellen von permanenten Stichproben, auch 

 Stichproben ID 

 Stichproben Adresse 

 Permanente Markierung [stake] 

 GPS Koordinaten 
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wenn die Genauigkeit von GPS-Daten stark variieren kann, besonders unter Bäumen.  

 

Wie dokumentieren 

• Papier: Eingabe der Längen- und Breitengrade unter GPS Coordinates auf der ersten 

Seite. 

• ‘Mobile Data Collector’: Eingabe unter Map Coordinates. Es bestehen drei Optionen, um 

Koordinaten aufzunehmen. Sie können die Koordinaten selber eingeben, die GPS Ihres 

Gerätes verwenden oder die Lage auf der Karte antippen.  

 

 

Beschreibung:  

ID Nummer des/der Fotos der jeweiligen Stichprobe. Benutzen Sie diese Variable, um eine 

Übersicht über Ihre Bilddateien zu bekommen und die Ablage nachvollziehen zu können. 

 

Wie dokumentieren 

• Papier: Eingabe der ID Nummer unter Photo ID(s) auf der ersten Seite.  

• ‘Mobile Data Collector’: Eingabe unter Plot Info > Photo. 

 

 

Beschreibung:  

Skizze der Stichprobe, welche die Richtung sowie die Distanzen zwischen dem 

Stichprobenmittelpunkt und den Referenzobjekten aufzeigt und/oder die Lage anderer Fixpunkte 

zum Stichprobenmittelpunkt. 

 

Wie dokumentieren 

• Papier: Zeichnen Sie eine Skizze am Ende der zweiten Seite unter Plot Sketch Area. 

• ‘Mobile Data Collector’: N/A 

 

 

Beschreibung:  

Name und Telefonnummer der Kontaktperson der jeweiligen Stichprobe. Geben Sie diese 

Informationen an, sofern vorhanden. In Wohngebieten werden die Kontaktdaten nicht direkt 

erfragt, sondern nur eingetragen, wenn Sie die Namen auf den Briefkästen ablesen können. Zu 

wissen, ob es sich um den Eigentümer oder einen Mieter handelt, kann in Gesprächen nützlich 

sein.  

 

Wie dokumentieren 

• Papier: Eingabe von Namen und Telefonnummer unter Plot Contact Name und Phone # 

 Foto ID 

 Skizze der Stichprobe 

 Kontaktinformationen für die Stichprobe 
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auf der ersten Seite. 

• ‘Mobile Data Collector’: Eingabe unter Plot Info > Contact Info. 

 

 

Beschreibung: (Beachte: Diese Messgrösse ist erforderlich für alle Projekte mit 

Stichprobendesign [plot-based sample projects.]) 

 

Der Flächenanteil der Stichprobe, welcher vom Feldteam betreten und gemessen werden kann 

(entweder direkt oder durch Schätzungen). Dadurch können auch Daten von Teilflächen erhoben 

werden. Wenn Sie zum Beispiel 10% der Stichprobe lediglich hinter einem Gebäude oder einem 

grossen Zaun betrachten können und keine Erlaubnis zum Betreten bekommen konnten, so 

tragen Sie hier 90% ein (Sicherheitsrisiken können auch ein Grund dafür sein, dass nur Teile der 

Stichprobenfläche aufgenommen werden können). Falls Sie jedoch über den Zaun sehen und 

BHD, Beschirmungsprozent, Baumart sowie sonstige Baummessungen abschätzen können, so 

tragen Sie 100% ein.  

 

Wie dokumentieren 

• Papier: Eingabe unter Per. of Plot Measured (%) auf der ersten Seite des Formulars. 

• ‘Mobile Data Collector’: Eingabe unter Plot Info > % Measured 

 

  

 Messbarer Flächenanteil [percent measured] 

 

 
Im seltenen Fall, wenn Ihre Stichprobe (in stratifizierten Projekten) in mehr als ein von Ihnen 

zugewiesenes Stratum fällt, erfüllt diese Messgrösse einen weiteren Zweck. Beispielsweise 

kann der Stichprobenmittelpunkt in die zugewiesene Landnutzungsklasse fallen, während die 

Stichprobengrenzen in eine andere Landnutzung unterschiedlicher Vegetations-Charakteristika 

hineinreichen. In diesem Fall können Sie die Daten nur in dem Teil der Stichprobe aufnehmen, 

welche sich innerhalb der zugewiesenen Landnutzungsklasse befindet und benutzen dann den 

Eintrag «Percent measured» um diese Änderung zu notieren. Zum Beispiel: Falls der 

Stichprobenmittelpunk im Landnutzungs-Stratum ‘Gewerbe / Industrie’ [commercial land use] 

liegt und über Stichprobengrenze verfügt, die ebenfalls Waldflächen umfassen, können Sie 

unter «percent measured» nur den Teil der Vegetation angeben, der sich im Landnutzungstyp 

‘Gewerbe / Industrie’ der Stichprobe befindet und vermeiden damit, dass die Bäume im 

Waldgebiet mit berücksichtigt werden . 

Tipp 
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Beschreibung: (Achtung: Diese Messgrösse ist erforderlich für alle Projekte mit 

Stichprobendesign [plot-based sample projects].) 

Der Flächenanteil (%) der Stichprobe, welcher durch die Baumkronen beschirmt wird {Synonym 

‘Deckungsgrad’ aller Bäume}. Sie können sich dies als den Teil der Stichprobe vorstellen, welcher 

von den Bäumen beschattet wird, wenn die Sonne am höchsten steht; er bewegt sich von 0 bis 

100%. Die Beschirmung kann auch durch Bäume ausserhalb der Stichprobe kommen, so dass 

auch Stichproben ohne Bäume eine Beschirmung aufweisen können. 

Wie dokumentieren 

Geben Sie die Beschirmung (%) durch Bäume in 5%-Intervallen an, indem Sie die Mittelpunkte (3, 

8, 13, 18, usw.) benutzen oder 0%, 100%. 

• Papier: Eingabe unter Plot Tree Cover (%). 

• ‘Mobile Data Collector’: Eingabe unter Plot Info > % Tree cover. 

 

 

 

Beschreibung:  

Der Flächenanteil der Stichprobe, welcher durch die Strauchschicht beschirmt wird. Sie können 

sich dies als den Teil der Stichprobe vorstellen, welcher von der Strauchschicht beschattet wird, 

wenn die Sonne am höchsten steht; er bewegt sich zwischen 0% und 100%. Zählen Sie 

mehrerschichtige Sträucher nicht doppelt. 

 

Wie dokumentieren: 

Geben Sie den Deckungsgrad der Strauchvegetation in 5%-Intervallen an, indem Sie die 

Mittelpunkte (3, 8, 13, 18, usw.) benutzen oder 0%, 100%. 

 Beschirmung [tree cover] 

 Deckungsgrad Strauchvegetation [shrub cover] 

 

 

Feldpläne mit Luftbildern als Hintergrund, sind besonders hilfreich zur Bestimmung 

der Beschirmungsprozente durch Bäume. 

Tipp 

 

 

 

Sträucher sind in Eco Projekten definiert, als Gehölzpflanzen mit einem 

Brusthöhendurchmesser (BHD) ≤ 2.54 cm, während Bäume einen BHD ≥ 2.54 cm 

aufweisen. Gehölzpflanzen, die kleiner als 30.5 cm sind (z.B. Jungpflanzen 

[seedling]), werden zur Krautschicht gezählt.  

Tipp 
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• Papier: Eingabe unter Shrub Cover (%). 

• ‘Mobile Data Collector’: Eingabe unter Plot Info > % Shrub cover. 

 

 

Beschreibung:  

Der Flächenanteil der Stichproben, welcher mit Bäumen bepflanzt werden kann (d.h, 

bepflanzbarer oden, welcher nicht nach oben von Baumkronen oder sonstigen Restriktionen 

begrenzt wird und wo das Anpflanzen/Etablieren von Bäumen nicht verboten ist, wie z.B. auf 

Gehwegen, Fussballfeldern usw.). 

Die Bepflanzung unterhalb von Strom- und Telefonleitungen ist gestattet. 

 

 

Wie dokumentieren: 

Geben Sie die bepflanzbare Fläche in 5%-Intervallen an, indem Sie die Mittelpunkte (3, 8, 13, 18, 

usw.) benutzen oder 0%, 100%. 

• Papier: Eingabe unter Plantable Space (%) auf der ersten Seite. 

• ‘Mobile Data Collector’: Eingabe unter Plot Info > % Plantable. 

 

 

 

Beschreibung: 

Legen Sie mindestens einen Orientierungspunkt (Referenzobjekt) fest, welches vom 

Stichprobenmittelpunkt ersichtlich ist. Permanente Stichproben erfordern zwei Referenzobjekte, 

dagegen werden drei Referenzobjekte empfohlen, wenn der Stichprobenmittelpunkt schwer zu 

finden ist. Referenzobjekte müssen sich nicht zwingend in der Stichprobe befinden. Die folgenden 

Daten sind notwendig um Ihre Referenzobjekte zu beschreiben: 

 

 Bepflanzbare Fläche [plantable space] 

 Referenzobjekte [reference object] 

 

 

Um die bepflanzbare Fläche genauer abschätzen zu können, können die 

nachfolgenden Bodenbedeckungsklassen einzeln geschätzt und anschliessend 

aufsummiert werden: Erde, Humus/Mulch, Kräuter/Efeu, Grasflächen mit/ohne 

Unterhalt. 

 

Tipp 

 

Da die Definition der bepflanzbaren Fläche relativ subjektiv ist, sollten Projektmanager 

bei der Einführung ihres Teams diese Messgrösse klar definieren. 

Achtung 

 
! 
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• Objekttyp – sichtbare Referenzobjekte, wie z. B. ein Stoppschild oder eine permanente 

Konstruktion, welche vom Stichprobenmittelpunkt gesehen werden kann. 

• Richtung – vom Stichprobenmittelpunkt zum Referenzobjekt. 

• Distanz – vom Stichprobenmittelpunkt bis zum Referenzobjekt. 

• BHD – Brusthöhendurchmesser im Fall, dass das Referenzobjekt ein Baum ist.  

 

Wie dokumentieren 

Versuchen Sie Objekte zu wählen, welche auch noch in den nächsten 5-15 Jahren vorhanden sein 

werden (z.B.: Stoppschilder, Telefonpfosten, permanente Konstruktionen, Gehwege). Falls die 

Stichprobe in einem Waldgebiet liegt und somit keine permanenten Strukturen (natürlich oder 

unnatürliche) vorhanden sind, so können Sie zwei einzigartige Bäume (besondere Baumart oder 

grosser BHD) als Referenzobjekte wählen, sofern Sie erwarten können, diese auch in der Zukunft 

wieder anzutreffen. Fotos der Referenzobjekte sind hilfreich. Beschreiben Sie jedes 

Referenzobjekt ganz spezifisch (z.B. Telefonpfosten 1.5m vom linken Fahrwegrand entfernt, wenn 

man in Richtung Haus schaut). Messen Sie die Distanz und die Richtung (1°-360°) vom 

Stichprobenmittelpunkt bis zu jedem der Referenzobjekte. 

• Papier: Eingabe vom Beschrieb des Objekttyps, Richtung und Distanz für eine oder zwei 

Referenzobjekte auf der ersten Seite. 

• ’Mobile Data Collector’: Im Fenster Reference Objects klicken Sie oben rechts auf das 

Pluszeichen (+) und wählen einen Objekttyp aus der Liste aus. Geben Sie nun Distanz 

und Richtung ein und klicken Sie danach oben rechts auf das Pfeil-Symbol. Wiederholen 

Sie dies, wenn nötig, für weitere Objekte. Um ein Objekt nachträglich zu bearbeiten, klicken 

Sie im Fenster Reference Objects auf das gewünschte Objekt. Wenn Sie mit der Eingabe 

der Referenzobjekte fertig sind, klicken Sie auf das linke Pfeil-Symbol im Fenster 

Reference Objects und kehren zum Hauptmenu zurück. 

 

  

 

Falls der Stichprobenmittelpunkt nicht zugänglich war, können Sie auch einen 

Ihrer Referenzpunkte als Baummesspunkt (TMP) auswählen. 

• Papier: Setzen Sie ein Häkchen neben dem als TMP verwendeten Objekt 

unter Reference Objects. 

• ’Mobile Data Collector’: Geben Sie TMP in das Feld Notizen unter dem Objekt 

ein, welches als TMP dient. 

Weitere Informationen finden Sie unter ‘Unzugängliche 

Stichprobenmittelpunkte’. 

Tipp 
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Beschreibung: 

Die Landnutzung sollte je nach den Eindrücken des Inventur-Teams, während der Datenaufnahme 

im Feld bestimmt werden (d.h. nicht von Landnutzungskarten).  

Diese Messgrösse beschreibt die aktuelle Landnutzung, was nicht zwingend dem Landeigentum 

{oder der Nutzungszone} entspricht.  

 

Eco stellt Ihnen 13 Landnutzungsklassen zur Auswahl. Alternativ können Nutzer eigene 

Landnutzungsklassen in der i-Tree Softwares definieren. Nutzerdefinierte Landnutzungsklassen 

müssen später aber einer der vorgegeben Default-Klassen zugeordnet werden. 

 

Die folgenden Daten sind notwendig, um die Landnutzung zu beschreiben: 

• Aktuelle Landnutzung [actual land use] – Landnutzungsklassen, so wie Sie im Feld 

beobachtet wurden.  

• Flächenanteil der Stichprobe (%) [percent of plot] – Der Anteil der Stichprobefläche, 

welcher von der jeweiligen Landnutzung beansprucht wird.  

 Landnutzung [land use] 

 

 

Die aktuellen Landnutzungsklassen können zwar angepasst werden, werden jedoch 

nicht zur Stratifizierung Ihres Projektes verwendet. Daher werden Ihre Projektdaten 

nicht anhand der nutzerdefinierten Landnutzungsklassen, sondern anhand der 

Default-Landnutzungsklassen analysiert und dargestellt. 

Weitere Informationen zur Stratifizierung Ihres Projektes finden Sie im Kapitel Phase 

I unter “Plot-Based Sample Inventory > Will you stratify your sample?”. 

Achtung 

 
! 

 

 

Bei der Datenerhebung unter ‘Bauminformationen’ können Sie die Landnutzung für 

jeden Baum am jeweiligen Standort einzeln eingeben. Falls Sie bei 

Stichprobeninventuren [sample inventories] die Landnutzung pro Stichprobe 

erhoben haben, müssen Sie die Lannutzung ebenfalls für den Baum schätzen.  

Weitere Informationen finden Sie unter ‘Bauminformationen’ im Abschnitt zur 

Landnutzung. 

Achtung 

 
! 
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Die folgenden Default-Landnutzungsklassen werden zur Verfügung gestellt: 

• Landwirtschaft (A) [agriculture]: Kulturland, Wiesen und Weiden, Obstplantagen, 
Weinberge, Baumschulen, Bauernhöfe und zugehörige Gebäude sowie Baumplantagen 
{z.B. Kurzumtriebsplantagen}, die nach landwirtschaftlichen Grundsätzen bewirtschaftet 
werden. 

• Friedhöfe (E) [cemetery]: Beinhaltet auch alle kleineren nicht-gepflegten Flächen 
innerhalb eines Friedhofs.  

• Gewerbe / Industrie (C) [commercial/industrial]: Land, das für gewerbliche Tätigkeiten 
genutzt wird, einschliesslich Einzelhandel, Dienstleistungen und Bürogebäude 
[professsionel business]. Umfasst auch industrielle Standardnutzungen, wie z. B. 
Produktion oder Verarbeitung, Aussenlagerplätze / Baustelleneinrichtungsplätze [staging] 
sowie Parkplätze in Innenstädten, die nicht mit einer institutionellen oder wohnbedingten 
Nutzung in Zusammenhang stehen. 

• Wald (F) [Forest]: Bewirtschaftete oder unbewirtschaftete Flächen, die mit Bäumen 
bedeckt und von ihnen dominiert sind {mit Bäumen bestockte Flächen, welche 
Waldcharakter aufweisen unabhängig ihrer rechtlichen Zuteilung}. (Hinweis: Gleichmässig 
aufgebaute Wälder, die als Plantagen bewirtschaftet warden {Kurzumtriebsplantagen} 
und Baumschulen werden am besten als Landnutzungsklasse ‘Landschirtschaft’ 
kategorisiert). 

• Golfplatz (G) [Golf course]: Umfasst das gesamte Gelände, egal ob dieses gepflegt wird 
oder nicht. 

• Öffentliche Einrichtungen (I) [Institutional]: Schulen, Spitäler / Gesundheitszentren, 
Hochschulen/Universitäten, religiöse Gebäude, Regierungsgebäude usw. (Hinweis: Wenn 
ein Grundstück grosse unbewirtschaftete Flächen enthält (z.B. für eine weitere 
Überbauung oder aus anderen Gründen), ordnen Sie die Fläche als ‘Vakant’ zu. Kleine 
Waldinseln in bewirtschafteten Flächen würden als ‘Öffentliche Einrichtung’ gelten.)  

• Mehrfamilienhaus (M) [Multi-family residential]: Gebäude mit >4 Wohneinheiten. 
(Hinweis: Ein Wohnkomplex bestehend aus mehreren zusammenhängenden kleinen 
Wohneinheiten (1-4 Wohnungen) wird als Mehrfamilienhaus betrachtet. Ein 
Wohnkomplex, der aus vielen separaten 1-4 Wohneinheiten und den dazugehörigen 
Grünflächen besteht, wird ebenfalls als Mehrfamilienhaus betrachtet.) 

 

 

Eco benutzt die Werte, um Anpassungen am Modell vorzunehmen, welche auf 

den Unterschieden bezüglich Baumwachstum und der monetären Bewertung 

[valuation characteristic] beruhen und im Zusammenhang mit den vorgegebenen 

Default-Landnutzungsklassen stehen. Zum Beispiel: Ein Baum, welcher in der 

Landnutzungsklasse ‘Transport’ (z.B. Autobahn) steht, besitzt eine andere 

Wachstumsrate, als ein Baum auf einem Golfplatz oder in einem Wohngebiet. 

Deswegen müssen jegliche nutzerdefinierten Landnutzungsklassen einer der 

vorgegebenen Eco Default-Landklassen zugeordnet werden. 

Tipp 
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• Park (P): Umfasst Pärke sowohl in bewirtschafteten sowie unbewirtschafteten Flächen 
(Hinweis: Bewaldete Flächen lassen sich am besten der Landnutzung ‘Wald’ zuordnen). 

• Wohnhäuser (R) [residential]: Freistehende Gebäude mit 1 – 4 Wohneinheiten. 

• Transport (T): Umfasst Strassen mit begrenztem Zugang und die dazugehörigen 
Grünflächen (z. B. Autobahnen mit Auf- und Abfahrten, manchmal umzäunt) sowie 
Bahnhöfe, Gleise und Güterbahnhöfe, Schiffswerften, Flughäfen usw. (Hinweis: Wenn 
eine Stichprobe auf eine andere Art von Strasse oder einem dazugehörigen Mittelstreifen 
fällt, müssen diese entsprechend der nächstgelegenen Landnutzung klassifiziert werden.) 

• Versorgungsanlage (U) [utility]: Umfasst Stromanlagen, 
Abwasseraufbereitungsanlagen, verdeckte und nicht abgedeckte Reservoirs, leere 
Rückhaltebereiche für Regenwasser, Hochwasserschutzkanäle und Leitungen. 

• Vakant/unbestimmt (V): Beinhaltet Land ohne eindeutigen Verwendungszweck 
(Hinweis: Verlassene und leerstehende Gebäude sollten nach ihrem ursprünglich 
vorgesehenen Verwendungszweck klassifiziert werden).  

▪ Gewässer (W) [water/wetland]: Bäche, Flüsse, Seen und andere Gewässer, natürlich 
oder verbaut. (Hinweis: Kleine Schwimmbäder und Springbrunnen sollten anhand der 
angrenzenden Landnutzung klassifiziert werden.) 

▪ Andere/Other (O): Landnutzung, die nicht in eine der aufgeführten Klassen fällt. 
(Hinweis: Diese Bezeichnung sollte sparsam verwendet werden, da sie nur wenige 
nützliche Informationen für das Modell enthält.) Erklären Sie mehr dazu in Ihren 
Bemerkungen. 

 
(Beachte: Bei Gebäuden mit gemischter Nutzung, wird die Landnutzung der vorherrschenden 

Nutzungsklasse zugeteilt, dh. der Nutzung, die den Grossteil des Fussverkehrs ausmacht. 

Möglicherweise nimmt dieser nicht immer den Grossteil des Platzes im Gebäude in Anspruch. 

Zum Beispiel ein Gebäude, welches in der ersten Etage kommerziell genutzt wird und ebenfalls 

Wohnungen in den oberen Etagen besitzt, würde als kommerziell / industriell (C) eingestuft 

werden.) 

 

Wie dokumentieren 

• Aktuelle Landnutzung 

o Papier: Eingabe unter Actual Land Use auf der zweiten Seite. 

o ‘Mobile Data Collector’ : Klicken Sie im Fenster Land Uses auf das Pluszeichen 

(+) in der oberen rechten Ecke und wählen Sie eine der Landnutzungsklasse aus 

dem Dropdown-Menü aus. Geben Sie den Flächenanteil (%) wie unten beschrieben 

ein. 

o Flächenanteil der Stichprobe (%): Bei Stichproben, die nur eine 

Landnutzungsklasse aufweisen, beträgt dieser Wert 100%. Schätzen Sie bei 

Stichproben mit zwei oder mehr Landnutzungen ab, wieviel Prozent der 

Stichproben von jeder Landnutzungsklasse beansprucht werden. Eine Stichprobe 

die zum Beispiel zwischen einem bewohnten Haus und einem Gewerbe liegt, 

könnte zu 40% Wohnhäusern (R) und zu 60% Gewerbe- und Industriegebäuden (I) 

zugeordnet werden. Landnutzungsunterschiede müssen auf der Stichprobe in 

Bezug zur menschlichen Nutzung des Bodens eindeutig zugeordnet werden und 

nicht nur in Bezug auf seine Deckung oder Eigentumsverhältnise. 

▪ Papier: Eingabe des Prozentanteils pro Landnutzungsklasse unter Percent 

of plot. 
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▪ ‘Mobile Data Collector’: Klicken Sie im Fenster Landnutzung auf das 

Pluszeichen (+) oben rechts und wählen Sie eine Landnutzungsklasse aus 

der Dropdown-Liste aus. Geben Sie den Prozentanteil in Percent of Plot 

ein. Klicken Sie auf Save, um fortzufahren. Fügen Sie weitere 

Landnutzungen hinzu bis das Total 100 % ist. Klicken Sie dann im 

Hauptfenster für Land Uses auf den linken Pfeil, um zum Hauptmenü für 

diese Stichprobe zurückzukehren. 

 
 

 

Beschreibung: 

Innerhalb der Stichprobenfläche werden verschiedene Bodenbedeckungsklassen vorkommen. Eco 

bietet 11 vorgegeben Bodenbedeckungsklassen (Default) an, aus denen die Nutzer wählen 

können. Alternativ können auch nutzerdefinierte Bodenbedeckungsklassen innerhalb der i-Tree 

Eco-Software erstellt werden. Benutzerdefinierte Bodenbedeckungsklassen müssen einer der 

Standardklassen zugeordnet werden. Grasflächen mit/ohne Unterhalt und Kräuter werden in nur in 

US-Amerikanischen Projekten in die Modellierung der Luftschadstofffilterung miteinbezogen. Die 

Ergebnisse in Bezug zur Luftverschmutzung werden entsprechend beeinflusst, wenn neue 

Flächen diesen Bodenbedeckungsklassen zugeordnet werden.  

 

Die folgenden Daten sind erforderlich, um die Bodenbedeckung zu beschreiben: 

• Bodenbedeckung [ground cover] – Art der Bodenbedeckung so, wie im Feld beobachtet. 

• Flächenanteil der Stichprobe (%) [percent of plot] – der Anteil der gesamten 

Stichprobe, welcher von jeder Bodenbedeckungsklasse beansprucht wird. 

 

Die folgenden Default-Bodenbedeckungsklassen stehen zur Verfügung: 

▪ Offener Boden (Soil): Beinhaltet auch natürlich vorkommenden Sand {Im Umfeld von 

Seen oder dem Meer}. 

▪ Gebäude (Bldg): Beinhaltet auch Gebäude mit einem grünen Dach. 

 Bodenbedeckung [ground cover] 

 

 

Bäume und Sträucher werden getrennt von den hier beschriebenen Bodenbe-

deckungsklassen betrachtet. Weitere Informationen zu diesen Bodenbedeckungs-

klassen finden Sie unter Beschirmung [tree cover] und Deckungsgrad 

Strauchvegetation [shrub cover]. Stämme als Bodenbedeckung {liegende 

Stämme, z.B. Totholz) werden in dieser Messgrösse ignoriert. 

Tipp 
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▪ Zement (Cement) 

▪ Teer (Tar): Schwarzbelag/Asphalt 

▪ Gestein (Rock): Durchlässige Gesteinsoberflächen wie Kies, Ziegelsteine/Pflastersteine, 

oder Terassen oder Steinplatten (ohne Mörtel) sowie Sand auf Spielplätzen oder als Belag 

auf vorhandenem Boden. (Hinweis: Grosse, solide Felsformationen sollten als Anderes, 

versiegelt [other impervious] eingestuft werden.) 

▪ Rohhumus (Duff / Mulch): loses organisches Material, Laubstreu 

▪ Gras {mit Unterhalt} (Main. Grass) 

 

▪ Gras ohne Unterhalt (Unmain. Grass) 

 

▪ Kräuter / Efeu (Herb / Ivy): Krautige Bodenvegetation, ausser Gras, einschliesslich 

landwirtschaftlicher Kulturpflanzen. 

▪ Anderes, versiegelt (Other impervious): Undurchlässige Oberflächen, ausser 

Gebäuden, Zement und Teer, einschliesslich grosser Felsformationen, Schwimmbecken, 

Kanaldeckel, Versorgungskästen, Grabsteine, Kunstrasen usw. (Hinweis: Künstlicher 

Rasen sollte als Gestein (Rock) eingestuft werden, wenn das zugrundeliegende Material 

durchlässig ist.) 

 

Der prozentuale Anteil der Gebäudedeckung wird bei der Modellierung von 

Wildtierbeständen und Energie verwendet. Benutzer, die an diesen Analysen 

interessiert sind, sollten entweder die Klasse Gebäude (Bldg) beibehalten oder 

eine benutzerdefinierte Klasse hinzufügen, die der Defaultklasse Gebäude (Bldg) 

zugeordnet ist. 

Tipp 

 

Gras mit/ohne Unterhalt und Kräuter werden nur in US-Projekten in die 

Modellierung der Luftschadstofffilterung miteinbezogen. Die Ergebnisse in Bezug 

zur Luftverschmutzung werden entsprechend beeinflusst, wenn neue Flächen 

diesen Bodenbedeckungsklassen zugeordnet werden. 

Tipp 

 

 

Der Flächenanteil von Gras mit Unterhalt wird bei der Wildtier-Modellierung 

verwendet. Benutzer, die an dieser Analyse interessiert sind, sollten entweder die 

Klasse Gras mit Unterhalt [main. grass] verwenden oder eine benutzerdefinierte 

Klasse hinzufügen, die der Standardklasse Gras mit Unterhalt [main. grass] 

zugeordnet ist. 

 

Tipp 
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▪ Wasser (Water): Natürliche Gewässer und Flüsse, ausgenommen temporär anstehendes 

Wasser. 

 
Wie dokumentieren 

Schätzen Sie den Flächenanteil jeder Bodendeckungsklasse auf die nächsten 5% genau, ausser 

die Bodenbedeckung ist zu klein. Bei Kleinstmengen können Sie einfach 1, 2, 3% usw. eingeben. 

Die Summe der Anteile muss 100% pro Stichprobe ergeben. Verwenden Sie die folgende Tabelle 

als Hilfe, wenn Sie die Bodenbedeckung in 1 und 5% Intervallen schätzen. (Einige 

Vergleichsbeispiele: Eine Queen-Size-Matratze umfasst 3,25 m2; ein Geländewagen in voller 

Grösse deckt 8,36 m2 ab). 

 

 Prozentanteil  

0.04 ha / Stichprobe 
        Fläche (m2) Durchmesser des Kreises (m) 

    1%              4.09                     2.29 

    5%            20.25                     5.03 

  10%            40.60                     7.19 

  25%          101.34                   11.37 

  50%          202.81                   16.06 

  75%          304.16                   19.69 

100%          405.52                   22.71 

 

• Papier: Eingabe der Flächenanteile (%) pro Bodenbedeckungsklasse unter der 

entsprechenden Kategorie (siehe obenstehende Angaben in Klammern). 

• ‘Mobile Data Collector’ : Klicken Sie im Fenster Ground Covers auf das Pluszeichen (+) 

in der oberen rechten Ecke und wählen Sie im Dropdown-Menü eine 

Bodenbedeckungsklasse aus. Geben Sie den Flächenanteil (%) in das Feld Percent 

Covered ein und klicken Sie auf Save, um fortzufahren. Fügen Sie weitere 

Bodenbedeckungsklassen hinzu, bis das Total von 100% erreicht ist. Klicken Sie dann im 

Hauptfenster des Ground Covers auf den linken Pfeil, um zum Hauptmenü für diese 

Stichprobe zurückzukehren. 
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Beschreibung: 

Für den Zweck dieses Inventars sollten Sträucher der gleichen Art und ähnlicher Höhe zu Gruppen 

[masses] zusammengefasst werden. Wenn in einer Stichprobe beispielsweise fünf Exemplare 

einer Azalee ähnlicher Höhe in verschiedenen Bereichen vorkommen, können Sie diese zu einer 

Gruppe zusammenfassen und als eine einzelne Gruppe eingeben. Eine holzige Pflanze mit BHD 

<2.54 cm gilt als Strauch. Für jede Strauchgruppe sind folgende Daten erforderlich: 

• Art [species] - Name der Strauchart 

• Höhe [Height] - Durchschnittliche Höhe einer Strauchgruppe (d.h. einer Menge an 

Sträucher der gleichen Art) 

• Flächeanteil in % [Percent of area] – Prozentanteil Strauchfläche, der pro Stichprobe 

durch die jeweilige Strauchgruppe abgedeckt wird 

• Fehlender Volumenanteil in % [Percent missing] - Prozentanteil des fehlenden 

Strauchgruppenvolumens (d.h. nicht mit Blättern besetzt) 

 

Wie dokumentieren 

Geben Sie maximal 12 Strauchgruppen an. Wenn mehr als 12 Gruppen vorhanden sind, geben 

Sie die ersten 11 an und fassen die verbleibenden Sträucher in einer zwölften Gruppe zusammen. 

o Papier: Eingabe der Daten pro Strauchgruppe in die vier dafür vorgesehenen 

Felder unterhalb der Überschrift Shrubs. 

o ‘Mobile Data Collector’: Klicken Sie im Fenster Shrubs auf das Pluszeichen (+), 

um eine neue Strauchgruppe hinzuzufügen, und füllen Sie die vier unteren Felder 

aus. 

• Art [species]: Identifizieren Sie die Straucharten. Ist dies nicht möglich, sollte die Pflanze 

mindestens durch ihre Gattung identifiziert werden. Wenn die Gattung nicht bekannt ist, 

nehmen Sie eine Probe zur Identifizierung. 

o Papier: Eingabe von Artnamen oder Artcode unter Shrubs > Species ein. 

Besuchen Sie die i-Tree-Website unter www.itreetools.org> Resources, um ein 

PDF und die Excel-Tabelle der Artcodeliste zu erhalten. 

o ‘Mobile Data Collector’: Wählen Sie eine Art aus dem Dropdown-Menü aus. Klicken 

 Details zu Sträuchern [shrub details] 

 

Für Stichprobeninventuren [sample inventories] können Sie während der 

Datenerhebung unter Stichprobeninformationen den Flächenanteil (%) der 

Stichprobe eingeben, der vonSträuchern bedeckt ist. Dieser Abschnitt bezieht sich 

nur auf diese Fläche. Wenn Sie Strauchdaten erheben, müssen Sie auch den 

Deckungsgrad der Strauchvegetation abschätzen. Weitere Informationen finden Sie 

unter Deckungsgrad der Strauchvegetation in diesem Handbuch. 

Achtung 

 
! 
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Sie auf die Schaltfläche Next am unteren Rand jeder Seite, um weitere Arten 

anzuzeigen. Sie können mit dem Button oben rechts zwischen wissenschaftlichem 

Namen, Volksnamen [common name] und Artcode wechseln. Sie können auch 

suchen, indem Sie den Namen/Code in das Suchfeld eingeben. 

• Höhe [height]: Messen Sie die Höhe der Strauchgruppe auf die nächsten 0.10 m genau. 

Die Höhen der Strauchgruppen einer bestimmten Art werden sich in der Stichprobe 

wahrscheinlich unterscheiden. Es kann eine durchschnittliche Höhe verwendet werden und 

verschiedene Strauchmassen können dann zusammen gruppiert werden, sofern die 

Unterschiede inerhalb der Gruppen relativ gering sind. 

o Papier: Geben Sie die Höhe unter Shrubs > Height ein. 

o ‘Mobile Data Collector’: Geben Sie die Höhe im Fenster Shrubs unter Height ein. 

• Flächenanteil in % [percent of area]: Messen Sie den prozentualen Anteil der gesamten 

Strauchfläche (d.h. nicht die gesamte Stichprobenfläche), die durch die Kombination von 

Art/Höhe beschieben wird. Die Summe aller in der Stichprobe erhobenen Strauchgruppen 

muss 100% betragen. Befinden sich in einer zusammenhängenden Strauchgruppe 

mehrere Arten unterschiedlicher Höhe, wird nur die höchste Art als Gruppe erhoben, aber 

nur die Fläche der niedrigeren Arten sofern sie nicht durch höhere Sträucher beschattet 

(überdeckt) werden – dh. betrachten Sie die Stichprobe aus der Vogelperspektive und 

geben Sie den Flächenanteil der Sträucher an, die sie von oben sehen. 

o Papier: Eingabe unter Shrubs > % of shrub area. 

o ‘Mobile Data Collector’: Eingabe im Fenster Shrubs unter Percent of Shrub Area 

ein. 

• Fehlender Volumenanteil in % [Percent missing]: Visualisieren Sie die Strauchmasse 

dieser Arten- / Höhengruppe als Volumen (Höhe ab Bodenoberfläche) und geben Sie den 

Prozentsatz des fehlenden Volumens an, d.h. den Anteil des Strauchvolumens, welcher 

nicht mit Blättern besetzt ist. Es wird angenommen, dass die Blätter der Strauchmasse am 

Boden beginnen. Die Intention dieser Messgrösse ist, dass damit Höhen- und 

Flächenmessungen angepasst werden können, um das tatsächliche Volumen der Blätter 

zu ermitteln, und Lücken in der Vegetation sowie Ungenauigkeiten bei einfachen Höhe-zu-

Flächenmessungen zu berücksichtigen (z. B. ist die Höhe der Masse möglicherweise nicht 

einheitlich). 

Berücksichtig die natürliche Anordnung oder Lücken der Blätter; Sie sollten jedoch das 

Innere der Strauchmasse anschauen, um die fehlenden Teile besser abschätzen zu 

können. In der Vergangenheit haben die Teams die fehlende Strauchmasse unterschätzt, 

da sie den Innenraum nicht berücksichtigt haben. 

 

Geben Sie die Fehlenden Volumenanteile der Strauchvegetation in 5%-Intervallen an, indem Sie 

die Mittelpunkte (3, 8, 13, 18, usw.) benutzen oder 0%, 100%. 

 

o Papier: Eingabe unter Shrubs > % Missing. 

o ‘Mobile Data Collector’: Eingabe im Fenster Shrubs unter Percent missing. 

Klicken Sie auf Save, um diese Strauchgruppe zu speichern, und klicken Sie auf 

das Pluszeichen (+), um weitere Strauchgruppen hinzuzufügen, bis das Total = 

100% ist. Wenn Sie fertig sind, klicken Sie auf den linken Pfeil im Hauptfenster 

Shrubs, um zum Hauptmenü für diese Stichprobe zurückzukehren. 
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Je nachdem in welcher Entwicklungsstufe sich ein Baum befindet, kann er im Eco-Modell als 

Bodenbedeckung [ground cover], Strauch oder Baum klassifiziert werden. Die folgenden 

Informationen aus dem Zeitschriftenartikel «A Ground-Based Method of Assessing Urban Forest 

Structure and Ecosystem Services» (verfügbar unter www.itreetools.org unter Resources > 

Archives) wurden angepasst und können Eco-Benutzern dabei helfen, zwischen den verfügbaren 

Optionen zu unterscheiden. 

 

Normalerweise werden Sträucher als Gehölzpflanzen mit einem Brusthöhendurchmesser (BHD) ≤ 

2,54 cm definiert, während Bäume einen BHD ≥ 2,54 cm haben. Gehölzpflanz mit einer Höhe ≤ 

30,5 cm (z. B. Jungpflanzen), werden der Krautschicht zugeordnet. 

 

 

Die Unterscheidung in Baum- oder Straucharten kann auch aufgrund der Artzuordnung erfolgen 

(d.h. bestimmte Arten sind immer Bäume oder Sträucher) oder über einen Mindestwert für den 

BHD definiert werden. In bewaldeten Gebieten kann z.B. ein minimaler BHD ≥ 12cm die Feldarbeit 

verringern, indem die Anzahl der gemessenen Bäume verringert wird. Sie erhalten somit jedoch 

weniger Informationen über die Bäume und ihre Leistungen. 

Baumdatenerhebung bei Stichprobeninventuren [plot-based sample]  

Die Dateneingabe für lebende und tote Bäume verläuft im Uhrzeigersinn und beginnt mit dem 

nördlichsten Baum. Befinden sich, vom Stichprobenmittelpunkt aus gesehen, zwei Bäume in 

derselben Richtung, wird der Baum gemessen, der am nächsten steht. Wenn der 

Stichprobenmittelpunkt unzugänglich ist und Sie einen Baummesspunkt (TMP) festgelegt haben 

(weitere Informationen finden Sie unter Unzugängliche Stichprobenmittelpunkte), verwenden 

Sie den TMP, um Entfernung und Richtung zu bestimmen. Denken Sie jedoch daran, dass die 

Stichprobe selbst nicht verschoben wird. Der TMP ist nicht der Mittelpunkt der Stichprobe. Messen 

Sie nur die Bäume, welche sich innerhalb der wahren Stichprobengrenze befinden, gemessen 

vom wahren Stichprobenmittelpunkt. Es werden alle Bäume erfasst, von denen sich mindestens 

die Hälfte des Stammes in der Stichprobenfläche befindet. 

Baumformationen 

 Was ist ein Baum? [What is a tree?] 

 

 

Für ein i-Tree Eco-Projekt werden Bäume als Gehölzpflanzen mit einem BHD ≥ 2,54 

cm definiert. Für inventarbezogene Zwecke wird vorgeschlagen, dass alle als Baum 

taxierten Gehölzarten unabhängig ihres BHD’s als ‘Baum’ erhoben und erfasst 

werden. 

Tipp 
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Beschreibung: 

ID Nummer des Baumes. Für Vollinventuren [complete inventory], muss die ID ein eindeutiger 

Identifikator sein. Für Stichprobeninventuren [plot-based sample] muss der Identifikator 

innerhalb der Stichprobe eindeutig sein. 

 

Wie dokumentieren 

• Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe der Nummer 

unter TREE ID. Beginnen Sie mit 1 und und fahren der Reihe nach fort. 

• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): Klicken 

Sie im Fenster Trees auf das Pluszeichen (+) in der oberen rechten Ecke. Eine Baum-ID 

wird automatisch generiert, und Sie haben jetzt Zugriff auf bis zu sechs weiteren Fenstern, 

je nach Ihrer Projektkonfiguration: Allgemein [General], Details [Details], Stämme [Stems], 

[Building Interactions], Management Info [Management Info] und Schädorganismen 

[pests]. Erklärungen hierzu siehe nachfolgend. 

 

 

Beschreibung: Einmalige Baum-ID für Stichproben- und Vollinventuren [for complete 

inventory and plot-based sample] 

 

• Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe der Nummer 

unter USER ID.  

• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): 

Klicken Sie im Fenster Trees auf das Pluszeichen (+) in der oberen rechten Ecke. 

Eingabe im Fenster ‘General Info’ unter User Id 

 

 

 

 Baum ID [tree ID] 

 Nutzer ID [user ID] 

 

Das Markieren (z.B. mit Kreide) jedes Baums während der Messung hilft dabei, 

den Überblick über die Bäume zu behalten und zu verhindern, dass ein Baum 

verloren geht oder zweimal erfasst wird. Hinterlassen Sie keine bleibenden 

Spuren (Farb- oder Anritzmarken) auf Bäumen. 

Tipp 
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Beschreibung: (Hinweis: Diese optionale Messgrösse wird nur bei Stichprobeninventuren [plot-

based sample] erhoben.) 

Richtung vom Stichprobenmittelpunkt zum Baum in Kompassgraden / Azimut (z. B. Nord = 360 °; 

Ost = 90 °; Süd = 180 °; West = 270 °). 

 

Wie dokumentieren: 

Falls der Stichprobenmittelpunkt unzugänglich ist, messen Sie die Richtung vom Baummesspunkt 

(TMP) aus. Stellen Sie sicher, dass die Informationen zum TMP eingegeben sind – entweder im 

Papierformular oder im ‘Mobile Data Collector’ jeweils bei den Referenzobjekten [reference 

objects]. 

• Papier (bei Stichprobeninventuren): Eingabe des Azimuts (in Grad °) unter DIR. 

• ‘Mobile Data Collector’ (bei Stichprobeninventuren): Eingabe des Azimuts (in Grad °) im Fenster 

General unter Direction.  

 

 

Beschreibung (Hinweis: Diese optionale Messgrösse wird nur bei Stichprobeninventuren [plot-

based sample] erhoben.) 

Kürzeste Entfernung (in m) vom Stichprobenmittelpunkt bis zum Rand des Baumstammes, 

gemessen auf Höhe des BHD’s und parallel zum Boden. In bewaldeten Stichprobenflächen ist es 

wichtig, genau zu arbeiten, damit Sie die Bäume in Zukunft wiederfinden. 

 

Wie dokumentieren: 

Falls der Stichprobenmittelpunkt unzugänglich ist, messen Sie die Distanz vom Baummesspunkt 

(TMP) aus. Stellen Sie sicher, dass die Informationen zum TMP eingegeben sind – entweder im 

Papierformular oder im ‘Mobile Data Collector’ jeweils bei den Referenzobjekten [reference 

objects]. 

• Papier (bei Stichprobeninventuren): Eingabe Distanz (in m) unter DIST. 

• ‘Mobile Data Collector’ (bei Stichprobeninventuren): Eingabe Distanz (in m) im Fenster General 

unter Distance. 

  

 Richtung zum Stichprobenmittelpunkt [direction to plot center] 

 Distanz zum Stichprobenmittelpunkt [distance to plot center]  
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Beschreibung: 

Landnutzungsklasse, in der sich der Baum befindet. Eco stellt Ihnen 13 Klassen der Landnutzung 

zur Auswahl. Alternativ können Nutzer eigene Landnutzungsklassen in der i-Tree Softwares 

definieren. Nutzerdefinierte Landnutzungsklassen müssen später aber einer der vorgegeben 

Default-Klassen zugeordnet werden. 

Die vorgegebenen Default-Klassen sind unter Informationen zur Stichprobenfläche definiert. 

 

Wie dokumentieren 

Geben Sie die Landnutzung an, in der sich der Baum befindet. 

• Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe unter LAND 

USE mit den oben definierten Landnutzungscodes. 

• ‘Mobile Data Collector’ (Stichprobeninventur [for sample]): Wählen Sie im Fenster General 

die Landnutzung aus der Dropdown-Liste aus. Es werden nur Landnutzungen 

berücksichtigt, die Sie für die jeweilige Stichprobe festgelegt haben. 

• ‘Mobile Data Collector’ (Vollinventuren [for complete]): Wählen Sie im Fenster General die 

Landnutzung aus der Dropdown-Liste aus. 

 

 

Beschreibung: (Hinweis: Diese Messgrösse ist für alle Projekte erforderlich.) 

Gattung und Baumart. Lesen Sie unter Identifizieren von Baumarten die empfohlenen Leitlinien 

für die jeweiligen Szenarien. 

 

Wie dokumentieren 

• Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe der Baumart 

unter TREE SPECIES. Wenn Sie Artcodes verwenden möchten, finden Sie auf der i-Tree-

Website www.itreetools.org unter Resources ein PDF und eine Excel-Tabelle mit der 

Artcodeliste. 

• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): 

Wählen Sie im Fenster General die Art aus der Liste aus. Klicken Sie unten auf der Seite 

 Landnutzung [land use] 

 Arten [species] 

 

 

Bei Stichprobeninventuren [plot-based sample] können Sie whrend der 

Datenerhebung zu den Stichprobeninformationen [plot information] die 

Landnutzungzusammensetzung pro Stichprobe eingeben. Wenn Sie die 

Landnutzung bei Bäumen erheben, müssen Sie Landnutzung auch für die Stichprobe 

erheben. Weitere Informationen zur Landnutzung finden Sie unter 

Stichprobeninformationen [plot information]. 

Achtung 

 
! 
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auf Next, um die Artenliste zu durchlaufen. Sie können mit dem Button oben rechts 

zwischen wissenschaftlichem Namen, Volksnamen und Artcode wechseln. Sie können 

auch Namen suchen, indem Sie diese in das Suchfeld eingeben. 

 

Identifizieren von Baumarten 

Empfohlene Leitlinien für Szenarien, die Sie im Feld antreffen können: 

 

• Arten können nicht identifiziert werden: Wenn eine Art nicht identifiziert werden kann, 

nehmen Sie eine Probe. Nummerieren Sie diese und machen dazu den folgenden Vermerk 

in Ihrem Notizbuch; Stichprobe #XXX unbekannt #1 usw. Jedes Mal, wenn derselbe 

unbekannte Baum in der Stichprobe vorkommt, sollte er mit der gleichen Nummer erfasst 

werden.  

Nummerieren Sie die unbekannten Bäume der Reihe nach in Ihrem Notizbuch und 

versuchen Sie später, diese zu identifizieren. Nachdem die Proben im Büro identifiziert 

wurden, geben Sie die korrekten Artcodes auf Papier oder im ‘Mobile Data Collector’ ein. 

Kann nach Überprüfung aller verfügbarer Referenzen eine einzelne Art noch immer nicht 

identifiziert werden (z. B. aufgrund von Hybridisierung), wird falls möglich nur die Gattung 

angegeben. 

• Tote Bäume: Es werden nur stehende und schrägstehende tote Bäume ins Inventar 

aufgenommen. Die Gattung oder Art sollte nach Möglichkeit identifiziert werden. 

 

Ist die Identifizierung der Art schwierig, wie dies bei Totholz der Fall sein kann, kann eine der 

folgenden taxonomischen Klassen verwendet werden: Magnoliopsida, Pinopsida, Ginkgoopsida, 

Liliopsida, Filicopsida oder Cycadopsida. Bei der Artidentifizierung von lebenden Bäumen sind 

diese Klassen sparsam zu verwenden. Diese Klassen können für eine eher übergeorndete 

Klassifizierung benutzt werden, wie ihre Volksnamen vermuten lassen. Allerdings umfassen diese 

Klassen nicht notwendigerweise alle allgemeingültigen Klassifizierungen, die durch diese 

Volksnamen umschrieben werden. 

 

Wissenschaftlicher 

Name 

Artcodes Volksname 

Cycadopsida CYCLASS Palmfarne [Palm class] 

Filicopsida FICLASS Echte Farne [Farn class] 

Ginkgoopsida GICLASS Ginkgoähnliche [Ginkgo class] 

Liliopsida LICLASS Einkeimblättrige Bedecktsamer [Lily class] 

Magnoliopsida MACLASS Zweikeimblättrige Bedecktsamer [Dicodyledon] 

Pinopsida PICLASS Nacktsamer [Conifer] 
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Beschreibung: 

Geben Sie an, ob es sich um einen Strassenbaum handelt oder nicht. 

 

Wie dokumentieren 

• Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe von Yes (Y) 

oder No (N) unter STREET TREE/NON-ST S/N). 

• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): 

Betätigen Sie im Fenster General unter Street Tree den Button, um Ja (Yes) oder Nein 

(No) anzugeben. 

 

 

Beschreibung: 

Geben Sie an, ob der Baum von der Stadt unterhalten wird (d.h öffentlich ist) oder nicht (d.h. 

privat). 

 

Wie dokumentieren 

• Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe von Yes (Y) 

oder No (N) unter PUBLIC or PRIV. 

• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): 

Aktivieren Sie im Fenster General die Schaltfläche, um unter Public Tree Ja (Yes) oder 

Nein (No) anzugeben. 

  

 Strassenbaum / kein Strassenbaum [Street Tree/Non-Street Tree] 

 Öffentlich/Privat [Public/Private] 

 

 

Taxonomische Klassen (dh. Magnoliopsida, Pinopsida, Ginkgoopsida, Liliopsida, 

Filicopsida, Cycadopsida) sollten bei der der Artidentifizierung von lebenden Bäumen 

sparsam eingesetzt werden. Diese Klassen können zur Darstellung der 

allgemeineren Klassifikationen verwendet werden. Die Artidentifizierung ist jedoch 

für die Berechnung von Ökosystemleistungen wichtig – die artenspezifische 

Identifizierung liefert bessere Modellschätzungen. 

Achtung 

 
! 
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Beschreibungen: 

Status des Baumes, entstanden durch Pflanzung oder Naturverjüngung.  

Nachfolgend sind die acht Statusmöglichkeiten eines Baums aufgeführt. In der ersten 

Bestandsaufnahme des Untersuchungsgebiets werden alle Bäume durch Pflanzung (P) [Planted], 

Naturverjüngung (I) [Ingrowth] oder Unbekannt (U) [Unknown] identifiziert. Bei Folgeerhebungen 

auf demselben Standort werden nur noch neu dazugekommene Bäume als P, I oder U identifiziert, 

bereits früher erfasste Bäume sollen mit den anderen fünf Status-Codes identifiziert werden. 

 

Die Informationen zur Verjüngungsart (Pflanzung / Naturverjüngung) sind für zukünftige Berichte 

und Verbesserungen des Eco-Modells sehr wertvoll. Obwohl es möglichst vermieden werden soll, 

können Sie Unknown (U) auswählen, wenn Sie die Verjüngungsart nicht eindeutig feststellen 

können. 
 

▪ Pflanzung (P) [Planted]: Der Baum wurde gepflanzt. 

▪ Naturverjüngung (I) [Ingrowth]: Der Baum hat sich selbst ausgesät. 

▪ Unbekannt (U) [Unknown]: Pflanzung oder Naturverjüngung kann nicht bestimmt 

werden. 

 

Verwenden Sie bei Folgeerhebungen auf demselben Standort nachfolgende Codes, um den 

aktuellen Status von Bäumen zu definieren, die bereits bei der Erstaufnahme vorhanden waren. 

 

▪ Keine Statusänderung (N) [No change in status]: Dieser Baum war bereits in einer 

früheren Inventur und ist auch heute noch vorhanden. 

▪ Entfernt aus Sicherheits- / Gesundheitsproblemen (H) [removed for 

hazard/health problem]: Der Baum wurde seit der vorherigen Inventur aus 

Gesundheits- oder Sicherheitsgründen entfernt. 

▪ Entfernt, aber gesund (C) [Removed but healthy]: Ein gesunder Baum wurde vom 

Eigentümer entfernt. 

▪ Entfernt wegen Landnutzungsänderung (L) [Removed owing to land use 

change]: Der Baum wurde aufgrund von Landnutzungsänderungen (z. B. 

Bauvorhaben) entfernt. 

▪ Entfernt, unbekannt (R) [Removed, unknown]: Baum wurde aus unbekannten 

Gründen entfernt. 

 

(Hinweis: Im Modell werden keine Berechnungen erstellt für Bäume, die entfernt wurden; für Status 

von H, C, L oder R.) 

 

Wie dokumentieren 

• Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe vom 

Statuscode unter STAT.  

• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): 

Wählen Sie im Fenster General den Status aus der Drop-Down Liste aus. 

 

 Status [status] 
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Beschreibung: 

Zeigt an, dass der Baum tot ist.  

 

Wie dokumentieren 

• Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe vordefinierter 

Standardwerte wie nachfolgend: 

o Gesamtbaumhöhe [total tree height]: Aktuelle Messung (in m) durchführen! Eingabe 

unter TOT TREE HEIGHT. 

o Höhe der lebenden Kronenspitze [Height to live top / live crown heigth]: Eingabe 

von -1 unter LIVE CROWN HEIGHT. 

o Höhe Kronenansatz [Height to crown base]: Eingabe von -1 unter CROWN BASE 

HEIGHT. 

o Kronenbreite [crown width]: Eingabe von -1 unter CROWN WIDTH sowohl bei N-S 

als auch bei E-W. 

o Kronenverlust (%) [Percent crown missing]: Eingabe von 100% unter CROWN % 

MISS. 

o Wipfeldürre [percent dieback]: Eingabe von 100% unter CROWN COND 

o Lichtexpositition der Krone [Crown light exposure]: Eingabe von -1 unter CLE ein. 

o BHD [DBH]: Aktuelle Messung durchführen! Eingabe unter DBH. 

• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): 

Aktivieren Sie im Fenster Details das Kontrollkästchen neben Dead. Wenn Sie dieses 

Kontrollkästchen aktivieren, werden alle Standardoptionen für tote Bäume automatisch 

ausgefüllt. 

 

  

 Tot [dead] 

 

Nur stehende oder schrägstehende tote Bäume sind ins Inventar aufzunehmen. 

Gattungen oder Arten sollten nach Möglichkeit identifiziert werden. Wenn dies 

nicht möglich ist, geben Sie eine der folgenden taxonomischen Klassen an: 

Magnoliopsida, Pinopsida, Ginkgoopsida, Liliopsida, Filicopsida oder 

Cycadopsida. 

 

Im ‘Mobile Data Collector’ werden automatisch Default-Wertes für tote Bäume 

eingegeben, wo es passt. Bei Einträgen ohne Default-Werte (z.B. 

Gesamtbaumhöhe [total tree height] und BHD [DBH]) müssen eigene 

Messungen durchgeführt werden. 

Tipp 
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Beschreibung: 

Höhe ab Boden [from planting grade] bis zur Baumspitze (lebend oder tot). 

 

Wie dokumentieren 

Messen Sie die Höhe bis zur oberen Baumspitze (auf die nächsten 0.1 m gerundet). Für stehende 

oder umgefallene lebende Bäume sowie stark geneigte Bäume wird die Entfernung entlang dem 

Hauptstamm vom Boden bis zur Baumspitze betrachtet. (Schliessen Sie kein liegendes Totholz 

ein.) 

• Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe der 

Gesamtbaumhöhe unter TOT TREE HEIGHT ein. 

• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): 

Eingabe der Gesamtbaumhöhe im Fenster Details unter Height ein. 

 
 

Höhe der lebenden Kronenspitze [Height to Live Top {live crown height}] 

 

Beschreibung: 

Höhe ab Boden [from planting grade] bis zum Ende der lebenden Kronenspitze. Diese Höhe 

entspricht der Gesamtbaumhöhe; es sei denn der Baum lebt, aber die Kronenspitze ist tot!  

 

Wie dokumentieren 

Messen Sie die Höhe bis zum Ende der lebenden Kronenspitze und geben Sie sie bis auf den 

nächsten Meter genau an. 

• Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe unter LIVE 

CROWN HEIGHT. 

• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): 

Eingabe im Fenster Details unter Crown Top Height ein. 

  

 Gesamtbaumhöhe [total tree height] 

 Kroneausdehnung [crown size] 

 

 

Die Höhe bis zum Ende der lebenden Kronenspitze darf nicht grösser sein als die 

Gesamtbaumhöhe. 

Achtung 

 
! 
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Höhe Kronenansatz [height to crown base] 

 

Beschreibung: 

Höhe ab Boden bis zum lebenden Kronenansatz. Der lebende Kronenansatz ist der Punkt auf dem 

Hauptstamm, der senkrecht zum untersten lebenden Blatt des letzten Astes liegt. Beachten Sie, 

dass der lebende Kronenansatz durch das grüne Laub bestimmt wird und nicht durch den Punkt, 

an dem sich ein Zweig mit dem Hauptstamm schneidet. Wenn also der Kronenansatz den Boden 

berührt, ist Null ein akzeptabler Wert. In Abb. 2 finden Sie Tipps zur Erhebung der 

Baumkronenparameter. 

 
Abb. 2 – Wie Sie sich positionieren müssen beim Messen der Krone. 
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Wie dokumentieren 

Messen Sie die Höhe vom Kronenansatz (auf die nächsten 0.1 m gerundet). Wenn Sie Ihre Daten 

auf Papier eingeben, geben Sie bei toten Bäumen eine -1 ein. Im ‘Mobile Data Collector’ wird der 

Default-Wert von -1 automatisch eingefüllt, wenn das Kontrollkästchen "Dead" aktiviert wurde. 

 

• Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe unter 

CROWN BASE HEIGHT. 

• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): 

Eingabe im Fenster Details unter Crown Base Height. 

 

Kronenbreite [crown width] 

 

Beschreibung:  

Die Kronenbreite in zwei Richtungen gemessen: Nord-Süd (N-S) und Ost-West (E-W). 

 

Wie dokumentieren 

Messen Sie die Kronenbreite (auf die nächsten 0.1 m gerundet) in zwei Richtungen, möglichst so 

nah an der N-S und E-W Ausdehnung, wie es Sicherheitsüberlegungen oder physische 

Hindernisse erlauben. Wenn der Baum liegt oder geneigt ist, nehmen Sie die Breitenmessungen 

senkrecht zum Baumstamm vor. Wenn Sie Ihre Daten auf Papier eingeben, tragen Sie bei toten 

Bäumen eine -1 ein. Im ‘Mobile Data Collector’ wird der Default-Wert von -1 automatisch eingefüllt, 

wenn das Kontrollkästchen "Dead" aktiviert wurde. 

 

• Papier (Stichproben- und Vollinventuren [for sample and complete]): unter CROWN WIDTH 

jeweils für N-S und E-W. 

• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): 

Eingabe im Fenster Details unter Crown NS Width und Crown EW Width ein. 

 

Kronenverlust % [percent crown missing] 

 

Beschreibung: 

Prozentualer Anteil des Kronenvolumens, der nicht von Ästen und Blättern besetzt ist. 

 

Wie dokumentieren 

Das fehlende Kronenvolumen sollte von zwei Personen gemessen werden, die im rechten Winkel 

zueinander stehen (Abb. 2). Visualisieren Sie den erwarteten „typischen Kronenumriss“ der 

spezifischen Baumart, der durch Breite, Gesamthöhe und Höhe bis zum lebenden Kronenansatz 

erzeugt wird. Visualisieren Sie diesen artspezifischen Kronenumriss und füllen ihn mit Blättern, als 

wäre es ein gesunder Baum in ausgezeichnetem Zustand. Schätzen Sie nun den prozentualen 

Anteil der Blattmasse ab, welcher aufgrund von Baumpflegemassnahmen, Nadel- oder 

Blattverlusten, Wipfeldürre, ungleichmässige Krone oder Blattanomalien [dwarf or sparse leaves] 

fehlt. Schliessen Sie normale inneren Kronenlücken aufgrund von Beschattungseffekten aus. 

Stellen Sie sicher, dass sie den Kronenverlust anhand der existierenden Kronen bestimmen, die 

Sie gemessen haben (z.B anhand Gesamtbaumhöhe, Kronenbreite und Kronenansatz). (Abb. 3) 
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Wenn zwei Beobachter in ihren Einschätzungen nicht einverstanden sind, befolgen Sie die 

nachstehende Leitlinie zur Erhebung der Kronenparameter. Geben Sie den Kronenverlust in 

5%-Intervallen an, indem Sie die Mittelpunkte (3, 8, 13, 18, usw.) benutzen oder 0%, 100%. 

 

Wenn Sie Ihre Daten auf Papier eingeben, geben Sie bei den toten Bäumen 100% an. Im ‘Mobile 

Data Collector’ wird der Default-Wert von 100% automatisch eingefüllt, wenn das Kontrollkästchen 

Dead aktiviert wurde. 

• Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe unter 

CROWN %MISS ein. 

• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): 

Eingabe im Fenster Details unter Crown Percent Missing. 

 
Abb. 3 – Illustration, wie Sie die Höhe des Kronenansatzes und des Kronenverlustes (%) bestimmen. 
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Vorgängige Hinweise zur Kronenbeurteilung 
 
Um eine bestmögliche Genauigkeit zu gewährleisten, sollte das Team bei der Beurteilung unter 
bestimmten Bedingungen besonders vorsichtig sein und das folgende Vorgehen befolgen. 
 
Entfernung vom Baum: Stellen Sie sich zur Beurteilung mindestens ½ - 1 Baumlänge entfernt vom zu 
beurteilenden Baum hin. Einige Schätzungen ändern sich mit dem Abstand zum Baum. In manchen 
Situationen wird dies zwar unmöglich sein, aber tun Sie Ihr Bestes. Alle Beurteilungen werden auf der 
gleichen Höhe wie der Baumstandort oder aber hangaufwärts des Baumes vorgenommen. Auch das ist 
wahrscheinlich nicht in allen Fällen möglich, aber beurteilen Sie die Bäume niemals von der 
Hangunterseite aus! 
 
Blick auf die Krone: Um die beste Sicht auf die Krone zu erhalten, sollten zwei Teammitglieder in 
einem rechten Winkel (90°) zueinander stehen (Abb. 3). Die Teammitglieder sollten den Baum nicht 
von derselben Position aus oder direkt gegenüberliegend voneinander (180°) bewerten, es sei denn, es 
gibt keine andere Option. In stark überdachten Bereichen ist es schwierig, eine gute Perspektive der 
Krone zu erhalten. Überlappende Äste, Bäume im Hintergrund und das Fehlen eines guten 
Sichtbereichs können Probleme bei der Beurteilung einiger Bäume verursachen. Das Team sollte sich 
seitwärts bewegen, um nach einer guten Perspektive zu suchen. Seien Sie besonders aufmerksam, 
wenn Sie solche Bäume bewerten. 
 
Wetterbedingungen [Climatic conditions]: Durchzogener oder bewölkter Himmel, Nebel, Regen und 
ein ungünstiger Sonneneinfallswinkel können die Beurteilung beeinflussen.  
Messgrössen zur Kronenausdehung können davon betroffen werden, jedoch in einem geringeren Mass 
als andere Kronenindikatoren. Die Wipfeldürre [crown dieback] wird möglicherweise unterschätzt, da es 
schwierig ist, tote Zweige zu sehen oder entlaubte Zweige von toten Zweigen zu unterscheiden. Seien 
Sie besonders aufmerksam bei schlechten Lichtverhältnissen. Bewegen Sie sich um einen Baum 
herum, um eine andere Perspektive einzunehmen, auch wenn die Perspektive an einem bestimmten 
Ort angemessen erscheint. 
 
Starke Entlaubung [Heavy defoliation]: Bei starker Entlaubung kann die Wipfeldürre [crown dieback] 
überschätzt werden. Verwenden Sie Ferngläsern, um abgestorbene Zweige von entlaubten Zweigen zu 
unterscheiden. 
 
Bäume mit Kletterpflanzen in der Krone [Trees with vines in crown]: Kletterpflanzen in der 
Baumkrone werden nicht als zusätzliche Blattfläche bei der Beurteilung von Kronenverlust [percent 
crown missing] und Wipfeldürre [crown dieback] einbezogen. Zählen Sie die Kletterpflanzen nicht zur 
Krone. 
 
Bäume mit Reiterationstriebe [Trees with epicormic twigs and sprouts]: Bäume mit 
Reiterationstrieben (z.B. Klebäste, Geiztriebe u.ä.), gelten nicht als Sonderfälle bei der 
Felddatenerhebung. Es gibt zwei Methoden, um mit dieser Situation umzugehen:  

Bei der ersten Methode werden die Reiterationstriebe nicht als Teil des lebenden Kronenansatzes 
[crown base] betrachtet (sofern diese sich unterhalb des eigentlichen Kronenansatz befinden). Der 
Blattanteil der Reiterationstriebe wird aber dem Kronenvolumen angerechntet, indem er vom 
Kronenverlust [percent canopy missing] subtrahiert wird, wodurch sich dieser verringert. 

Beispiel: Die Reiterationstriebe eines Baumes befinden sich 1,22 m vom Boden entfernt, der lebende 
Kronenansatz liegt bei 2,44 m. Das Team schätzt den Kronenverlust auf 15%, die zusätzlichen 
Klebäste, Geiztriebe u.ä. auf 1,22 m machen ungefähr 5% der Krone aus. Der Kronenverlust [percent 
canopy missing] würde dann auf 10% geschätzt werden. Alle Prozentangaben würden sich auf die 
Kronenmessungen (Kronenbreite, Gesamtbaumhöhe und Kronenansatz) beziehen. 
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Vorgängige Hinweise zur Kronenbeurteilung - Fortsetzung 

Bei der zweiten Methode wird der lebende Kronenansatz [crown base] auf Höhe des 
niedrigstgelegenen Reiterationstriebes festgelegt. Diese Höhe dient dann als Basis für die 
Abschätzung des Kronenverlustes [percent canopy missing]. Bei dieser Methode erhöht sich demnach 
der Anteil des Kronenverlustes [percent canopy missing]. 
Beide dieser Methoden können in Eco verwendet werden. Versuchen Sie jedoch, im Feld beständig zu 
bleiben. Verwenden Sie möglichst immer die gleiche Methode bei der Beurteilung von Bäumen mit 
Reiterationstrieben. 
Falls die Baumkrone nur aus Reiterationstriebe besteht oder wenn diese sich oberhalb des 
Kronenansatzes befinden, werden sie als Teil der Baumkrone betrachten und auch als solche 
gemessen. 
 
Der Umgang mit unterschiedlichen Messungen: Wenn die zwei Teammitglieder bei den Kronen-
messungen zu unterschiedlichen Ergebnissen kommen, ermitteln Sie den Endwert indem Sie…: 

• denn Durchschnitt bilden, solange die Zahlen um 15% (2 Klassen) oder weniger von einander 
abweichen. 

• die Positionen ändern, wenn die Zahlen um 15% oder mehr von einander abweichen. Versuchen 
Sie, den Bereich auf 10% oder weniger einzuengen. 

• für Bäume, die eine unterschiedlichen Bewertungen je nach Position aufweisen: Bilden Sie den 
Mittelwert der beiden Schätzungen (Bewertungen von 30% und 70% würden als 50% angegeben 
werden) 

 

 

Beschreibung: 

Die Kronengesundheit [crown health] beruht auf einer visuellen Beurteilung der Menge an 

Totästen in der Baumkrone und wird als Wipfeldürre [dieback] oder Kronenzustand [condition] 

angegeben.  

• Um die Wipfeldürre [dieback] anzugeben, geben Sie den Prozentsatz der Krone an, der 

aus toten Ästen besteht. 

{Da die standardmässign Erhebunge des Kronenzustandes [condition] viele verschiedene 

Parameter beinhaltet, welche mit i-Tree nicht betrachtet werden, wird bei der Schweizer Erhebung 

nur die Wipfeldürre [dieback] betrachtet.} 

 

Eco verfügt über 22 voreingestellte Klassen zur Abschätzung der Wipfeldürre [dieback] aus denen 

der Nutzer auswählen kann. Weitere Informationen finden Sie unter Schätzung Wipfeldürre (%) 

(siehe untenstehende Box). 

 

 

 Kronengesundheit [crown health] 

 

 

Benutzern, die ein neues Projekt erstellen, wird dringend empfohlen, mit den 

Standardklassen von Eco (Default) für die Kronengesundheit zu arbeiten. Durch die 

Arbeit mit den Standardklassen wird die Datenerfassung im Feld präzisiert und die 

Berichterstellung standardisiert. 

Tip 
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Alternativ können Benutzer in der i-Tree Eco-Software benutzerdefinierte Klassen für die 

Kronengesundheit erstellen, diese müssen aber analoge Klassen bei der Wipfeldürre [dieback] 

aufweisen. Erstellen Sie diese Klassen bevor Sie ins Feld gehen. 

 

Wie dokumentieren 

Wenn Sie mit den Standardklassen von Eco arbeiten, geben Sie die Prozenanteile in 5%-

Intervallen an, indem Sie die Mittelpunkte (3, 8, 13, 18, usw.) benutzen oder 0%, 100%. 

Wenn Sie Ihre Daten auf Papier eingeben, geben Sie bei toten die Wipfeldürre [dieback] mit 100% 

an. Wenn Sie mit dem ‘Mobile Data Collector’ arbeiten, wird der Default-Wert von 100% bei der 

Wipfeldürre [dieback] automatisch eingefüllt, wenn das Kontrollkästchen „Dead“ aktiviert wurde. 

 

Wenn Sie mit benutzerdefinierten Klassen arbeiten, beurteilen Sie die Kronengesundheit anhand 

der Klassen, die Sie in der i-Tree Eco-Software erfasst haben.  

• Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe unter 

CROWN HEALTH. 

• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): 

Wählen Sie im Fenster Details, einen Wert unter dieback aus dem Drop-Down Menu aus. 

 

Schätzung Wipfeldürre (%) [Estimating percent dieback] 

 

Der prozentuale Anteil der Wipfeldürre [Percent dieback] schliesst normales, natürliches Absterben der 

Äste aus, z.B. eine Astreinigung durch eigene Kronenkonkurrenz oder eigene Beschattung des unteren 

Kronenbereiches. Dagegen wird die Wipfeldürre [branch dieback] infolge Beschattung durch Gebäude 

oder andere Bäume einbezogen. Weitere Informationen finden Sie im Forest Inventory and Analysis 

National Core Field Guide. 

 

Stellen Sie sich den Umfang der Krone als eine zweidimensionale Figur vor, welche von Astspitze zu 

Astspitze reicht, nicht einbezogen werden dabei Aststummel (abgebrochene Äste) und grosse Löcher 

oder Lücken in der Krone (Abb.4). Die Wipfeldürre [Percent dieback] wird von zwei Personen (Abb. 2) 

mit einem Fernglas erfasst. Dabei sollten Sie sich der Lichtverhältnisse und des Tageslichts bewusst 

sein und sich bei schlechten Sichtverhältnissen mehr Zeit für Ihre Messung nehmen. 

 

Jedes Teammitglied stellt sich visuell eine zweidimensionale Kronenlinie um den Baum vor und teilt 

diese Figur dann in Quadrate auf, um damit die Wipfeldürre abzuschätzen. Wenn die beiden 

Teammitglieder in ihren Einschätzungen nicht übereinstimme, befolgen Sie die oben aufgeführten 

Vorgängigen Hinweise zur Kronenbeurteilung. 

 

 

http://www.fia.fs.fed.us/library/field-guides-methods-proc/index.php
http://www.fia.fs.fed.us/library/field-guides-methods-proc/index.php
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. 
 

 

Beschreibung: 

Anzahl der Seiten der Baumkrone, die Licht von oben oder von der Seite empfangen (maximal 

fünf). 

 

Wie dokumentieren: 

Die Spitze des Baumes wird als eine Seite gezählt. Die vier anderen Seiten werden durch 
vertikales Unterteilen der Krone in vier Quadranten um den Schaft herum festgelegt. Zählen Sie 
die Anzahl der Seiten (0-5), welche Licht erhalten (d.h. Licht wird nicht durch Objekte in der Nähe 
zurückgehalten (Abb. 5). 
 
Für jede der 5 zu messenden Baumseiten gilt, sobald ein Teil einer benachbarten Baumkrone oder 
eines Gebäudes…  
a) höher ist als ein Teil der zu beurteilenden Baumseite 
b) eine durchschnittliche Kronenbreite vom Baum entfernt ist (gemessen vom Baumstamm) und 

das Objekt mindestens so hoch ist wie der zu messene Baum… 
…dass die betroffene Seite, nicht ausreichend Licht erhält. 
 

Verwenden Sie die folgenden Codes: 

• Toter Baum: nicht eingegeben 

 Lichtexposition der Krone [crown light exposure] 

Abb. 4 - Beispiele für die Beurteilung der Wipfledürre [dieback]. 
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• 0: Der Baum empfängt kein direktes Licht, da er von Bäumen, Reben oder anderen 

Vegetationen / Objekten beschattet wird. 

• 1: Der Baum empfängt direktes Licht von 1 von 5 Seiten. 

• 2: Der Baum empfängt direktes Licht von 2 von 5 Seiten 

• 3: Der Baum empfängt direktes Licht von 3 von 5 Seiten 

• 4: Der Baum empfängt direktes Licht von 4 von 5 Seiten. 

• 5: Der Baum empfängt direktes Licht von allen 5 Seiten (offener Baum) 

 

Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe unter CLE. 

‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): Eingabe im 

Fenster Details unter Crown Light Exposure.  

 

 

Beschreibung: (Hinweis: Diese Messgrösse ist für alle Projekte erforderlich.) 

Brusthöhendurchmesser (BHD), der auf 1.3 m über dem Boden gemessen wird. 

 

 

Wie dokumentieren 

Messen Sie den BHD bergseitig des Baumes (auf 0.01 cm genau). Beachten Sie für Bäume mit 

Sonderfällen die Leitlinien für BHD-Messungen unter BHD-Sonderfälle. 

• Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe unter DBH1 

bei normalen Bedingungen. Bei mehrstämmigen Bäume Eingabe unter DBH2 - DBH6, 

siehe unter BDH-Sonderfälle. 

BHD [DBH] 

Abb. 5. Schematische Darstellung der 5 Seiten (4 Seiten und Oben). 

 

 

Einige Baumleistungen [benefits], wie die Kohlenstoffspeicherung werden mithilfe vom 

BHD geschätzt. Für diese Berechnungen wird der gemessene BHD bis ≤ 2.54 cm 

oder weniger verwendet. Bei allen Bäumen mit einem BHD ≥ 2.54 cm, basieren die 

Berechnungen der Baumleistungen [benefits] auf dem max. BHD von 2.54 cm. 

Tip 
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• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): Auf 

die BHD-Eingabefelder können Sie unter dem Fenster Stems zugreifen. Klicken Sie auf 

das Pluszeichen (+) in der oberen rechten Ecke, um mit der Eingabe zu beginnen. Die 

Stamm-ID wird automatisch generiert. Geben Sie unter Diameter einen Wert für den BHD 

ein. 

 

BHD-Sonderfälle 

 

Mehrstämmige Bäume: Sobald der Punkt der Marktrennung über dem Boden liegt (Abb. 6), wird 

die Pflanze als ein einziger Baum betrachtet. Der BHD wird bei bis zu sechs Stämmen separat 

gemessen. Wenn der Baum mehr als sechs Stämme mit BHD ≥ 2,54 cm hat, senken Sie die 

Messhöhe auf 30,4 cm über dem Boden und geben Sie die Durchmesser der sechs stärksten 

Stämme an (wählen Sie die grössten aus und ignorieren Sie alle anderen).  

Falls der Punkt der Marktrennung unter dem Boden liegt, wird jeder Stamm als separater Baum 

betrachtet (reicht der sichtbare Leist (Rindengrat) bis zur Bodenoberfläche [included bark down to 

planting grade] ist das ein guter Indikator dafür, dass die Marktrennung unter dem Boden liegt).  

 

 
Abb. 6 - BHD-Messung bei mehrstämmigen Bäumen. 

 

Wurzelsprosse: Alle Wurzelsprosse mit BHD ≥ 2.54 cm sollten als separate Bäume gemessen 
werden. Wurzelsprossen mit BHD <2.54 cm können ignoriert werden. 
 
Baum mit Flaschenhals [butt-swell or bottleneck]: Falls der Flaschenhals [butt-swell or 

bottleneck] >91.4 cm über dem Boden liegt, messen Sie den BHD dieser Bäume 45.7 cm über 

dem Ende des Flaschenhalses [butt-swell or bottleneck] (Abb. 7). 

 

Baum mit Unregelmässigkeiten auf Höhe BHD: Bei Bäumen mit Wülsten, Kröpfen, Überwal-

lungen, Dellen oder Ästen auf BHD-Höhe wird der Durchmesser unmittelbar über der Unregel-

mässigkeit an der Stelle gemessen, an der die normale Stammform wieder einsetzt. (Abb. 7)  
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BHD Sonderfälle- Fortsetzung 
 

Abb. 7—BHD-Messungen bei Bäumen mit Unregelmässigkeiten {Angabe zum Distanzen in Fuss/inch}. 

 

Baum am Hang: Messen Sie den Durchmesser 1.3 m über dem Boden entlang des Baumstamms 

bergseitig des Baumes. 

 

Schrägstehender Baum: Messen Sie den Durchmesser in 1.3 m über dem Boden und zwar von 

der Stammunterseite aus gemessen.  

 

Umgestürzter Baum (lebend): Messen Sie den Durchmesser an der Stammoberseite in 1.3 m ab 

Stammansatz/ Wurzelanlauf [trunk flare / root collar]. 

 
 

BHD-Messhöhe [DBH measurement height] 

 

Beschreibung: 

Höhe der BHD-Messung, wenn sie nicht 1.3 m über dem Boden durchgeführt werden konnte. 

 

Wie dokumentieren 

Falls der BHD nicht bei 1.3m gemessen werden konnte, geben Sie die Höhe an, bei der der BHD 

gemessen wurde. 

• Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe unter HT 

DBH. 

• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): Im 

Fenster Stems wird automatisch ein Wert von 1.3 m generiert. Korrigieren Sie dies, 

falls nötig. 
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BHD gemessen [DBH measured] 

 

Beschreibung: 

Wann immer möglich, sollte der BHD direkt gemessen werden. Er kann jedoch, falls nötig visuell 

abgeschätzt werden. 

Wie dokumentieren 

Geben Sie an, ob der BHD direkt gemessen wurde oder nicht. 

• Papier (Stichproben- und Vollinventuren [for sample and complete]): N/A 

• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): Wenn 

direkte Messungen vorgenommen wurden, aktivieren Sie im Fenster Stems das 

Kontrollkästchen neben Measured. Wenn alle Informationen für einen bestimmten Stamm 

eingegeben wurden, klicken Sie auf Save, um fortzufahren. Wenn alle Stämme 

eingegeben wurden, klicken Sie auf der Hauptseite (Stems) auf den Linkspfeil, um zum 

Hauptmenü dieses Baums zurückzukehren. 

 

 

 

Flächenanteil Versiegelung in % [percent impervious] 

 

Beschreibung: (Hinweis: Diese optionale Messgrösse wird nur für Projekte mit Stichproben-

design [plot-based sample projects] erfasst.) 

Der prozentuale Flächenanteil an versiegelter Fläche unterhalb der Kronentraufe 

 

Wie dokumentieren 

Wenn die Baumkrone die Stichprobengrenze überschreitet, wird der gesamte Bereich unter dem 

Baum weiterhin berücksichtigt. Geben Sie den Flächenanteil Versiegelung in 5%-Intervallen an, 

indem Sie die Mittelpunkte (3, 8, 13, 18, usw.) benutzen oder 0%, 100%. 

• Papier (Stichprobeninventur [for sample]): Eingabe unter UNDER CANOPY > % IMPER. 

• ‘Mobile Data Collector’ (Stichprobeninventur [for sample]): Auswahl im Fenster Details aus 

dem Dropdown-Menü für Percent Impervious. 

 

Flächenanteil Sträucher in % [percent shrubs] 

 

Beschreibung: (Hinweis: Diese optionale Messgrösse wird nur für Projekte mit 

Stichprobendesign [plot-based sample projects] erfasst.)  

Der prozentuale Flächenanteil unterhalb der Kronentraufe, welcher mit Sträuchern bedeckt ist. 

 

Wie dokumentieren 

Wenn die Baumkrone die Stichprobengrenze überschreitet, wird der gesamte Bereich unter dem 

Baum weiterhin berücksichtigt. Geben Sie den Flächenanteil Strauchdeckung in 5%-Intervallen an, 

indem Sie die Mittelpunkte (3, 8, 13, 18, usw.) benutzen oder 0%, 100%.  

 Deckungsgrad Unterwuchs [cover under canopy] 
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• Papier (Stichprobeninventur [for sample]): Eingabe unter UNDER CANOPY > % SHRUB 

ein. 

• ‘Mobile Data Collector’ (Stichprobeninventur [for sample]): Auswahl im Fenster Details aus 

dem Dropdown-Menü für Percent Shrub aus. 

 
 

 

Falls Sie sich dazu entschieden haben, Informationen in Bezug zu den Energieeffekten zu 

erheben, sind zwei Felder (z.B. Richtung und Entfernung) erforderlich. Die energiebezogenen 

Wechselwirkungen zwischen Baum / Gebäude werden für Bäume (≥ 6.1 m hoch) erfasst, die sich 

innerhalb von 18.3 m von beheizbaren oder klimatisierten Wohngebäuden befinden und die ≥ 3 

Stockwerke umfassen (z. B. zwei Stockwerke und ein Dachgeschoss). Behandeln Sie bei 

Mehrfamilienhäusern alle Gebäudeteile als ein einzelnes Gebäude. Für Projekte mit 

Stichprobendesign [plot-based sample projects] muss das Gebäude selbst nicht auf der 

Stichprobenfläche liegen. Bis zu drei Gebäuden können erfasst werden, entweder mit dem 

Papierformular oder mit dem ‘Mobile Data Collector’. Stehende tote Bäume, die die oben 

genannten Bedingungen erfüllen, sollten ebenfalls erfasst werden. 

 

Richtung zum Gebäude 

 

Beschreibung: 

Richtung vom Baum zum nächstgelegenen Teil des Gebäudes, für solche Bäume, die die oben 

genannten Bedingungen erfüllen. 

 

Wie dokumentieren 

Geben Sie die Richtung (Azimut in Grad) vom Baum zum nächstengelegen Gebäudeteil an. 

• Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe der Richtung 

von bis zu drei nächstgelegenen Gebäuden unter TREES NEAR BUILDINGS > BLDG 

DIST 1/BLDG DIST 2/BLDG DIST 3. 

• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): Auf 

gebäudebezogene Eingabefelder kann im Fenster Building Interactions zugegriffen 

werden. Klicken Sie oben rechts auf das Pluszeichen (+), um das erste Gebäude 

hinzuzufügen. Geben Sie unter Direction einen Wert ein. 

 

Distanzen zum Gebäude 

 

Beschreibung: 

Kürzeste Entfernung vom Baum zum nächstgelegenen Gebäudeteil, für solche Bäume, die die 

oben genannten Bedingungen erfüllen. 

 

Wie dokumentieren 

Messen Sie die kürzeste Entfernung vom Baum zum nächstgelegenen Teil des Gebäudes (auf die 

nächsten 0.1 m gerundet). 

 Energie 
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• Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe der 

Entfernung von bis zu drei nächstgelegenen Gebäuden unter TREES NEAR BUILDINGS > 

BLDG DIR 1/BLDG DIR 2/BLDG DIR 3. 

• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): 
Eingabe im Fenster Building Interactions unter Distance und klicken Sie auf Save, um 
fortzufahren. Klicken Sie oben rechts auf das Pluszeichen (+), um ein weiteres Gebäude 
hinzuzufügen. Wenn alle Gebäude eingegeben wurden, klicken Sie auf der Hauptseite für 
Building Interactions auf den Linkspfeil, um zum Hauptmenü des Baumes 
zurückzukehren. 

 

 

Beschreibung: 

Längen- und Breitengrad eines Baumstandortes. 

 

Wie dokumentieren 

• Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe unter TREE 

GPS > LAT COORD Y und LONG COORD X. 

• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): 

Eingabe unter Trees > Map Coordinates. Es gibt drei Optionen zur Erfassung der 

Koordinaten. Entweder Sie geben Koordinaten direkt ein, oder Sie verwenden ein GPS-

Gerät oder Sie tippen auf einen Ort auf der Karte.  

 
 
  

 GPS Koordinaten 



 

 77 

  

 

Beschreibung: 

Notwendigkeit routinemässiger oder sofortiger Baumpflegemassnahmen. Eco bietet 6 

Standardklassen zur Auswahl. Alternativ können Benutzer innerhalb der i-Tree Eco-Software 

benutzerdefinierte Klassen erstellen, die für ihre Projektziele relevanter sind. Diese 

benutzerdefinierten Klassen sollten erstellt werden, bevor Sie ins Feld gehen. 

 

Die folgenden Baumpflegeempfehlungen stehen als Standardoptionen zur Verfügung: 

• keine 

• Kleiner Baum (Routine) 

• Kleiner Baum (sofort) 

• Grosser Baum (Routine) 

• grosser Baum (sofort) 

• Kritische Probleme/Anliegen (öffentliche Sicherheit) 

 

Wie dokumentieren 

• Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe unter 

MANAGEMENT FIELDS > MAINT RECOM ein. 

• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): Zugriff 

auf managementbezogene Felder im Fenster Management Info Auswahl im Dropdown-

Menü Maintenance Recommendation.  

 

 

Beschreibung: 

Notwendigkeit spezifischer prioritärer Baumpflegearbeiten. Eco bietet 7 Standardklassen zur 

Auswahl. Alternativ können Benutzer innerhalb der i-Tree Eco-Software benutzerdefinierte 

Klassen erstellen, die für ihre Projektziele relevanter sind. Diese benutzerdefinierten Klassen 

sollten erstellt werden, bevor Sie ins Feld gehen. 

Die folgenden Baumpflegearbeiten werden als Standardoptionen zur Verfügung gestellt: 

 

▪ Keine [None] 
▪ Erziehungsschnitt [Formative pruning] (um strukturelle Mängel bei jungen Bäumen 

zu korrigieren) 
▪ Kronenpflege [Crown cleaning] (selektiver Schnitt zum Entfernen eines oder mehrerer: 

toter, erkrankter, befallener, reibender, abgelöster und / oder gebrochener Äste) 

Managementinformationen  

[management information] 

 Baumpflegeempfehlungen [maintenance recommended] 

 Baumpflegearbeiten [maintenance task 
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▪ Lichtraumprofilschnitt [Crown raising] (Schnitt von Ästen, um unter der Krone einen 
vertikalen Abstand zu gewährleisten) 

▪ Kroneneinkürzung [Crown reduction] (Abnahme der Zweiglänge oder Pflanzenhöhe 
und / oder Ausbreitung, z.B. um Konflikte mit Freileitungen zu reduzieren) 

▪ Kronenreinigung [crown clearing] (Säuberungsfläche: bestimmte festgelegte Fläche, 
aus der Vegetation entfernt wird) 

▪ Entfernen [Remove] 
▪ Schadorganismen / Krankheiten behandeln [Treat pests / disease] 

 
 
Wie dokumentieren 

• Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe unter 

MANAGEMENT FIELDS > MAINT TASK. 

• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): Zugriff 

auf managementbezogene Felder im Fenster Management Info. Auswahl im Dropdown-

Menü Priority Task. 

 
 

 
Beschreibung: 
Ausmass des Konflikts zwischen dem Wurzelanlauf des Baumes / Wurzeln erster Ordnung und 
den umgebenden Wegeinfrastrukturen (Hartbelag / Bürgersteig) [hardscape/sidewalk]. Eco bietet 
3 Standardklassen zur Auswahl. Alternativ können Benutzer innerhalb der i-Tree Eco-Software 
benutzerdefinierte Klassen erstellen, die für ihre Projektziele relevanter sind. Diese 
benutzerdefinierten Klassen sollten erstellt werden, bevor Sie ins Feld gehen. 
 
Die durch den Konflikt verursachte Verschiebung von Wegeinfrastrukturen (Hartbelag / 
Bürgersteig) [hardscape/sidewalk] wird anhand der folgenden Default-Optionen gemessen: 

▪ 0 bis 1.90 cm  
▪ > 1.90 bis 3.81 cm 
▪ > 3.81 cm  

 
Wie dokumentieren 

• Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe unter 

MANAGEMENT FIELDS > SIDEWALK CONFL. 

• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): Zugriff 

auf managementbezogene Felder im Fenster Management Info. Auswahl im Dropdown-

Menü Sidewalk Conflict.  

 

 

 
Beschreibung: 
Mögliche oder vorhandene Konflikte zwischen Baumzweigen/Ästen und Freileitungen. Eco bietet 3 
Standardklassen zur Auswahl. Alternativ können Benutzer innerhalb der i-Tree Eco-Software 

 Konflikte mit Wegeinfrastrukturen [sidewalk conflict] 

 Konflikte mit Freileitungen [utility conflict] 
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benutzerdefinierte Klassen erstellen, die für ihre Projektziele relevanter sind Diese 
benutzerdefinierten Klassen sollten erstellt werden, bevor Sie in das Feld gehen.  
 

Die folgenden Konflikte mit Freileitungen werden als Standardoptionen zur Verfügung gestellt: 

• Keine Freileitungen [No lines] 

• Vorhanden ohne potentiellen Konflikt [Present and no potential conflict] 

• Vorhanden mit Konflikt [Present and conflicting] 
 
Wie dokumentieren 

• Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe unter 

MANAGEMENT FIELDS > UTILITY CONFL. 

• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): Zugriff 

auf managementbezogene Felder im Fenster Management Info. Auswahl im Dropdown-

Menü Utility Conflict. 

 

 
Beschreibung: 
Benutzer können bis zu drei zusätzliche benutzerdefinierte Felder erstellen, um die zu 
bewertenden Bäume noch detaillierter zu beschreiben. Kategorien, die benutzerdefinierten Feldern 
zugeordnet sind, werden vom Benutzer während der Projektkonfiguration definiert. 
 

Wie dokumentieren 

• Papier (Stichproben- und Vollinventuren [for sample and complete]): Eingabe unter 
Custom Fields > 1, 2, oder 3. 

• ‘Mobile Data Collector’ (Stichproben- und Vollinventuren [for sample and complete]): Zugriff 
auf managementbezogene Felder im Fenster Management Info. Auswahl im Dropdown-
Menü der benutzerdefinierten Felder, die Sie zuvor erstellt haben. 
 

 

{Das IPED-Tool ist in ‘i-Streets’ integriert und derzeit nur für US-Projekte verfügbar.} 

Im ‘Mobile Data Collector’ haben Sie Zugriff auf die Felder zu den Schadorganismen im Fenster 

Pests. Im ersten Fenster werden Sie gefragt, ob der Gesamtbaum, Blätter / Zweige, oder Äste / 

Stamm Anzeichen von Schädlingen oder Krankheiten aufweisen. Wenn Sie eine dieser drei 

Kategorien mit „Ja“ beantworten, wird ein zusätzliches Fenster angezeigt, in dem Sie aufgefordert 

werden, den Schaden weiter zu charakterisieren. Für jede Kategorie, in der Sie Anzeichen oder 

Symptome festgestellt haben, müssen Sie, falls bekannt, einen Primär-Schadorganismus 

(Primary Pest) auswählen (nur USA). Wenn Sie sich nicht sicher sind, wählen Sie Unknown 

(Internationale Benutzer) aus, da das Protokoll nicht als Diagnosewerkzeug gedacht ist, sondern 

als systematische Methode zur Beurteilung und Dokumentation von Anzeichen und Symptomen 

von Schädlingen und Krankheiten. Wenn keine Anzeichen oder Symptome eines Schädlings oder 

einer Krankheit festgestellt wurden, wählen Sie None. 

 

 Benutzerdefinierte Felder [custom fields] 

 Schadorganismen (IPED) [pests] 
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Bei Vollinventuren [complete inventories] fahren sie mit der Eingabe fort, bis alle Bäume im 

Untersuchungsgebiet erhoben wurden. Überprüfen Sie sorgfältig, ob alle erforderlichen Felder 

vollständig und alle Angaben angemessen sind. 

 

Bei Stichprobeninventuren [sample inventories] fahren sie mit der Eingabe fort, bis alle Bäume 

pro Stichprobe erhoben wurden. Es liegt in der Verantwortung jedes Teams, alle Variablen zu 

vervollständigen, bevor Sie die Stichprobe verlassen. Überprüfen Sie sorgfältig, ob alle 

erforderlichen Felder vollständig sind und alle Angaben angemessen sind. 

 

Im ‘Mobile Data Collector’ können Sie, nachdem Sie alle Bäume eingegeben haben, auf den 

Linkspfeil klicken, um zum Hauptmenü der Stichprobe zurückzukehren. Klicken Sie auf Mark 

Plot as Completed. Sie können mit der nächsten Stichprobe fortfahren 

 

 
 
 
  

Dateneingabe beenden 

 

Denken Sie daran, dass im ‘Mobile Data Collector’ Ihre Daten nicht automatisch an 

den Server gesendet werden - sie werden nur im Browser-Cache gespeichert. Um 

Ihre Daten auf dem Server zu speichern, MÜSSEN Sie diese, wie im Abschnitt Tipps 

zur Dateneingabe beschrieben, einreichen. Reichen sie möglichst früh und oft ein! 

Achtung 

 
! 
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Throughout this section of the manual, we will refer to certain components of the i-Tree Eco 

application. Here’s a guide to show you what the components of the Eco window look like. See the 

Glossary for more details! 

 

 

 

 

 

 

 

 

 

 

 

Phase IV: Working with Eco 

 Getting to Know Eco 

Tabs 

Select one of the tabs on the ribbon to 

display the buttons and functions available. 

Window display 

Use these buttons to 

           minimize; 

           restore down/maximize; or 

           close the window. 

File menu 

Create new, open, save, and manage your 

Eco projects here. 

Need help? 

Use the on-screen help text in this panel 

as guidance through the process of 

creating, editing, and viewing your Eco 

project and results. 

 
Use this button to 

           auto hide. 

What is the action panel? 

The action panel is this part of the window where 

you input and edit your project settings and data, 

as well as view reports. When you click on a 

button or function in the ribbon, the feature will 

be available here. 
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The Eco application is so versatile that rather than provide step-by-step directions we have chosen 

to explain what you can do in each tab and function and why that might be important to you. 

Review the information in this section to help you navigate through the application’s user interface. 

 

  

 Navigating the User Interface 

 

 

While working in Eco, use the on-screen help text in the panel on the left-

hand side of the window. This help text will provide step-by-step directions 

for using each button and function. 

Tip 

 

 

This is a complete list of tabs, functions, and buttons that are available for the 

Eco user interface. Depending on whether you are doing a plot-based sample 

inventory or a complete inventory, certain functions may not appear or may 

be “greyed out.” Do not worry about the “missing” functions – they are not 

available because they are not relevant to your specific project. 

Caution 

 
! 

 

 

i-Tree Eco provides example projects that you can look at to explore the 

application before working with your own project. Check out the Eco Guide to 

Exploring Example Projects for more details.  

Eco Guide 
 

http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_ExploringExampleProjects.pdf
http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_ExploringExampleProjects.pdf
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File Menu 

 

New Project 

Description: This menu option allows you to create a new Eco project. 

 

Open Project 

Description: This menu option allows you to open an existing Eco project. 

 

Open Example Project 

Description: This menu option allows you to open one of Eco’s example projects.  

 

Why It’s Important: i-Tree Eco provides example complete inventory and plot-based 

inventory projects that you can view to become more familiar with the Eco application. 

 

Save Project (Automatic). 

Description: This option is disabled, but included in the menu to indicate that your Eco 

project is automatically saved as edits are made. 

 

Save a Copy 

Description: This menu option allows you to save your open project under a new name.  

 

Why It’s Important: This feature is especially useful if you want to view the same project in 

different ways. For example, let’s say you decide to post-stratify your results. You can try 

stratifying your plots several different ways and save your Eco project each time you stratify 

using the Save a Copy feature. 

 

Pack Project 

Description: This menu option allows you to put all of your project materials into a single 

compressed folder that saves storage space and can be shared easily.  

 

Close Project 

Description: This menu option allows you to close your open project without closing the Eco 

application. 

 

Exit 

Description: This menu option allows you to close the Eco application. 
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Project Configuration 

 

On this tab, you can set up your new i-Tree Eco project, make changes, or view the settings that 

you provided for an existing project. 

 

Project Definition 

 

Project Definition 

Description: In this function, you can identify many of your most important project settings, 

including project name, series, and year, the location of your study area, and what data 

variables you will be collecting. 

 

Why It’s Important: You can’t run Eco without filling out the forms here. Plus, you’ve 

probably spent a lot of time planning and designing your project. All of the decisions that 

you have made to customize your project are used to inform the Eco model and must be 

entered here. 

 

Define Data Fields 

 

Land Use 

Description: In this function, you can view the actual land use classes in your study area. 

Eco provides 13 default land use classes that you can choose to work with or create your 

own list of custom land use classes. 

 

Why It’s Important: If you have decided to collect land use data, which is optional, this 

function is a good place to reference your default options or to customize the list to better 

suit your project. 

 

 

 

Ground Cover 

 

 

Remember the data collection decisions that you made in Phase III: 

Collecting Your Field Data? This is where that data is specified in the Eco 

application. 

Tip 

 

 

The actual land uses should not be confused with your project strata. If you 

are choosing to stratify by land use, those fields should be defined in the 

Project & Strata Area function. 

Caution 

 
! 
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Description: In this function, you can view the ground cover classes in your study area. Eco 

provides 11 default ground cover classes that you can choose to work with or create your 

own list of custom ground cover classes. 

 

Why It’s Important: If you have decided to collect ground cover data, which is optional, this 

function is a good place to reference your default options or to customize the list to better suit 

your project. Grass, unmaintained grass, and herbs factor in to pollution modeling for U.S. 

projects. Pollution results will be affected by how these ground covers are categorized in the 

field or if new fields are mapped to these ground cover designations. 

 

 

Condition 

Description: In this function, you can view Eco’s default condition classes or enter custom 

classes. There are 22 default condition classes that you can choose from when you identify 

condition during data collection out in the field. You can also choose to add or edit the list 

of condition classes using the tools in the Actions group of the ribbon. 

 

Why It’s Important: You don’t actually have to do anything in this function unless you want 

to edit your condition classes. Assessing condition is optional and this function is simply a 

good place to reference if you want a refresher of your default or user-defined options. The 

condition classes that are displayed here will be available in the mobile data collector if you 

collect your field data using a mobile device, as well as in the Data tab of the ribbon. 

 

Dieback 

Description: In this function, you can view Eco’s default dieback classes or enter custom 

classes. There are 22 default dieback classes that you can choose from when you identify 

dieback during data collection out in the field. You can also choose to add or edit the list of 

dieback classes using the tools in the Actions group of the ribbon. 

 

Why It’s Important: You don’t actually have to do anything in this function unless you want 

to edit your dieback classes. Assessing dieback is optional and this function is simply a 

good place to reference if you want a refresher of your default or user-defined options. The 

dieback classes that are displayed here will be available in the mobile data collector if you 

collect your field data using a mobile device, as well as in the Data tab of the ribbon. 

 

Maintenance 

 

• Maintenance Recommended 

Description: In this function, you can view broad types of recommended maintenance 

that can be specified during data collection in the field. There are six default 

maintenance recommendations (e.g., small tree routine), but we strongly encourage 

users to define maintenance recommendations that are relevant to their project goals. 

 

Why It’s Important: This data allows you to categorize the management needs of your 

trees. This is where you can view the default classes or customize the list to better suit 

your study area. The recommended maintenance options that are displayed here will 
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be available in the mobile data collector if you collect your field data using a mobile 

device, as well as in the Data tab of the ribbon. 

 

• Maintenance Task 

Description: In this function, you can view priority maintenance tasks that can be 

specified during data collection in the field. There are seven default maintenance tasks 

(e.g., staking), but we strongly encourage users to define maintenance tasks that are 

relevant to their project goals using the tools in the Actions group of the ribbon. 

 

Why It’s Important: This data allows you to categorize the management needs of your 

trees. This is where you can view the default classes or customize the list to better suit 

your study area. The maintenance task options that are displayed here will be available 

in the mobile data collector if you collect your field data using a mobile device, as well 

as in the Data tab of the ribbon. 

 

• Sidewalk Conflict 

Description: In this function, you can view possible sidewalk conflicts with nearby trees 

that can be recorded during data collection in the field. There are three default 

measurements of sidewalk displacement (e.g., > 3.81 cm), but we strongly encourage 

users to define sidewalk conflicts in a way that is relevant to their project goals using 

the tools in the Actions group of the ribbon. 

 

Why It’s Important: This data allows you to categorize the management needs of your 

trees. This is where you can view the default classes or customize the list to better suit 

your study area. The sidewalk conflict classes that are displayed here will be available 

in the mobile data collector if you collect your field data using a mobile device, as well 

as in the Data tab of the ribbon. 

 

• Utility Conflict 

Description: In this function, you can view possible conflicts between tree branches and 

overhead utility lines that can be recorded during data collection in the field. . There are 

three default utility conflicts (e.g., present and conflicting), but we strongly encourage 

users to define utility conflicts in a way that is relevant to their project goals using the 

tools in the Actions group of the ribbon. 

 

Why It’s Important: This data allows you to categorize the management needs of your 

trees. This is where you can view the default classes or customize the list to better suit 

your study area. The utility conflict classes that are displayed here will be available in 

the mobile data collector if you collect your field data using a mobile device, as well as 

in the Data tab of the ribbon. 

 

Custom Fields 

Description: In this function, you can define the categories associated with your custom 

fields using the tools in the Actions group of the ribbon. Your custom fields are defined in 

the Project Definition function and would be included in your data collection out in the 

field. 
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Why It’s Important: This is a great way to customize your Eco project! You may add up to 

three additional custom fields to describe your assessed trees in even more detail. The 

classes that you define here are available in the mobile data collector if you collect your 

field data using a mobile device, as well as in the Data tab of the ribbon. 

 

Define Plots 

 

Load from File 

Description: This function provides one of the methods for identifying your sample plots in 

Eco. Here you can load the three files that are necessary to identify your sample plots. 

 

Why It’s Important: If you have chosen to do a plot-based sample inventory, you will need 

to create a sample and pass that information to the application. More importantly, if you 

have created your sample using ArcGIS software, this function provides the means by 

which to load the files that you created in GIS. 

 

via Google Maps 

Description: This function provides one of the methods for identifying your sample plots in 

Eco. The Google Maps Plot Generator creates your plot sample directly in Eco! 

 

Why It’s Important: If you have chosen to do a plot-based sample inventory, you will need 

to create a sample and pass that information to the application. More importantly, if you 

have chosen to do a simple or stratified random sample, this tool provides an easy way to 

create your sample.  

 

User Defined 

Description: This function provides one of the methods for identifying your sample plots in 

Eco.  

 

Why It’s Important: If you have chosen to do a plot-based sample inventory, you will need 

to create a sample and pass that information to the application. This option allows you to 

define your plot sample manually by simply entering the plot size and number of plots that 

you would like to add to each strata. 

 

Project & Strata Area 

 

Project & Strata Area 

Description: In this function, you can add your project or strata area and view or edit the 

strata that you will be using for your project. Stratifying your study area allows you to 

subdivide the study area into smaller units, such as land use classes or political 

boundaries, so that you can compare urban forest effects between each stratum. 

 

Why It’s Important: The size entered in the “Area” column is used to calculate the per unit 

area, or density, estimates that are included in some of the Eco results on the Reports tab. 

The more accurate the area entered here, the better your density estimates will be. You 
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can use the tools in the Actions group to add or delete strata. This is also simply a good 

place to reference the strata for your project! If you are doing a plot-based sample project, 

the strata that you define here will be visible in the User Defined function. The strata that 

you define here are also available in the mobile data collector if you collect your field data 

using a mobile device, as well as in the Data tab of the ribbon. 

 

Export 

 

CSV 

Description: This function allows you to export tabular data from an open function to a 

“comma separated values” (csv) file format. 

 

Why It’s Important: Data exported as a csv file are compatible with Microsoft Excel and text 

editors such as WordPad and Notepad. This function allows you to save and organize your 

project data however you choose. 

 

Actions 

 

The Actions group is available in the ribbon bar when you are working in a function that requires 

the following tools: 

 

New 

Description: This tool allows you to add a new class or category of data to the table that is 

open in the action panel. 

 

Undo 

Description: This tool allows you to undo the last action that you took. 

 

Redo 

Description: This tool allows you to redo an action that you had just negated using the 

Undo tool. 

 

Restore Defaults 

Description: This tool will restore any default classes or categories of data to the table that 

is open in the action panel. 

 

Delete 

Description: This tool allows you to delete a selected class or category of data from the 

table that is open in the action panel. 

 

Editing Mode 

 

Editing Mode 

Description: This tool allows you to work in Editing mode so that you may edit or add to the 

project settings in the Project Configuration tab. 
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Why It’s Important: After you run the Eco model in the Reports tab, the Project 

Configuration tab will be locked so it cannot be edited unintentionally. However, the 

project settings that you enter in the Project Configuration tab may be edited with caution. 

In order to do this, you will need to switch to Editing mode by clicking on the Editing Mode 

function. If you choose to work in Editing mode, you will need to submit your data to the 

server again and retrieve your updated results. 

 

Data 

 

On this tab, you can add, edit, or view your inventory data (i.e., the plot and/or tree data that you 

collect in the field). 

 

Data Collection 

 

Paper Form 

Description: This function displays the paper data collection forms provided by Eco. 

 

Why It’s Important: If you have decided to collect and record your field data on paper forms, 

this is where you will find Eco’s ready-made forms so you can save and print them. 

 

Submit to Mobile 

Description: This function submits your project configuration settings to the mobile data 

collector. If you are not planning to record your data in the field using the mobile data 

collector, then you do not need to use this tool. 

 

Why It’s Important: Your project configuration is unique to your project. Submitting your 

project settings using this tool ensures that your mobile data collector has the correct 

classes or categories when you go into the field to collect your data. If you do not first 

submit your project configuration using this tool, you will not be able to access the mobile 

data collector. 

 

Retrieve from Mobile 

Description: This function imports your inventory data from the mobile data collector into 

Eco. If you did not record your data in the field using the mobile data collector, then you will 

not need to use this tool. 

 

Why It’s Important: If you recorded your data in the field using the mobile data collector, 

this is how you will import your data. This tool offers an easy way of bringing your inventory 

data into the application. 

 

From the Complete Inventory Importer 

If you have an existing tree inventory, you can import your data directly into your complete 

inventory project: 
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1 Click on the Data tab. 

 

2 Click on the Trees function. (Note: The Import tool will become available in the ribbon.) 

 

3 Click on the Import tool to import your existing tree inventory. 

 

4 In the Data Import Wizard, click Browse. 

 

a Navigate to the file containing your inventory data.  

 

b Select the file and click Open. 

 

5 Confirm that the data that appears in the table is correct and click Next. 

 

6 Match your existing data fields to Eco’s data fields. 

 

 

a Select an inventory column from the table. The column header will appear in the 

“Your Source Column” space towards the bottom of the window. 

 

b Choose the “Eco Field” from the drop-down list that defines the type of data in your 

selected column. 

 

c Check the box indicating whether or not you will need to map your field values to 

the Eco field values. (Note: You will be prompted to complete the value mapping 

later. See step 8.) 

 

d CONDITIONALLY REQUIRED: As previously described, Eco data variables can 

often be displayed in several ways. For example, species data can be entered as 

common name, scientific name, or species code. For data variables where this 

applies, a “Field Type” drop-down list will appear below “Eco Field.” Select the field 

type that matches your existing data. 

 

e Repeat steps 6a through 6d until each variable that you would like imported has 

been matched to the appropriate Eco field. 

 

7 Click Next. 

 

8 CONDITIONALLY REQUIRED: For data variables that you indicated the need to map field 

values (step 6c), match your field values to Eco’s. 

 

 

 

Try moving from left to right clicking on each column in turn. This can help 

ensure that you match all of the necessary columns to an Eco field. 

Tip 
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a In the upper table, select a row. 

 

b In the lower table, choose the “Eco Value” from the drop-down list that matches 

“Your Value.”  

 

c Move through the lower table until all of your values have been matched to an Eco 

value. 

 

d Repeat steps 8a through 8c until all necessary data variables have been mapped. 

 

9 Click Next. 

 

10 Review the results of your processed data at the top of the Data Import Wizard. This 

information will tell you how many records from your inventory data will be imported. 

 

11 When you are satisfied with the data that will be imported, click Finish. (Note: Use the 

Back button to return to previous steps to make adjustments.) 

 

 

 

 

 

Inventory Data 

 

Plots 

Description: Field data collected for each plot are entered in this function. You can also edit 

the plot data using the tools in the Actions group of the ribbon once it has been entered or 

imported here. 

 

Why It’s Important: If you are doing a plot-based sample project, this is where you can 

manually enter or edit your plot data. If you have already entered or imported your data, 

this function can simply be a place for viewing that data. 

 

Trees 

Description: Field data collected for each tree are entered in this function. You can also edit 

the tree data using the tools in the Actions group of the ribbon once it has been entered or 

imported here. 

 

Why It’s Important: For all projects, this is where you can manually enter or edit your tree 

data. If you have already entered or imported your data, this function can simply be a place 

for viewing that data. 

 

Shrubs 

Description: Field data collected for shrubs are entered in this function. You can also edit 

the shrub data using the tools in the Actions group of the ribbon once it has been entered 

or imported here. 
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Why It’s Important: If you are doing a plot-based sample project and collected shrub data, 

this is where you can manually enter or edit that data. If you have already entered or 

imported your data, this function can simply be a place for viewing that data. 

 

Check Data 

Description: The field data that you have imported or manually entered in the Plots, Trees, 

and/or Shrubs functions can be validated using the Check Data function. When you click 

on the Check Data function, Eco will check for invalid data and report issues that need to 

be corrected before you can submit your data to the server and retrieve your results.  

 

Export 

 

CSV 

Description: This function allows you to export tabular data from an open function to a 

“comma separated values” (csv) file format. 

 

 

 

 

Why It’s Important: Data exported as a csv file are compatible with Microsoft Excel and text 

editors such as WordPad and Notepad. This function allows you to save and organize your 

project data however you choose. 

 

KML 

Description: This function allows you to export tabular data from an open function to a 

“keyhole markup language” (kml) file format. 

 

Why It’s Important: If you have recorded the map coordinates of plot centers and/or trees, 

you will be able to make use of Eco’s KML function. Data exported as a kml file are 

compatible with software programs that include Google Earth and ArcGIS. This function 

allows you to view plot and tree data locations spatially. 

 

Inventory Value 

 

Benefit Prices 

Description: In this function, you can view or customize the benefit prices that will be used 

by the Eco model to estimate the economic value associated with the environmental 

benefits, such as carbon storage, provided by your urban forest. 

 

Why It’s Important: This is a great way to localize your results! Many of the default benefit 

prices available for Eco come from the scientific literature. This function allows you to enter 

data that is more relevant to your study area. Benefit prices may be edited at any time 

without requiring you to submit your project to the server again. The change to your 

monetary values will be reflected in the Reports tab immediately.  
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Annual Costs 

Description: In this function, you can include the annual costs associated with your project. 

There are no default costs for this function because they can vary significantly from place 

to place. The values that you provide here are primarily the annual costs associated with 

the management of your urban forest, such as tree planting or removal. However, there 

may be less obvious tree-related costs to consider, such as sidewalk repair costs or 

litigation fees. 

Why It’s Important: Providing annual cost information makes it possible to calculate a 

benefit-cost ratio which can be a valuable public-policy tool. Annual costs may be edited at 

any time without requiring you to submit your project to the server again. The change to 

your annual costs will be reflected in the Reports tab immediately. 

 

Actions 

 

The Actions group is available in the ribbon bar when you are working in a function that requires 

the following tools: 

 

New 

Description: This tool allows you to add a new class or category of data to the table that is 

open in the action panel. 

 

Undo 

Description: This tool allows you to undo the last action that you took. 

 

Redo 

Description: This tool allows you to redo an action that you had just negated using the 

Undo tool. 

 

Delete 

Description: This tool allows you to delete a selected class or category of data from the 

table that is open in the action panel. 

 

 

Editing Mode 

 

 

 

International Users: Remember the valuation data you collected in Phase 

II: Setting Up Your Project? The Benefit Prices function is where you 

will input your local values for estimating the economic value associated 

with certain tree benefits. Don’t forget – if you are choosing to use Eco’s 

default values, supply an exchange rate so your results will be given in 

your local currency.  

Tip 
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Editing Mode 

Description: This tool allows you to work in Editing mode so that you may edit or add to the 

inventory data in the Data tab. 

 

Why It’s Important: After you run the Eco model in the Reports tab, the Data tab, with the 

exception of the Benefit Prices and Annual Costs functions, will be locked so it cannot be 

edited unintentionally. The data that you enter in the Data tab may still be edited with 

caution. In order to do this, you will need to switch to Editing mode by clicking on the 

Enable Mode function. If you choose to work in Editing mode, you will need to submit your 

data to the server again and retrieve your updated results. 

 

View 

 

On this tab, you can specify how you would like to view your project data, including which dataset 

you would like to view and the style of the user interface. 

 

Specify Data 

 

Specify Data 

Description: This function offers three drop-down menus for you to specify which dataset 

you would like to view in the application. 

 

Why It’s Important: i-Tree Eco projects are stored in databases that may contain multiple 

datasets. Use this function to specify the project, series, and year of the dataset that you 

want to view in Eco. 

 

Species 

 

Species Codes 

Description: This function is a lookup tool that identifies the common name, scientific name, 

and species code associated with a tree species when you supply any one of the three 

descriptors. For example, if you know that the common name of one of your tree species is 

Red Maple, then supplying that name in the lookup tool will provide you with the 

corresponding species code and scientific name. 

 

Why It’s Important: i-Tree Eco features data for over 7,500 tree and shrub species, each of 

which is associated with a particular common name, scientific name, and species code. 

This lookup tool enables you to find those descriptors easily. 

 

 

 

 Species Lists 

Description: This function includes a table that identifies the species code, scientific name, 

and common name of all of the tree species that are available in Eco. This list can be 

exported to a “comma separated values” (csv) file for use outside of Eco. 
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Export 

 

CSV 

Description: This function allows you to export tabular data from an open function to a 

“comma separated values” (csv) file format. 

 

Why It’s Important: Data exported as a csv file are compatible with Microsoft Excel and text 

editors such as WordPad and Notepad. This function allows you to save and organize your 

project data however you choose. 

 

 

 

 

Configuration 

 

Style 

Description: The user interface of the Eco application can be customized by choosing one 

of the different color schemes from the drop-down list.  

 

Always Minimize Help Panel 

Description: Help text is available in the panel on the left-hand side of the i-Tree Eco 

window. This function allows you to have that help panel minimized at all times. You can 

also choose to maximize the help panel again by deselecting this option. 

 

Reports 

 

On this tab, you can run the i-Tree Eco model and view your results. Eco features a number of 

charts, tables, and reports to summarize the structure, function, and ecosystem services provided 

by the urban forest in your study area. 

 

 

Project Metadata 

 

Project Metadata 

Description: This report summarizes important metadata for your project, including the date 

your project was created, number of plots and / or trees, pollution and weather data used, 

benefit prices, and available reports. 

 

 

Go to Phase V: Viewing Your Reports to explore all of the reports that are 

available for your custom Eco project in more detail. 

Tip 
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Why It’s Important: The Project Metadata report is a good place to check if and when you 

ran the model and view some of the key information about your project.  

 

Submit Data for Processing 

 

Submit Data for Processing 

Description: This function begins data processing. When you click on this button, your 

project settings and inventory data will be sent to the i-Tree server where the Eco model 

will run. 

 

Why It’s Important: After you have established your project settings in the Project 

Configuration tab and entered your field data in the Data tab, it is time to run the i-Tree 

Eco model. 

 

Track & Retrieve Results 

 

Track & Retrieve Results 

Description: This function is essential after data processing. When you click on this button, 

you can retrieve your results from the i-Tree server and view your Eco reports. 

 

Why It’s Important: After the i-Tree Eco model has run on the server you can retrieve the 

results for your project – the big payoff for all your efforts! This function also allows you to 

track the status of your data submission and see where you are in the processing queue. 

 

 

Formatted Reports 

 

Written Report 

Description: This is a summary, narrative report of your project results. This report gives a 

great overview of the trees in your study area, while describing urban forest benefits and 

the basic methodology used in i-Tree Eco. 

 

Composition and Structure 

Description: The standard reports in this drop-down menu summarize information about the 

composition and structure of the trees in your study area, including DBH (diameter at 

breast height), condition, and leaf area and biomass. These reports are in tabular or chart 

format and can be saved or printed for use outside of the Eco application. 

 

 

If you make changes in the Project Configuration or Data tabs, you will need 

to send your data to the server again and retrieve your results so that the 

provided reports will be populated. 

Caution 

 
! 
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Benefits and Costs 

Description: The standard reports in this drop-down menu summarize information about  

the benefits and costs of the trees in your study area, including carbon storage and 

sequestration, energy effects, and pollution removal. These reports are in tabular or chart 

format and can be saved or printed for use outside of the Eco application. 

 

 

 

Measured Tree Details 

Description: The standard reports in this drop-down menu summarize information about the 

individual trees sampled in your study area. Reports include data about the composition 

and structure of the sampled trees, as well as benefits and costs. These reports are in 

tabular or chart format and can be saved or printed for use outside of the Eco application. 

 

Air Quality Health Impacts and Values 

Description: This is a standard report that provides estimates of the number of adverse 

health incidents avoided due to changes in pollutant concentration levels, as well as the 

economic value of reduced health incidents. This report is in tabular format and can be 

saved or printed for use outside of the Eco application. 

 

Pest Analysis 

Description: The standard reports in this drop-down menu summarize information about the 

pest susceptibility of trees in your urban forest (USA only), as well as signs and symptoms 

of pests in your study area. These reports are in tabular or chart format and can be saved 

or printed for use outside of the Eco application. 

 

Charts 

 

 

 

If you are doing a plot-based sample project, remember that the reports in the 

Measured Tree Details drop-down menu are only reporting results for the 

trees that you sampled during field data collection. These results do not 

represent the entire population in your study area. 

Caution 

 
! 

 

 

Reports summarizing documented signs and symptoms of tree pests and 

diseases require additional pest data to be collected. Please refer back to 

Phase IIIB: Collecting Your Field Data for more information on the 

requirements for the supplemental pest analysis. 

Tip 
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Pollution and Weather 

Description: The standard reports in this drop-down menu summarize information about the 

pollution and weather data used for your project, such as air pollutant concentration, rain, 

temperature, air quality improvement, transpiration, avoided runoff and isoprene emitted by 

trees. These reports are in tabular or chart format and can be saved or printed for use 

outside of the Eco application. 

Settings 

 

 Coordinates, Comments, User ID 

 Turn these on to view in reports when available. 

 

English or Metric Units 

Description: Choose to view your results in English (e.g., inches) or metric (e.g., 

centimeters) units. 

 

Why It’s Important: This function converts your results to English or metric units so you can 

view them in a way that suits your needs. This is also helpful if you have chosen to record 

your field data using one set of units, but would like to see results reported in different 

units. 

 

Common or Scientific Species Names 

Description: Choose to view your species by scientific name (e.g., Acer rubrum) or 

common name (e.g., Red maple). 

 

Why It’s Important: Many of the model outputs are reported by species. This function 

converts your results to scientific or common name so you can view them in a way that 

suits your needs. 

 

 

Model Notes 

 

Model Notes 

Description: The notes available here provide more information about the data processing 

that occurs within the Eco model. For example, notes displayed here may tell a user that 

because energy data collected for a specific tree was invalid, it has not been included in 

estimated energy effects. 

 

Why It’s Important: This function provides a good opportunity to see if any errors have 

occurred during data collection or data entry. You can use the key below your processing 

notes to decipher any errors that occurred and determine how to resolve them. 

 

 

Map Active Report (beta) 
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Forecast 

On this tab, you can run Eco’s Forecast component at a basic or advanced level and view the 

results of that run. To estimate what your urban forest will look like in the future, Forecast uses the 

structural estimates (e.g., number of trees, species composition) generated by running the i-Tree 

Eco model along with anticipated growth and mortality rates. You can even include future tree 

planting scenarios or possible adverse events, such as a storm or pest infestation, to predict their 

impact on your urban forest. 

 

Configuration Summary 

 

Configuration Summary 

Description: This is a summary report that displays all of the parameters that you defined 

for the active configuration. This includes parameters defined under the Basic Options 

function, such as number of years to forecast, frost-free days, and base annual mortality 

rates, as well as any additional annual mortality rates or tree planting and extreme event 

scenarios that you defined. If you have chosen to run Forecast using the defaults provided, 

you will see those values here as well. 

 

 

Run Forecast 

 

Run Forecast 

Description: This function is used to begin running the Forecast model. 

 

Why It’s Important: Clicking on the Run Forecast button starts the process of estimating 

your future urban forest. The configuration selected in the Active Configuration drop-

down menu on the ribbon defines the settings for your Forecast results. Make sure that the 

desired configuration is selected before running Forecast. 

 

 

Look at the Eco Guide to Using the Forecast Model for detailed 

directions. 

Eco Guide  

 

 

Don’t be shy – try just clicking the Run Forecast button in the ribbon bar! 

The Forecast model will use the provided default values and give you a 

basic estimate of what your urban forest will look like in the future. You can 

choose to make changes to the defaults later if you like. 

 

Tip 

https://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_UsingForecast.pdf
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Basic Options 

 

Basic Options 

Description: In this function, you can set the number of years into the future your results will 

be forecasted, the number of days without frost in your study area, and basic annual 

mortality rates.   

 

Why It’s Important: The variables that you can set in this function allow you to customize 

your Forecast results at a very basic level. Please note that making changes here is 

optional. You can always run the model using the defaults provided! 

 

Custom Options 

 

Annual Mortality Rates 

Description: In this function, you can define your annual mortality rates. 

 

Why It’s Important: The rates that you set in this function allow you to customize your 

Forecast results at a more advanced level. One of the advantages of setting advanced 

mortality rates is that you can apply annual mortality rates to specific condition classes, 

strata, or genera. Please note that making changes here is optional. You can always run 

the model using the defaults provided! 

 

Trees to Plant 

Description: In this function, you can define one or more tree planting scenarios. 

 

Why It’s Important: The tree planting scenarios that you define in this function allow you to 

customize your Forecast results at a more advanced level. One of the advantages of 

including tree planting scenarios is that you can model what your urban forest will look like 

in the future as a result of one or more tree planting events, allowing you to account for tree 

planting in your study area (or even natural regeneration, which can be factored in as if it 

were tree planting). Please note that adding scenarios here is optional. You do not need 

planting scenarios to run the model! 

 

 

Extreme Events 

 

• Pest Outbreaks 

Description: In this function (USA only), you can define one or more pest outbreaks, 

such as an emerald ash borer infestation, and the annual mortality rate associated with 

each event. 

 

• Weather Events 

Description: In this function, you can define one or more weather events, such as 

hurricane or tropical storm, and the annual mortality rate associated with each event. 

 



 

 101 

Why It’s Important: The extreme events that you define in this function allow you to 

customize your Forecast results at a more advanced level. One of the advantages of 

defining extreme events is that you can model what your urban forest will look like in the 

future as a result of the loss of trees. Extreme events can be set as a single incident or 

recurring event. Please note that adding events here is optional. You do not need extreme 

events to run the model! 

 

Configurations 

 

The Configurations group of the Forecast tab encompasses multiple functions, including the 

Active Configuration drop-down list and Rename, New, Duplicate, Delete, and Restore 

Defaults functions. One of the useful features of Forecast is that you can make use of the 

component many different ways by projecting future estimates with any number of combinations of 

settings, tree planting scenarios, and extreme events. Each one of these combinations is a 

different configuration and can be defined by going through the Basic or Custom Options of the 

ribbon. You can also choose to run Forecast without providing any special information and simply 

using the defaults provided. 

 

Active Configuration 

Description: This drop-down menu includes all of the Forecast configurations that you have 

created for your Eco project. 

 

Why It’s Important: The settings associated with the “active” configuration displayed here 

are what will be used when you decide to run Forecast. 

 

Rename 

Description: This tool allows you to rename the configuration that is displayed in the Active 

Configuration drop-down menu. 

 

New 

Description: This tool allows you to create a new Forecast configuration. Your new 

configuration will contain all of the default Forecast settings until you make changes. 

 

 

Duplicate 

 

 

You can choose to work with a different configuration at any time. Simply 

select the desired configuration from the Active Configuration drop-down 

menu! When you click on one of the other buttons or functions in the 

ribbon, the settings or reports will then be associated with that 

configuration.  

Tip 
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Description: This tool allows you to duplicate the configuration that is displayed in the 

Active Configuration drop-down menu. 

 

Why It’s Important: This a useful tool if you have created a custom configuration. By 

duplicating your custom configuration, you can start with whatever changes you have 

already made to the settings and just make desired modifications to create different 

scenarios more easily. 

 

Delete 

Description: This tool allows you to delete the configuration that is displayed in the Active 

Configuration drop-down menu. 

 

Restore Defaults 

Description: This tool will restore the default Forecast settings to the configuration that is 

displayed in the Active Configuration drop-down menu. 

 

Reports 

 

Composition and Structure 

Description: The standard reports in this drop-down menu summarize information about the 

structure of your future urban forest, including number of trees, tree cover, DBH (diameter 

at breast height), and leaf area and biomass. These reports are in tabular or chart format 

and can be saved or printed for use outside of the Eco application. 

 

Benefits 

Description: The standard reports in this drop-down menu summarize information about the 

function of your future urban forest, including carbon storage and sequestration and 

pollution removal. These reports are in tabular or chart format and can be saved or printed 

for use outside of the Eco application. 

 

Units 

 

English or Metric 

Description: Choose to view your results in English (e.g., inches) or metric (e.g., 

centimeters) units. 

Why It’s Important: This function converts your Forecast results to English or metric units 

so you can view them in a way that suits your needs. This is also helpful if you have 

chosen to record your field data using one set of units, but would like to see results 

reported in different units. 

 

 

 

 

Editing Mode 

 

Editing Mode 
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Description: This tool allows you to work in Editing mode in the Forecast tab. 

 

Why It’s Important: After the Forecast model has been run using a specified configuration, 

the settings of that configuration will be locked so they cannot be edited unintentionally. In 

order to edit those settings, first make sure that the appropriate configuration is selected in 

the Active Configuration drop-down menu and then switch to Editing mode by clicking on 

the Editing Mode function. If you choose to work in Editing mode, you will need to run 

Forecast again using that configuration to get updated results. 

 

Support 

 

On this tab, you can access i-Tree Eco’s numerous support resources. 

 

User Manual 

Description: This function provides detailed specifications on setting up a project and 

carrying out data collection in the field. 

 

User Guides 

Description: This function provides topic-specific information to help users work through 

specific tasks for their project. The user guides available here are the same that are 

referenced throughout this manual.  

 

User Forum 

Description: This function links you to the webpage where you can participate in a 

moderated discussion forum to solicit advice, get technical questions answered, 

communicate experiences, and view frequently asked questions (FAQs). 

 

i-Tree Website 

Description: This function links you to the webpage where you can learn about all of the i-

Tree applications and utilities, access i-Tree support resources, and read about what’s new 

with i-Tree. 

 

Software Update 

Description: This function checks for new versions of the i-Tree Eco software and 

downloads software updates. 

 

 

 

 

 

About 

Description: This option provides general information for the i-Tree Eco application. You 

can read an overview of the i-Tree Eco model and view version information, 

acknowledgements, and credits. 
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License Agreement 

Description: This function opens the i-Tree End User’s License Agreement that you agree 

to when you download the i-Tree software and run an Eco project. 

 

Feedback 

Description: This function links you to the webpage where you can provide feedback about 

your experience using the i-Tree Eco application. 

 

What’s New 

Description: This option provides you with a list of new features in Eco v6.0. You can read 

an overview of significant upgrades over previous versions and other important differences. 

 

 

 

To add or edit your project data in Eco, click on your computer’s Start button > (All) Programs > 

i-Tree > i-Tree Eco v6. You should have already created a new project before going out in the 

field to collect data. However, if you have not, refer back to Phase III > Preparing for the Field for 

directions on Getting Started in Eco or follow Eco’s on-screen help text. 

 

To open an existing project: 

1 Click File > Open Project. 

2 Browse to the folder where you saved your project, click on the file name, and click Open. 

 

From Paper Forms 

 

If you recorded your data using Eco’s paper form, you will have to enter your data manually: 

 

1 Click on the Data tab. 

2 Use the functions in the Inventory Data group of the ribbon.  

 

The data entry forms are in table format and allow you to enter or edit data for plots, trees, and 

shrubs, depending on how you customized your project. The tools in the Action group allow you to 

add 

new 

records, delete existing records, and undo or redo the last actions that you took. 

 

From the Mobile Data Collector 

 

 Adding Data 

 

 

The Data tab is where you add your new data manually or edit data that has 

already been entered.  

Tip 
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If you recorded your data using Eco’s mobile data collector, you can import your data directly into 

Eco: 

 
1 Click on the Data tab. 

2 Click on the Retrieve from Mobile function. 

3 Enter your password in the space provided. 

4 Click Show List and a description of your data will appear. 

5 Check the box next to the record(s) that you would like to retrieve. Each record includes a 

description and date to help you determine which records should be imported. 

6 Click Retrieve Data. 

 

From the Complete Inventory Importer 

 

If you have an existing tree inventory, you can import your data directly into your complete 

inventory project: 

 

1 Click on the Data tab. 

 

2 Click on the Trees function. (Note: The Import tool will become available in the ribbon.) 

 

3 Click on the Import tool to import your existing tree inventory. 

 

4 In the Data Import Wizard, click Browse. 

 

a Navigate to the file containing your inventory data.  

 

b Select the file and click Open. 

 

5 Confirm that the data that appears in the table is correct and click Next. 

 

6 Match your existing data fields to Eco’s data fields. 

 

 

a Select an inventory column from the table. The column header will appear in the 

“Your Source Column” space towards the bottom of the window. 

 

b Choose the “Eco Field” from the drop-down list that defines the type of data in your 

selected column. 

 

 

 

Try moving from left to right clicking on each column in turn. This can help 

ensure that you match all of the necessary columns to an Eco field. 

Tip 
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c Check the box indicating whether or not you will need to map your field values to 

the Eco field values. (Note: You will be prompted to complete the value mapping 

later. See step 8.) 

 

d CONDITIONALLY REQUIRED: As previously described, Eco data variables can 

often be displayed in several ways. For example, species data can be entered as 

common name, scientific name, or species code. For data variables where this 

applies, a “Field Type” drop-down list will appear below “Eco Field.” Select the field 

type that matches your existing data. 

 

e Repeat steps 6a through 6d until each variable that you would like imported has 

been matched to the appropriate Eco field. 

 

7 Click Next. 

 

8 CONDITIONALLY REQUIRED: For data variables that you indicated the need to map field 

values (step 6c), match your field values to Eco’s. 

 

a In the upper table, select a row. 

 

b In the lower table, choose the “Eco Value” from the drop-down list that matches 

“Your Value.”  

 

c Move through the lower table until all of your values have been matched to an Eco 

value. 

 

d Repeat steps 8a through 8c until all necessary data variables have been mapped. 

 

9 Click Next. 

 

10 Review the results of your processed data at the top of the Data Import Wizard. This 

information will tell you how many records from your inventory data will be imported. 

 

11 When you are satisfied with the data that will be imported, click Finish. (Note: Use the 

Back button to return to previous steps to make adjustments.) 

  

 

 

For more information on importing a complete inventory, please see the Eco 

Guide to Importing an Existing Inventory. 

Eco Guide  

http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_InventoryImporter.pdf
http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_InventoryImporter.pdf


 

 107 

 

After you have established your project settings in the Project Configuration tab and entered 

your field data in the Data tab, it is time to run the i-Tree Eco model and get the results for your 

project! 

 

i-Tree Eco presents model results in the Reports tab that include charts, tables, and a summary, 

narrative report. Functions that are greyed out cannot be accessed at that point. If you have not 

yet run the i-Tree Eco model, most of the reports, charts, and tables will not be available until after 

you have done so. Depending on the type of project and data collected, some analyses may not 

be completed.  

 

 

To start, open your existing project: 

1 Click File > Open Project. 

2 Browse to the folder where you saved your project, click on the file name, and click Open. 

 

Running the Eco model is a two-step process that is necessary to view your reports or use 

Forecast. The first step is to send your data to the i-Tree server where the Eco model will be run. 

The second step is to retrieve your results from the server. 

 

First, send your data to the i-Tree server: 

 

1 Click on the Reports tab. 

2 Click on the Submit Data for Processing function. 

3 Read the i-Tree End User’s License Agreement and click OK if you consent. 

4 In the Contact Information window, enter your personal information in the spaces 

provided.  

5 To confirm your email address, enter the same email address in the spaces labeled “Email” 

and “Confirm.” This information is critical. 

6 Click OK. 

 

Please be patient – model processing time depends on the number of projects that have been 

recently submitted to the server as well as the size of your project. You can click on the Track & 

Retrieve Results function to track your status in the queue. 

 

When your data have been processed, an auto-generated email notifying you that the results are 

ready to download will be sent to the email address that you provide in the Contact Information 

window. This email will be from info@itreetools.org; please check your spam folders if you do not 

receive the email. Likewise, you will be notified of processing errors that require data to be 

submitted again. If you do not receive your results within 24 hours, please contact 

Phase V: Viewing Your Reports 

 Running the Eco Model 

mailto:info@itreetools.org
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info@itreetools.org. 

 

Second, retrieve your results from the i-Tree server: 

 

1 Click on the Reports tab. 

2 Click on the Track & Retrieve Results function. 

3 In the Retrieve Processed Results window, click OK. 

4 Please be patient while results are downloaded. 

 

You will see that many of the reporting options listed in the ribbon bar are greyed out and 

unavailable until after you load your results from the server. 

 

If you are unsure whether or not you have run the Eco model, you can check the Project 

Metadata report of the Reports tab. This information is especially useful since you may find it 

necessary to run the i-Tree Eco model more than once throughout the duration of your project. 

 

 

Read through the descriptions in this section of the manual to learn more about the reports 

provided in Eco. The reports that are available to you are entirely based on the nature of your 

project and the data that you collected in the field or provided during project configuration. The 

Project Metadata report in the Reports tab provides a list of all possible Eco reports and indicates 

which ones are available for your specific project. 

 

 

i-

Tree Eco provides a wide variety of standard reports to users.  

 

 

The Formatted Reports group contains four drop-down lists to choose reports from: 

• Composition and Structure charts and tables present information on the structural 

aspects of the urban forest of your study area, including population size, species 

composition, leaf area, tree condition, and biomass information. Results are provided in a 

variety of ways, such as classified by DBH size class or by strata or presented on a per-

unit-area (per-acre or per-hectare) basis. 

 

• Benefits and Costs charts and tables present information on the environmental benefits 

that are provided by the urban forest in your study area. Results are provided in functional 

 Overview of Reports 

 

 

Need help interpreting some of your results? The Glossary of this manual 

is a great resource for definitions of key terms!  

Tip 

 

 

If you make changes to your project settings or add or edit your field data, you 

will need to send your data to the server and retrieve your results again to 

ensure that your changes are reflected in your reports. 

Caution 

 
! 

mailto:info@itreetools.org
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units (e.g., tons of carbon sequestered) and in associated monetary values.  

 

• Measured Tree Details charts and tables present information on the characteristics of the 

sampled trees in your study area, including structural aspects and ecosystem services. 

Results are provided for each individual tree, as well as by species.  

 

• Pest Analysis charts and tables include a standard report for all users on the susceptibility 

of their urban forest to known pests (USA only). For users who choose to conduct the Pest 

Detection Module, additional reports summarize the results of that analysis. 

 

The Charts group contains one drop-down list to choose reports from: 

• Pollution and Weather charts and tables present information from the weather and 

pollution data used for your project, such as rain, temperature, air pollutant concentration, 

air quality improvement, and transpiration. 

 

The Model Notes function provides more information about the data processing that occurs within 

the Eco model. 

 

The Units and Species Names groups include functions that allow you to set how units (i.e., 

metric or English) and species names (i.e., common or scientific) are displayed in your reports. 

You may choose to switch between the available options while you view your reports. 

Project Metadata 

 

This report provides important information describing your project, including: 

• Version of i-Tree Eco used 

• Date when the project was created 

• Whether or not the model has been run 

• Project name, series, and year 

• Description of project settings 

• Details about pollution and weather data used 

 

 Reports 

 

 

If you are doing a plot-based sample project, remember that the reports in the 

Measured Tree Details drop-down menu are only reporting results for the 

trees that you sampled during field data collection. These results do not 

represent the entire population in your study area. 

Caution 

 
! 
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One important piece of information that can be gathered here is whether or not the i-Tree Eco 

model has been run. This information is especially useful since you may find it necessary to run 

the i-Tree Eco model more than once throughout the duration of your project. 

 

Written Report 

 

This report includes a summary and discussion of the following results from your project: 

• Tree characteristics of the urban forest 

• Urban forest cover and leaf area 

• Ecosystem services (air pollution removal, carbon storage, etc.) 

• Structural and functional values of trees 

• Potential pest impacts 

• i-Tree Eco methods 

 

Composition and Structure Reports 

 

Structure Summary > By Species 

This report provides a summary of Eco’s structural estimates, including number of trees, leaf area, 

leaf biomass, tree biomass, and average condition, for each species in your study area. 

 

Structure Summary > By Stratum and Species 

This report provides a summary of Eco’s structural estimates, including number of trees, leaf area, 

leaf biomass, tree biomass, and average condition, for the tree species in each stratum in your 

study area. 

 

Population Summary > By Species 

This report provides total estimates and percent contributions of the number of trees for each 

species in your study area. Results are displayed in pie chart and table formats. 

 

Population Summary > By Stratum 

This report provides total estimates and percent contributions of the number of trees found in each 

stratum in your study area. Results are displayed in bar chart, pie chart, and table formats. 

 

Population Summary > By Stratum per Unit Area 

This report provides per area (density) estimates of the number of trees found in each stratum in 

your study area. Per area estimates are calculated by dividing the total number of trees in each 

stratum by the area of the stratum. This report displays results in bar chart and table formats. 

 

Population Summary > Street Trees by Stratum 

This report provides estimates of the number of trees and percent of trees that were designated as 

street trees or non-street trees. Street tree and non-street tree results are summarized in separate 

tables by stratum. The tables display the following information: 

• Number of Trees – number of trees in stratum that were classified as street trees or non-
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street trees. 

• % of Strata Trees – percent of trees in stratum that were classified as street trees or non-

street trees. For example, in the “Summary of Street Trees” table, 100% would indicate that 

all trees located in that stratum were classified as street trees. 

• % of Street Trees – percent of all trees classified as street trees that were located in each 

stratum. For example, 50% would indicate that half of all street trees were located in that 

stratum.   

• % of Non-Street Trees – percent of all trees classified as non-street trees that were located 

in each stratum. For example, 25% would indicate that one quarter of all non-street trees 

were located in that stratum.  

• % of All Trees – percent of the total number of trees that were classified as street trees or 

non-street trees and located in each stratum. For example, in the “Summary of Street 

Trees” table, 0% would indicate that none of the total number of trees were classified as 

street trees and located in that stratum. 

 

Species Distribution > By DBH Class (chart) 

This report provides estimates of the proportion of trees of each species that falls into each 

diameter at breast height (DBH) size class. Results are displayed in chart format for the 10 most 

common species, showing the percent of the tree species population by DBH class. 

 

Species Distribution > By DBH Class (vertical table) 

This table provides estimates of the proportion of trees of each species that falls into each 

diameter at breast height (DBH) size class. Results are displayed for the percent of the tree 

species population by DBH class and include estimates of standard error. If all DBH classes 

cannot fit across the top of the table, the vertical display breaks the results into several tables so 

you can scroll down through all species in your study area before reaching the remaining DBH 

classes. 

 

Species Distribution > By DBH Class (horizontal table) 

This table provides estimates of the proportion of trees of each tree species that falls into each 

diameter at breast height (DBH) size class. Results are displayed for the percent of the tree 

species population by DBH class and include estimates of standard error. If all DBH classes 

cannot fit across the top of the table, the horizontal display breaks the results into several tables so 

you can scroll to the right through all DBH classes. 

 

Species Distribution > By DBH Class and Stratum (vertical table) 

This table provides estimates of the proportion of trees of each tree species by stratum that falls 

into each diameter at breast height (DBH) size class. Results are displayed for the percent of the 

tree species population by DBH class and include estimates of standard error. If all DBH classes 

cannot fit across the top of the table, the vertical display breaks the results into several tables so 

you can scroll down through all species in your study area before reaching the remaining DBH 

classes. 

 

Species Distribution > By DBH Class and Stratum (horizontal table) 

This table provides estimates of the proportion of trees of each tree species by stratum that falls 

into each diameter at breast height (DBH) size class. Results are displayed for the percent of the 
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tree species population by DBH class and include estimates of standard error. If all DBH classes 

cannot fit across the top of the table, the horizontal display breaks the results into several tables so 

you can scroll to the right through all DBH classes. 

 

Importance Value > By Species 

This table provides estimates of the percent population, percent leaf area, and importance value 

for each tree species in your study area. Results are ordered from the highest to lowest 

importance value. Importance value (IV) is calculated as the sum of the percent population and 

percent leaf area. High importance values do not mean that these trees should necessarily be 

encouraged in the future; rather, these species currently dominate the urban forest structure. 

 

Diversity Indices > By Stratum 

This table provides estimates of various diversity indices by stratum in your study area. The 

diversity indices presented here serve as indicators of species richness, dominance, and 

evenness. This table displays the following information by stratum: 

• Richness – number of species sampled. 

• Per area estimates of number of species – density estimates calculated by dividing the total 

number of species in each stratum by the area of the stratum. 

• Shannon-Wiener diversity index – a diversity index that serves as an indicator for species 

richness. Because this index assumes that all species within a stratum or study area have 

been sampled, it has a moderate sensitivity to sample size; therefore, strata and/or cities 

may not be comparable.  

• Menhinick’s diversity index – another diversity index that also serves as an indicator for 

species richness. This index has a low sensitivity to sample size and therefore may be 

more appropriate for comparison between strata. 

• Simpson’s diversity index – a diversity index that serves as an indicator for species 

dominance. It also has a low sensitivity to sample size and therefore may be more 

appropriate for comparison between strata. 

• Shannon-Wiener evenness index – an evenness index that, like the Shannon-Wiener 

diversity index, assumes that all species within a stratum or study area have been 

sampled. Similarly, it has a moderate sensitivity to sample size; therefore, strata and/or 

cities may not be comparable. 

• Sander’s rarefaction technique – a technique used for assessing species richness of 

samples. For a particular stratum, this value is the number of species one would expect to 

find if four trees were sampled in the stratum. For the city, this value is the number of 

species one would expect to find if 250 trees were sampled within the city. 

 

Species Range > Native Status by Stratum 

This table provides estimates of the percent of the trees in each stratum that are native to the state 

that the study area is located in. Possible places of origin include: 

• State (for U.S. projects only) 

• Africa 

• Africa & Asia 

• Asia 

• Asia & Australia 
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• Asia & Australia + 

• Australia 

• Europe 

• Europe & Africa 

• Europe & Asia 

• Europe & Asia + 

• North America 

• North America + 

• North & South America 

• North & South America + 

• Other 

• South America 

• Unknown 

 

”Unknown” indicates that the origin of the tree species is unknown; places of origin that include two 

continents indicate that the tree species is native to both continents; and places of origin marked 

with a “+” indicate that the tree species is native to the place of origin listed plus another continent 

that is not listed. For projects in the U.S., “State” is an additional place of origin that is reported and 

refers to the state in which the study area is located. 

 

Condition > By Species 

This table provides estimates of the percent of each tree species found in each condition class. 

The following condition classes are included in the table: 

• Excellent 

• Good 

• Fair 

• Poor 

• Critical 

• Dying 

• Dead 

 

For users providing custom classes, refer back to the Condition or Dieback function of the 

Project Configuration tab to see how the default classes displayed here are defined in terms of 

your custom classes. Please be aware that using custom classes makes comparing results across 

projects more difficult and should be done with caution. 

 

Condition > By Stratum and Species 

This table provides estimates of the percent of each tree species by stratum found in each 

condition class. The following condition classes are included in the table: 

• Excellent 

• Good 

• Fair 

• Poor 

• Critical 
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• Dying 

• Dead 

 

For users providing custom classes, refer back to the Condition or Dieback function of the 

Project Configuration tab to see how the default classes displayed here are defined in terms of 

your custom classes. Please be aware that using custom classes makes comparing results across 

projects more difficult and should be done with caution. 

 

Leaf Area > By Stratum 

This report provides total estimates and percent contributions of the leaf area found in each 

stratum in your study area. Results are displayed in bar chart, pie chart, and table formats. 

 

Leaf Area > By Stratum per Unit Area 

This report provides per area (density) estimates of the leaf area found in each stratum in your 

study area. Per area estimates are calculated by dividing the total leaf area in each stratum by the 

area of the stratum. Results are displayed in bar chart and table formats. 

 

Leaf Area and Biomass > Of Shrubs by Stratum 

This table provides per area (density) and total estimates of leaf area and leaf biomass for each 

shrub species by stratum. Per area estimates are calculated by dividing the total leaf area or total 

leaf biomass in each stratum by the area of the stratum. Results include estimates of standard 

error. 

 

Leaf Area and Biomass > Of Trees and Shrubs by Stratum 

This table provides per area (density) and total estimates of leaf area and leaf biomass for tree and 

shrub species by stratum. Per area estimates are calculated by dividing the total leaf area or total 

leaf biomass in each stratum by the area of the stratum. Results include estimates of standard 

error. 

 

Ground Cover Composition > By Stratum 

This table provides estimates of percent ground cover for each stratum in your study area. Results 

include estimates of standard error. The ground cover classes included here are defined in the 

Ground Cover function on the Project Configuration tab. 

 

Land Use Composition > By Stratum 

This table provides estimates of the amount of each stratum in your study area classified 

according to the actual land uses measured in the field. If you have chosen to stratify your project 

by land use, this table provides a useful look at how closely aligned your strata classifications are 

with actual land uses. Strata are defined in the Project & Strata Area function of the Project 

Configuration tab. Land uses are defined in the Land Use function on the Project Configuration 

tab. 

 

Relative Performance Index > By Species 

This table provides estimates of relative performance index (RPI) by tree species. RPI compares 

the overall condition of each species to all the others. Values that are higher than 1 indicate that a 

species has a proportionately better condition rating.  
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Maintenance > Recommended 

This table provides estimates of the number of trees, percent of species, and percent of all trees 

that were designated as needing some kind of recommended maintenance. Results are presented 

by recommended maintenance type, species, and DBH size class. 

 

Maintenance > Task 

This table provides estimates of the number of trees, percent of species, and percent of all trees 

that were as assigned to receive a particular maintenance task. Results are presented by 

maintenance task, species, and DBH size class. 

 

Maintenance > Sidewalk Conflicts 

This table provides estimates of the number of trees, percent of species, and percent of all trees 

that were designated as exhibiting a sidewalk conflict. Results are presented by type of sidewalk 

conflict, species, and DBH size class. 

 

Maintenance > Utility Conflicts  

This table provides estimates of the number of trees, percent of species, and percent of all trees 

that were designated as a utility conflict class. Results are presented by type of utility conflict, 

species, and DBH size class. 

 

Other > Other One / Two / Three 

If you created one or more custom data fields (maximum of three) during project configuration, 

these tables will provide estimates of the number of trees, percent of species, and percent of all 

trees that were designated according to those custom fields. Results are presented by type of 

custom data, species, and DBH size class. 

 

Miscellaneous > All Plots 

This table provides information of the stratum, address, date, crew, and whether or not the data 

collection was completed for each plot. 

 

Miscellaneous > Plot Comments 

This table lists any comments that were collected related to plots. 

Benefits and Costs Reports 

 

 

 

Monetary values are based on the Benefit Prices function of the Data tab. 

To edit benefit prices, open that function and follow the steps outlined in 

the Help panel. This form can be edited at any time and you will not be 

required to submit your project again. Results on the Reports tab will 

reflect the change in benefit prices immediately. 

Tip 
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Benefits Summary > By Species 

This report provides a summary of Eco’s benefit estimates, including number of trees, carbon 

storage and sequestration, avoided runoff, pollution removal, and structural value, for each species 

in your study area. 

 

Benefits Summary > By Stratum and Species 

This report provides a summary of Eco’s benefit estimates, including number of trees, carbon 

storage and sequestration, avoided runoff, pollution removal, and structural value, for the tree 

species in each stratum in your study area. 

 

Carbon Storage of Trees > By Species 

This report provides total estimates and percent contribution of carbon storage of trees by species 

in your study area. Results are also reported in carbon dioxide equivalent by multiplying carbon 

storage by the ratio of their atomic weights (44/12). Results are displayed in table format. 

 

Carbon Storage of Trees > By Stratum 

This report provides total estimates and percent contribution of carbon storage of trees by stratum 

in your study area. Results are also reported in carbon dioxide equivalent by multiplying carbon 

storage by the ratio of their atomic weights (44/12). Results are displayed in bar chart, pie chart, 

and table formats. 

 

Carbon Storage of Trees > By Stratum per Unit Area 

This report provides (density) per area estimates of carbon storage of trees by stratum in your 

study area. Per area estimates are calculated by dividing the total carbon storage in each stratum 

by the area of the stratum. Per area estimates are also reported for the carbon dioxide equivalent. 

Results are displayed in bar chart and table formats. 

 

Annual Carbon Sequestration of Trees > By Species 

This report provides total estimates of gross carbon sequestration of trees by species in your study 

area. Results are also reported in carbon dioxide equivalent by multiplying carbon sequestration by 

the ratio of their atomic weights (44/12). Results are displayed in table format. 

 

Annual Carbon Sequestration of Trees > By Stratum 

This report provides total estimates of gross carbon sequestration of trees by stratum in your study 

area. Results are also reported in carbon dioxide equivalent by multiplying carbon sequestration by 

the ratio of their atomic weights (44/12). Results are displayed in bar chart and table formats. 

 

Annual Carbon Sequestration of Trees > By Stratum per Unit Area 

This report provides per area (density) estimates of gross carbon sequestration of trees by stratum 

in your study area. Per area estimates are calculated by dividing the total gross carbon 

sequestration in each stratum by the area of the stratum. Per area estimates are also reported for 

the carbon dioxide equivalent. Results are displayed in bar chart and table formats. 

 

Annual Net Carbon Sequestration of Trees > By Species 

This report provides total estimates of net carbon sequestration of trees by species in your study 

area. Net sequestration is a measure of the carbon sequestered by trees calculated as the gross 
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carbon sequestered minus the carbon emissions due to decomposition after tree death. Results 

are also reported in carbon dioxide equivalent by multiplying carbon sequestration by the ratio of 

their atomic weights (44/12). Results are displayed in table format. 

 

Annual Net Carbon Sequestration of Trees > By Stratum 

This report provides total estimates of net carbon sequestration of trees by stratum in your study 

area. Net sequestration is a measure of the carbon sequestered by trees calculated as the gross 

carbon sequestered minus the carbon emissions due to decomposition after tree death. Results 

are also reported in carbon dioxide equivalent by multiplying carbon sequestration by the ratio of 

their atomic weights (44/12). Results are displayed in bar chart and table formats. 

 

Annual Net Carbon Sequestration of Trees > By Stratum per Unit Area 

This report provides per area (density) estimates of net carbon sequestration of trees by stratum in 

your study area. Net sequestration is a measure of the carbon sequestered by trees calculated as 

the gross carbon sequestered minus the carbon emissions due to decomposition after tree death. 

Per area estimates are calculated by dividing the total gross carbon sequestration in each stratum 

by the area of the stratum. Per area estimates are also reported for the carbon dioxide equivalent. 

Results are displayed in bar chart and table formats. 

 

 

 

Compensatory Value Factors for European Countries 

Compensatory value for trees is calculated using the Trunk Area formula found in the CTLA 

guide’s 8th edition. Some factors that determine the final value are species rating, base value, and 

for palm trees the cost per linear foot of clear trunk. These values were compiled from numerous 

states within the United States for i-Tree Eco, but comparable factors for European nations are not 

readily available. 

 

The species value is a rating from 0-100 (where 100 is the most desirable). For each species, this 

rating might change from one location to another. The average U.S. rating by species was applied 

for all European countries (see table 1). If no species value is found for an individual species then 

the average from the same genus is used. If no genus value is found, the average of results from 

all broadleaf or conifer equations is used. There are numerous other methods to estimate 

structural value throughout the world, but the CTLA approach is commonly used in the US and is 

also used in non-US countries within i-Tree for consistency in estimation of compensatory values. 

 

Table 1. Average species values used in i-Tree for Europe 

Scientific Name Average of rating 

Abies alba 62 

Abies amabilis 62 

Abies balsamea 60 

Abies bracteata 62 

Abies concolor 79 

Abies concolor v lowiana 62 
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Abies fraseri 63 

Abies grandis 62 

Abies holophylla 62 

Abies homolepis 62 

Abies lasiocarpa 62 

Abies magnifica 62 

Abies procera 62 

Abies spp. 62 

Acer barbatum 73 

Acer buergerianum 73 

Acer campestre 73 

Acer circinatum 73 

Acer ginnala 73 

Acer glabrum 73 

Acer grandidentatum 73 

Acer griseum 73 

Acer japonicum 73 

Acer leucoderme 73 

Acer macrophyllum 51 

Acer mono 73 

Acer negundo 33 

Acer nigrum 78 

Acer palmatum 73 

Acer pensylvanicum 73 

Acer platanoides 65 

Acer pseudoplatanus 63 

Acer rubrum 74 

Acer saccharinum 40 

Acer saccharum 77 

Acer spicatum 73 

Acer tataricum 73 

Acer spp. 73 

Aesculus flava 68 

Aesculus glabra 63 

Aesculus hippocastanum 60 

Ailanthus altissima 31 

Arbutus menziesii 50 

Betula alleghaniensis 61 

Betula lenta 57 

Betula nigra 70 

Betula occidentalis 59 

Betula papyrifera 60 

Betula pendula 59 
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Betula populifolia 59 

Betula pubescens 59 

Betula pumila 58 

Betula spp. 59 

Carya alba 66 

Carya aquatica 61 

Carya cordiformis 62 

Carya floridana 51 

Carya glabra 65 

Carya illinoinensis 61 

Carya laciniosa 60 

Carya myristiciformis 51 

Carya ovalis 51 

Carya ovata 67 

Carya pallida 51 

Carya texana 51 

Carya spp. 51 

Castanea dentata 48 

Catalpa speciosa 47 

Cedrus atlantica 82 

Cedrus deodara 64 

Celtis laevigata 63 

Celtis occidentalis 69 

Cercidiphyllum japonicum 79 

Chamaecyparis thyoides 71 

Chrysolepis chrysophylla 75 

Cryptomeria japonica 62 

Cupressocyparis leylandii 64 

Eucalyptus botryoides 52 

Eucalyptus camaldulensis 52 

Eucalyptus camphora 52 

Eucalyptus cinerea 52 

Eucalyptus diversicolor 52 

Eucalyptus globulus 52 

Eucalyptus grandis 52 

Eucalyptus gunnii 52 

Eucalyptus leucoxylon 52 

Eucalyptus polyanthemos 52 

Eucalyptus pulchella 52 

Eucalyptus rudis 52 

Eucalyptus sideroxylon 52 

Eucalyptus tereticornis 52 

Eucalyptus viminalis 52 
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Eucalyptus spp. 52 

Fagus grandifolia 86 

Fagus sylvatica 83 

Fraxinus americana 67 

Fraxinus anomala 63 

Fraxinus berlandieriana 64 

Fraxinus caroliniana 64 

Fraxinus cuspidata 64 

Fraxinus excelsior 64 

Fraxinus greggii 64 

Fraxinus holotricha 64 

Fraxinus latifolia 64 

Fraxinus nigra 58 

Fraxinus ornus 64 

Fraxinus oxycarpa 64 

Fraxinus pennsylvanica 65 

Fraxinus profunda 64 

Fraxinus quadrangulata 69 

Fraxinus texensis 64 

Fraxinus uhdei 64 

Fraxinus velutina 64 

Fraxinus spp. 64 

Ginkgo biloba 81 

Gleditsia triacanthos 65 

Gymnocladus dioicus 75 

Juglans cinerea 52 

Juglans nigra 63 

Juglans regia 54 

Juniperus virginiana 63 

Larix decidua 72 

Larix laricina 69 

Liquidambar styraciflua 72 

Liriodendron tulipifera 75 

Lithocarpus densiflorus 65 

Magnolia acuminata 73 

Magnolia grandiflora 70 

Metasequoia glyptostroboides 79 

Nyssa sylvatica 84 

Paulownia tomentosa 41 

Picea abies 69 

Picea abies x asperata 75 

Picea asperata 75 

Picea bicolor 75 
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Picea breweriana 75 

Picea engelmannii 75 

Picea glauca 71 

Picea glehnii 75 

Picea jezoensis 75 

Picea koraiensis 75 

Picea koyamai 75 

Picea mariana 74 

Picea montigena 75 

Picea omorika 75 

Picea pungens 76 

Picea rubens 75 

Picea sitchensis 75 

Picea spp. 75 

Pinus albicaulis 60 

Pinus aristata 60 

Pinus attenuata 60 

Pinus balfouriana 60 

Pinus banksiana 45 

Pinus canariensis 60 

Pinus cembroides 60 

Pinus clausa 60 

Pinus contorta 60 

Pinus coulteri 60 

Pinus densiflora 60 

Pinus discolor 60 

Pinus echinata 50 

Pinus edulis 60 

Pinus elliottii 57 

Pinus engelmannii 60 

Pinus flexilis 60 

Pinus glabra 55 

Pinus halepensis 60 

Pinus jeffreyi 60 

Pinus lambertiana 60 

Pinus longaeva 60 

Pinus monophylla 60 

Pinus monticola 60 

Pinus mugo 60 

Pinus muricata 60 

Pinus nigra 66 

Pinus palustris 75 

Pinus parviflora 60 
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Pinus pinea 60 

Pinus ponderosa 60 

Pinus pungens 60 

Pinus quadrifolia 60 

Pinus radiata 60 

Pinus resinosa 65 

Pinus rigida 58 

Pinus sabiniana 60 

Pinus serotina 60 

Pinus strobiformis 60 

Pinus strobus 73 

Pinus sylvestris 65 

Pinus taeda 70 

Pinus thunbergiana 60 

Pinus torreyana 60 

Pinus virginiana 53 

Pinus washoensis 60 

Pinus spp. 60 

Platanus hybrida 67 

Platanus occidentalis 63 

Populus alba 36 

Populus angustifolia 39 

Populus balsamifera 39 

Populus balsamifera ssp. trichoca 37 

Populus x canadensis 39 

Populus x canescens 33 

Populus deltoides 45 

Populus deltoides ssp. monilife 39 

Populus fremontii 39 

Populus grandidentata 43 

Populus heterophylla 30 

Populus nigra 33 

Populus tremuloides 42 

Populus spp. 39 

Prunus alleghaniensis 48 

Prunus americana 48 

Prunus angustifolia 48 

Prunus armeniaca 48 

Prunus avium 48 

Prunus x blireiana 48 

Prunus caroliniana 48 

Prunus cerasifera 48 

Prunus domestica 48 
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Prunus dulcis 48 

Prunus emarginata 48 

Prunus fremontii 48 

Prunus glandulosa 48 

Prunus hortulana 48 

Prunus ilicifolia ssp. lyon 48 

Prunus japonica 48 

Prunus laurocerasus 48 

Prunus maackii 48 

Prunus maritima 48 

Prunus mexicana 48 

Prunus munsoniana 48 

Prunus myrtifolia 48 

Prunus nigra 48 

Prunus padus 48 

Prunus pensylvanica 48 

Prunus persica 48 

Prunus pumila 48 

Prunus pumila v. besseyi 48 

Prunus sargentii 48 

Prunus serotina 45 

Prunus serrulata 48 

Prunus spinosa 48 

Prunus subcordata 48 

Prunus subhirtella 48 

Prunus triloba 48 

Prunus umbellata 48 

Prunus virginiana 48 

Prunus spp. 48 

Pseudotsuga menziesii 75 

Quercus acutissima 78 

Quercus agrifolia 83 

Quercus alba 88 

Quercus arizonica 83 

Quercus austrina 83 

Quercus berberidifolia 83 

Quercus bicolor 82 

Quercus cerris 77 

Quercus chapmanii 83 

Quercus chrysolepis 84 

Quercus coccinea 86 

Quercus douglasii 80 

Quercus dunnii 83 
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Quercus ellipsoidalis 80 

Quercus emoryi 83 

Quercus engelmannii 83 

Quercus falcata 78 

Quercus gambelii 83 

Quercus garryana 81 

Quercus grisea 83 

Quercus hemisphaerica 83 

Quercus hypoleucoides 83 

Quercus ilicifolia 83 

Quercus imbricaria 74 

Quercus incana 83 

Quercus kelloggii 79 

Quercus laevis 71 

Quercus laurifolia 76 

Quercus lobata 82 

Quercus lyrata 85 

Quercus macrocarpa 87 

Quercus margaretta 83 

Quercus marilandica 56 

Quercus michauxii 81 

Quercus muehlenbergii 81 

Quercus myrtifolia 78 

Quercus nigra 74 

Quercus oblongifolia 83 

Quercus oglethorpensis 83 

Quercus pagoda 83 

Quercus palustris 66 

Quercus petraea 83 

Quercus phellos 76 

Quercus prinoides 83 

Quercus prinus 78 

Quercus robur 79 

Quercus rubra 75 

Quercus shumardii 83 

Quercus sinuata 83 

Quercus stellata 61 

Quercus suber 83 

Quercus texana 83 

Quercus velutina 76 

Quercus virginiana 84 

Quercus wislizeni 80 

Quercus spp. 83 
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Robinia pseudoacacia 41 

Salix nigra 37 

Salix x sepulcralis 41 

Sequoia sempervirens 70 

Sequoiadendron giganteum 70 

Taxodium distichum 79 

Thuja occidentalis 57 

Thuja plicata 55 

Tilia americana 67 

Tilia cordata 81 

Tilia tomentosa 73 

Tsuga canadensis 71 

Ulmus alata 59 

Ulmus americana 52 

Ulmus crassifolia 62 

Ulmus glabra 60 

Ulmus parvifolia 74 

Ulmus procera 66 

Ulmus pumila 31 

Ulmus rubra 52 

Ulmus serotina 60 

Ulmus thomasii 62 

Ulmus spp. 59 

Umbellularia californica 60 

Zelkova serrata 68 

 

The base value is comprised of 3 factors: 1) replacement cost, 2) maximum size for replacement, 

and 3) average cost per square inch of trunk area, which varies by state. For Europe, the average 

replacement cost and cost per sq. inch for trees with a maximum replacement size of 4 inch (10 

cm) dbh is based on an average of all species with values within hardwood and softwood 

categories (Table 2).  

 

Table 2. Average base values used in Europe 

Category Cost Trunk Area Replacement Cost Max. Transplant Size 

Hardwood $30.31 / sq. inch $820 4-inches 

Softwood $29.55 / sq. inch $769 4-inches 

 

 

Palm trees are valued differently from hardwood and softwood trees. To calculate the replacement 

cost, a dollar value per clear trunk length is added to a planting cost. Clear trunk is determined by 

the length of trunk which is free from fronds. An average dollar per foot of clear trunk from Florida 

and California was used for Europe; these were the only two states that had reported values in the 

CTLA guide. The cost per linear foot and planting costs (based on CTLA planting cost categories 
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by species) are given in Table 3. 

 

 

 

Table 3. Palm factors for determining replacement costs by i-Tree species code 

Scientific Name $/clear foot of trunk Planting cost ($) 

Acoelorrhaphe wrightii 15 275 

Archontophoenix alexandrae 103 275 

Archontophoenix cunninghamiana 103 275 

Arecastrum romanzoffianum 103 275 

Brahea armata 171 350 

Brahea edulis 171 350 

Butia capitata 62 350 

Chamaerops humilis 71 350 

Cocos nucifera 140 750 

Cycas circinalis 140 750 

Cycas revoluta 205 750 

Livistona chinensis 60 350 

Phoenix canariensis 321 2000 

Phoenix dactylifera 134 700 

Phoenix reclinata 86 850 

Phoenix roebelenii 73 350 

Phoenix sylvestris 95 350 

Roystonea elata 90 275 

Sabal palmetto 6 275 

Syagrus romanzoffiana 33 350 

Trachycarpus fortunei 55 350 

Washingtonia filifera 43 400 

Washingtonia robusta 25 275 

Yucca aloifolia 103 275 

Yucca guatemalensis 103 275 

 

 

Energy Effects > Of Trees 

This table provides total estimates of the effect of trees in your study area on energy usage. 

Estimates are included for the following energy effects: 

• Effect on building energy use (i.e., increases or decreases in the number of MBTUs and 

MWHs used for heating or cooling residential buildings in study area) 

• Effect on carbon emissions (i.e., increases or decreases in carbon emissions from power 

sources as a result of changes in energy use) 

• Value of effects (i.e., economic values associated with the changes in building energy use 

and carbon emissions) 
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European Energy Savings Calculations 

For i-Tree energy calculations to function outside the US, cities in Europe need to be assigned a 

US climate region to ascertain energy and fuel type values. The European associations with 

climate regions were compiled at the national level based on the following criteria in sequence: 

1) User assignments through the i-Tree Database. If multiple cities were assigned with a 

European country or no cities were assigned, the following procedures were used 

2) Location of the county based on similarities with US latitude and coastal/interior geographic 

similarities 

3) Climate similarities based on average annual temperature (Figure 1, Table 1) 

 

Figure 1. U.S. climate zones from the Carbon Reduction through Urban Forestry guidelines 

(McPherson and Simpson 1999). 

 
 

 

 

https://www.fs.fed.us/psw/topics/urban_forestry/products/cufr_43.pdf
https://www.fs.fed.us/psw/topics/urban_forestry/products/cufr_43.pdf
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Table 2. U.S. climate zones assigned to countries in Europe. 

Country U.S. Climate Zone 

Austria Southeast 

Belgium Pacific Northwest 

Bulgaria Southwest 

Croatia Southwest 

Cyprus California Coast 

Czech Republic Southeast 

Denmark Pacific Northwest 

Germany California Coast 

Greece California Coast 

Estonia Northern Tier 

Finland Northern Tier 

France California Coast 

Hungary Southeast 

Iceland Northern Tier 

Ireland Pacific Northwest 

Italy California Coast 

Latvia Northern Tier 

Liechtenstein Southeast 

Lithuania Northern Tier 

Luxembourg Pacific Northwest 

Malta California Coast 

Montenegro California Coast 

Netherlands Pacific Northwest 

Norway Northern Tier 

Poland Pacific Northwest 

Portugal California Coast 

Republic of Macedonia California Coast 

Romania Southwest 

Spain California Coast 

Slovakia Southwest 

Slovenia Southwest 

Switzerland Southeast 

Sweden Northern Tier 

Turkey Pacific Northwest 

United Kingdom Pacific Northwest 

Note: not all countries in Europe are assessed in i-Tree due to limited data for the missing 

countries 

 

The cost of electricity and fuels for all European countries came from Eurostat (2017). 

All other variables used in the energy savings calculations in Europe are based on the formulas 

and lookup tables in the Carbon Reduction through Urban Forestry guidelines (McPherson and 

Simpson 1999).  

Warning: this procedure of estimating tree effects on energy use was developed for US building 

https://ec.europa.eu/eurostat/statistics-explained/index.php/Electricity_price_statistics
https://www.fs.fed.us/psw/topics/urban_forestry/products/cufr_43.pdf
https://www.fs.fed.us/psw/topics/urban_forestry/products/cufr_43.pdf
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types and energy uses. Applications of this process outside of the United States will produce 

results that assume that the U.S. conditions (e.g., climate, building types, heating fuel usage) apply 

to the European country. The only local values used in the estimates for Europe are electricity and 

fuel costs. The remainder of the estimation is based US conditions from the assigned climate 

zone. 

 

Hydrology Effects of Trees > By Species 

This table provides total estimates of stormwater runoff avoided due to trees by species in your 

study area. This table includes estimates for the following: 

• Number of trees 

• Leaf area 

• Potential evapotranspiration 

• Evaporation 

• Transpiration 

• Water intercepted 

• Avoided runoff 

• Avoided runoff value 

 

Hydrology Effects of Trees > By Stratum 

This table provides total estimates of stormwater runoff avoided due to trees by stratum in your 

study area. This table includes estimates for the following: 

• Number of trees 

• Leaf area 

• Potential evapotranspiration 

• Evaporation 

• Transpiration 

• Water intercepted 

• Avoided runoff 

• Avoided runoff value 

 

Oxygen Production of Trees > By Stratum 

This report provides total estimates of oxygen production of trees by stratum in your study area. 

Results are displayed in bar chart and table formats. 

 

Oxygen Production of Trees > By Stratum per Unit Area 

This report provides per area (density) estimates of oxygen production of trees by stratum in your 

study area. Per area estimates are calculated by dividing the total oxygen production in each 

stratum by the area of the stratum. Results are displayed in bar chart and table formats. 

 

Pollution Removal by Trees and Shrubs > Monthly Removal 

This table provides total monthly and annual estimates of pollution removal and associated value 

by the trees and shrubs in your study area. This table displays minimum, maximum, and mean 

pollution removal and value results for the following pollutants: 

• Nitrogen dioxide (NO2) 

• Sulfur dioxide (SO2) 
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• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 

 

(Note: While particulate matter smaller than 10 microns (PM10) is a significant air pollutant, it is not 

included in this analysis because i-Tree Eco analyzes particulate matter less than 2.5 microns 

(PM2.5), which is a subset of PM10. PM2.5 is generally more relevant in discussions concerning air 

pollution effects on human health.) 

 

Pollution Removal by Trees and Shrubs > Monthly Removal (chart display) 

This report provides total monthly estimates of pollution removal and associated value by the trees 

and shrubs in your study area. The report displays charts and tables for the following pollutants: 

• Nitrogen dioxide (NO2) 

• Sulfur dioxide (SO2) 

• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 

 

Several of the charts and tables in this report present pollution removal and the associated value 

for all of the pollutants studied. The remaining charts show pollution removal and value for each 

pollutant individually. (Note: While particulate matter smaller than 10 microns (PM10) is a significant 

air pollutant, it is not included in this analysis because i-Tree Eco analyzes particulate matter less 

than 2.5 microns (PM2.5), which is a subset of PM10. PM2.5 is generally more relevant in discussions 

concerning air pollution effects on human health.) 

 

Pollution Removal by Grass / Herbaceous Material > Monthly Removal 

This table provides total monthly and annual estimates of pollution removal and associated value 
by grasslands (a combination of maintained and wild grass as well as herbaceous) in your study 
area. This table displays minimum, maximum, and mean pollution removal and value results for 
the following pollutants: 

• Nitrogen dioxide (NO2) 

• Sulfur dioxide (SO2) 

• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 

 

(Note: While particulate matter smaller than 10 microns (PM10) is a significant air pollutant, it is not 

included in this analysis because i-Tree Eco analyzes particulate matter less than 2.5 microns 

(PM2.5), which is a subset of PM10. PM2.5 is generally more relevant in discussions concerning air 

pollution effects on human health.) 

 

Pollution Removal by Grass / Herbaceous Material > Monthly Removal (chart display) 

This report provides total monthly estimates of pollution removal and associated value by 
grasslands (a combination of maintained and wild grass as well as herbaceous) in your study area. 
The report displays charts and tables for the following pollutants: 

• Nitrogen dioxide (NO2) 
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• Sulfur dioxide (SO2) 

• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 

 

Several of the charts and tables in this report present pollution removal and the associated value 

for all of the pollutants studied. The remaining charts show pollution removal and value for each 

pollutant individually. (Note: While particulate matter smaller than 10 microns (PM10) is a significant 

air pollutant, it is not included in this analysis because i-Tree Eco analyzes particulate matter less 

than 2.5 microns (PM2.5), which is a subset of PM10. PM2.5 is generally more relevant in discussions 

concerning air pollution effects on human health.) 

 

VOC Emissions of Trees > By Species 

This table provides total estimates of volatile organic compounds (VOC) emissions from the tree 

species in your study area, including monoterpene, isoprene, and the sum of both. 

 

VOC Emissions of Trees > By Stratum 

This table provides total estimates of volatile organic compounds (VOC) emissions of trees by 

strata in your study area, including monoterpene, isoprene, and the sum of both. 

 

UV Effects of Trees > By Stratum 

This table provides estimates of the effects that trees have on the ultraviolet (UV) radiation 

received in your study area. UV radiation is emitted by the sun and while beneficial to humans in 

small doses, can have negative health effects when people are overexposed. The UV index scale 

was developed by the World Health Organization to more easily communicate daily levels of UV 

radiation and alert people to when protection from overexposure is needed most. UV index values 

are estimated from UV radiation and adjusted based on local elevation and cloud cover. Tree 

canopies help to reduce the amount of UV radiation that reaches the ground thus providing people 

with additional protection from the sun’s harmful rays. UV effects are reported in this table for each 

stratum and the study area as a whole and broken into the following results: 

• UV Effects in Tree Shade – changes in UV for a person who is always shaded by tree 

canopy. For example, someone who is sitting under a tree. 

• UV Effects Overall – changes in UV for a person who is in both areas that are shaded by 

tree canopy and areas that are not. For example, someone who is walking down a street 

may find themselves under tree canopy at some times and exposed to full UV radiation at 

others. 

 

Results are additionally reported for the following: 

• Protection factor – a unit-less value meant to capture the UV radiation-blocking capacity of 

trees. It is comparable to the SPF rating in sunscreen and calculated as unshaded UV 

index divided by shaded or overall UV index. 

• Reduction in UV Index – the change in UV index as the result of trees and calculated as 

unshaded UV index minus shaded or overall UV index. 

• Percent reduction – the reduction in UV index expressed as a percent change and 

calculated as the reduction in UV index divided by unshaded UV index. 
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Wildlife Suitability > By Plot 

This table provides estimates of wildlife suitability for each plot in your study area. The suitability 

index reported here is a unit-less value meant to capture the ability of an area to sustain a 

population based on the habitat features that relate to and influence the patterns of abundance of 

each species. Two suitability index values are given for each plot. One value is based on the trees 

that were sampled on the plot and the other value assumes an absence of trees on the plot. The 

index change due to trees is estimated as the following: 

• A relative change calculated as the absolute change (see below) divided by the suitability 

index with trees. 

• An absolute change calculated as the suitability index with trees minus the suitability index 

without trees. 

 

The wildlife species reported here are based on species’ ranges so only those species present in 

the study area will be included in the report. Data is available for up to nine bird species, including 

American robin, Baltimore oriole, black-capped chickadee, Carolina chickadee, European starling, 

northern cardinal, red-bellied woodpecker, scarlet tanager, and wood thrush. 

 

Wildlife Suitability > By Stratum 

This table provides estimates of wildlife suitability for each stratum and your study area as a whole. 

The suitability index reported here is a unit-less value meant to capture the ability of an area to 

sustain a population based on the habitat features that relate to and influence the patterns of 

abundance of each species. Two suitability index values are given for each stratum. One value is 

based on the trees in that stratum and the other value assumes an absence of trees in the stratum. 

The index change due to trees is estimated as the following: 

• A relative change calculated as the absolute change (see below) divided by the suitability 

index with trees. 

• An absolute change calculated as the suitability index with trees minus the suitability index 

without trees. 

 

The wildlife species reported here are based on species’ ranges so only those species present in 

the study area will be included in the report. Data is available for up to nine bird species, including 

American robin, Baltimore oriole, black-capped chickadee, Carolina chickadee, European starling, 

northern cardinal, red-bellied woodpecker, scarlet tanager, and wood thrush. 

 

 

Management Costs > By Expenditure 

This table reports the user-defined expenditures for managing the trees in your study area. From 

the total costs reported, the cost per tree and cost per capita are also estimated and presented in 

this table. Management costs are defined by the user in the Annual Costs function of the Data 

tab. To edit your annual costs, open that function and follow the steps outlined in the Help panel. 

This form can be edited at any time and you will not be required to submit your project again. 

Results on the Reports tab will reflect the change in annual costs immediately. 

 

Net Annual Benefits > Net Annual Benefits for All Trees 

This table reports the economic value of the environmental benefits provided by all of the trees in 
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your study area. The user-defined management costs are reported so that net benefits and 

benefit-cost ratio can be estimated for your study area. From the total benefits and costs reported, 

per tree and per capita estimates are also presented in this table. Management costs are defined 

by the user in the Annual Costs function of the Data tab. To edit your annual costs, open that 

function and follow the steps outlined in the Help panel. This form can be edited at any time and 

you will not be required to submit your project again. Results on the Reports tab will reflect the 

change in annual costs immediately. 

 

Foodscape Benefits of Trees > By Species 

The report seen in the action panel to the right provides information about the characteristics, 

productivity and services provided by edible/useful species of trees.  It is intended to communicate 

the value of this subset of trees in order to guide users in the planning, management and selection 

of the appropriate species. 

Only those species for which data has been gathered are included in the report. Additionally, if an 

entry in the report is blank, no data is currently available for that attribute. In the future, more 

species will be added. These data were gathered by the Community Food Forestry Initiative 

(CFFI). 

 

Measured Tree Details Reports 

 

Composition and Structure > Individual Tree Data 

This table presents a summary of the data collected in the field as well as additional estimated tree 

characteristics for each of the trees sampled in your study area. The table includes estimates for 

the following characteristics: 

• Tree ID 

• Species name 

• Diameter at breast height (DBH) 

• Height 

• Canopy cover 

• Tree condition 

• Leaf area 

• Leaf biomass 

• Leaf area index – estimated by dividing leaf area by canopy cover 

• Basal area 

• Street tree 

• Native to state 

 

For users providing custom classes, refer back to the Condition or Dieback function of the 

Project Configuration tab to see how the default classes displayed here are defined in terms of 

your custom classes. Please be aware that using custom classes makes comparing results across 

projects more difficult and should be done with caution. 

 

Composition and Structure > By Species 

http://inhabit.earth/community-food-forestry/
http://inhabit.earth/community-food-forestry/
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This table presents a summary of the data collected in the field as well as additional estimated tree 

characteristics for each of the species in your study area. The table includes estimates for the 

following characteristics: 

• Tree count 

• Canopy cover 

• Leaf area 

• Leaf biomass 

• Basal area 

 

Composition and Structure > By Stratum 

This table presents a summary of the data collected in the field as well as additional estimated tree 

characteristics for each of the stratum in your study area. The table includes estimates for the 

following characteristics: 

• Tree count 

• Canopy cover 

• Leaf area 

• Leaf biomass 

• Basal area 

 

Benefits and Costs > Individual Tree Benefits Summary 

This table provides a summary of Eco’s benefit estimates, including structural value, energy 

savings, carbon storage and sequestration, avoided runoff, and pollution removal, for each of the 

trees sampled in your study area. 

 

Benefits and Costs > Carbon Storage 

This table provides estimates of carbon storage for each of the trees sampled in your study area. 

The percent contribution to the total carbon storage of all sampled trees is also reported. 

 

Benefits and Costs > Carbon Sequestration 

This table provides estimates of carbon sequestration for each of the trees sampled in your study 

area. The percent contribution to the total carbon sequestration of all sampled trees is also 

reported. 

 

Benefits and Costs > Energy Effects 

This table provides total estimates of the effect of each tree sampled in your study area on energy 

usage. The table includes estimates for the following energy effects: 

• Effect on building energy use (i.e., increases or decreases in the number of MBTUs and 

MWHs used for heating or cooling residential buildings in study area) 

• Value of effects (i.e., values associated with the changes in building energy use) 

 

Benefits and Costs > Hydrology Effects 

This table provides total estimates of the stormwater runoff avoided due to each tree sampled in 

your study area. The table includes estimates for the following: 

• Leaf area 

• Potential evapotranspiration 
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• Evaporation 

• Transpiration 

• Water intercepted 

• Avoided runoff 

• Avoided runoff value 

 

Benefits and Costs > Pollution Removal 

This table presents total estimates of pollution removal, associated pollution removal value, and 

volatile organic compound emissions for each of the trees sampled in your study area. The table 

reports estimates for the following pollutants: 

• Nitrogen dioxide (NO2) 

• Sulfur dioxide (SO2) 

• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 

• Monoterpene 

• Isoprene 

 

(Note: While particulate matter smaller than 10 microns (PM10) is a significant air pollutant, it is not 

included in this analysis because i-Tree Eco analyzes particulate matter less than 2.5 microns 

(PM2.5), which is a subset of PM10. PM2.5 is generally more relevant in discussions concerning air 

pollution effects on human health.) 

 

Benefits and Costs > Oxygen Production 

This table provides total estimates of the oxygen production of each tree sampled in your study 

area. 

 

Benefits and Costs > VOC Emissions 

This table provides total estimates of the volatile organic compounds (VOC) emissions of each tree 

sampled in your study area, including monoterpene, isoprene, and the sum of both. 

Air Quality and Public Health Reports 

 

These reports provides estimates of the number of adverse health incidents that were avoided due 

to changes in pollutant concentration levels attributed to trees, shrubs, and grass. The estimates in 

the tables reflect the population of your study area. The dollar values reflect the economic value of 

those reductions in health incidents. The same health effects are not necessarily analyzed for each 

pollutant. Blank values indicate that incidence reduction and value are not estimated for that 

pollutant and health effect. For example, acute bronchitis is only estimated for particulate matter 

less than 2.5 microns (PM2.5) 

 

Pest Analysis Reports (USA only) 
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Susceptibility to Pests > By Stratum 

This table displays results for 36 pests and diseases (USA only). Results are reported as the 

number of trees by strata that are susceptible or not susceptible to each pest. Structural value and 

leaf area are also estimated based on the number of trees. 

 

Primary Pest > Impacts by Stratum 

This table displays results for the pests that were detected in your study area (based on signs and 

symptoms reported following the Pest Detection Module protocol). 

 

Primary Pest > Impacted Tree Details 

This table displays results for the pests that were detected in your study area (based on signs and 

symptoms reported following the Pest Detection Module protocol). 

 

Signs & Symptoms > Totals by Species 

This table displays the percent of trees that are affected by pests for each tree species sampled 

(based on signs and symptoms reported following the Pest Detection Module protocol). 

 

Signs & Symptoms > Summaries by Species 

This table displays the percent of trees that exhibit a condition for each tree species sampled 

(based on signs and symptoms reported following the Pest Detection Module protocol). The table 

shows a summary of the more detailed results as well as the percent of trees affected by each sign 

or symptom for each of the tree species sampled. 

 

Signs & Symptoms > Details by Species 

This table displays the percent of trees that exhibit a condition for each tree species sampled 

(based on signs and symptoms reported following the Pest Detection Module protocol). The table 

shows the complete detailed results as well as the percent of trees affected by each sign or 

symptom for each of the tree species sampled. 

 

 

 

Reports summarizing documented signs and symptoms of tree pests and 

diseases require the collection of additional pest data. Please refer back to 

Phase III: Collecting Your Field Data for more information on the 

requirements for the supplemental pest analysis. 

Tip 

 

 

The susceptibility report does not reflect field-collected data about actual risks 

and harm, but rather calculates the damage from a potential outbreak based 

on species diversity in your population. This susceptibility report will continue 

to be fully functional whether or not you choose to collect the supplemental 

pest detection data. 

 

Tip 
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Signs & Symptoms > Totals by Stratum 

This table displays the percent of trees that are affected by pests in each stratum (based on signs 

and symptoms reported following the Pest Detection Module protocol). 

 

Signs & Symptoms > Summaries by Stratum 

This table displays the percent of trees that exhibit a condition for each stratum (based on signs 

and symptoms reported following the Pest Detection Module protocol). The table shows a 

summary of the more detailed results as well as the percent of trees affected by each sign or 

symptom for each stratum. 

 

Signs & Symptoms > Details by Stratum 

This table displays the percent of trees that exhibit a condition for each stratum (based on signs 

and symptoms reported following the Pest Detection Module protocol). The table shows the 

complete detailed results as well as the percent of trees affected by each sign or symptom for 

each stratum. 

 

Signs & Symptoms > Impacted Tree Finder 

This table is an interactive display that allows you to choose which pest signs and symptoms you 

are most interested in. 

 

Pest Review > Of Assessed Trees 

This table is an interactive display that allows you to choose which pest you are most interested in 

and view the tree species that exhibit the signs and symptoms associated with that pest. 

 

 

 

 

Pollution and Weather Reports 

 

Raw and Source Data > Air Pollutant Concentration 

This report displays the hourly pollution concentration based on air quality data. Results are 

displayed in line chart and table formats for the user-designated pollution year. Estimates are 

reported for the following pollutants: 

• Nitrogen dioxide (NO2) 

• Sulfur dioxide (SO2) 

• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 

 

Raw and Source Data > Photosynthetically Active Radiation 

This report displays the hourly photosynthetically active radiation based on weather data. Results 

are displayed in line chart and table formats for the user-designated weather year. 

 

Raw and Source Data > Rain 
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This report displays the hourly precipitation based on weather data. Results are displayed in line 

chart and table formats for the user-designated weather year. 

 

Raw and Source Data > Temperature 

This report displays hourly air temperature based on weather data. Results are displayed in line 

chart and table formats for the user-designated weather year. 

 

Raw and Source Data > UV Index 

This report displays the daily ultraviolet (UV) index in your study area. UV radiation is emitted by 

the sun and while beneficial to humans in small doses, can have negative health effects when 

people are overexposed. The UV index scale was developed by the World Health Organization to 

more easily communicate daily levels of UV radiation and alert people to when protection from 

overexposure is needed most. UV index values are estimated from UV radiation and adjusted 

based on local elevation and cloud cover. Results are displayed in line chart and table formats. UV 

data is from the same year as the user-designated weather and pollution year. It is presented as a 

daily value at solar noon when the sun is highest in the sky. 

 

Air Quality Improvement > By Trees 

This report displays hourly air quality improvement provided by the tree cover in your study area. 

Results are displayed in line chart and table formats for the user-designated pollution year. 

Estimates are reported for the following pollutants: 

• Nitrogen dioxide (NO2) 

• Sulfur dioxide (SO2) 

• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 

 

Air Quality Improvement > By Shrubs 

This report displays hourly air quality improvement provided by the shrub cover in your study area. 

Results are displayed in line chart and table formats for the user-designated pollution year. 

Estimates are reported for the following pollutants: 

• Nitrogen dioxide (NO2) 

• Sulfur dioxide (SO2) 

• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 

 

Air Quality Improvement > By Grass / Herbaceous Material 

The report seen in the action panel to the right displays the hourly dry deposition of air pollutants 
per unit of grass / herbaceous cover. This report displays results in line chart and table formats for 
the user-designated pollution year. Estimates are reported for the following pollutants: 

• Nitrogen dioxide (NO2) 

• Sulfur dioxide (SO2) 

• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 
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Air Pollutant Flux (Dry Deposition) > Per Unit Tree Cover 

This report displays hourly dry deposition of air pollutants per unit of tree cover. Results are 

displayed in line chart and table formats for the user-designated pollution year. Estimates are 

reported for the following pollutants: 

• Nitrogen dioxide (NO2) 

• Sulfur dioxide (SO2) 

• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 

 

Air Pollutant Flux (Dry Deposition) > Per Unit Shrub Cover 

This report displays hourly dry deposition of air pollutants per unit of shrub cover. Results are 

displayed in line chart and table formats for the user-designated pollution year. Estimates are 

reported for the following pollutants: 

• Nitrogen dioxide (NO2) 

• Sulfur dioxide (SO2) 

• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 

 

 

Air Pollutant Flux (Dry Deposition) > Per Unit Grass / Herbaceous Cover 

The report seen in the action panel to the right displays the hourly dry deposition of air pollutants 
per unit of grass / herbaceous cover. This report displays results in line chart and table formats for 
the user-designated pollution year. Estimates are reported for the following pollutants: 

• Nitrogen dioxide (NO2) 

• Sulfur dioxide (SO2) 

• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 

Transpiration > By Trees 

This report displays hourly transpiration by trees. Transpiration is the amount of water moved 

through plants and released to the atmosphere. Results are displayed in line chart and table 

formats for the user-designated weather year. 

 

 

Transpiration > By Shrubs 

This report displays hourly transpiration by shrubs. Transpiration is the amount of water moved 

through plants and released to the atmosphere. Results are displayed in line chart and table 

formats for the user-designated weather year. 

 

Evaporation > By Trees 

This report displays the hourly evaporation by trees. Evaporation is the amount of water that is 
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released to the atmosphere from the plant’s surface. Results are displayed in line chart and table 

formats for the user-designated weather year. 

 

Evaporation > By Shrubs 

This report displays the hourly evaporation by shrubs. Evaporation is the amount of water that is 

released to the atmosphere from the plant’s surface. Results are displayed in line chart and table 

formats for the user-designated weather year. 

 

Water Intercepted > By Trees 

This report displays the hourly water interception by trees. Water intercepted is the amount of 

rainfall that fell on plants and was intercepted by the plant’s leaves. This water is eventually 

evaporated to the atmosphere. Results are displayed in line chart and table formats for the user-

designated weather year. 

 

Water Intercepted > By Shrubs 

This report displays the hourly water interception by shrubs. Water intercepted is the amount of 

rainfall that fell on plants and was intercepted by the plant’s leaves. This water is eventually 

evaporated to the atmosphere. Results are displayed in line chart and table formats for the user-

designated weather year. 

 

 

Avoided Runoff > By Trees 

This report displays the hourly avoided runoff by trees. Avoided runoff is the amount of water that 

would become surface runoff to streams, but does not. Estimates incorporate water interception by 

plants, ground depression storage, infiltration on pervious ground covers, and overland flow on 

impervious ground covers. Results are displayed in line chart and table formats for the user-

designated weather year. 

 

Avoided Runoff > By Shrubs 

This report displays the hourly avoided runoff by shrubs. Avoided runoff is the amount of water that 

would become surface runoff to streams, but does not. Estimates incorporate water interception by 

plants, ground depression storage, infiltration on pervious ground covers, and overland flow on 

impervious ground covers. Results are displayed in line chart and table formats for the user-

designated weather year. 

 

Potential Evapotranspiration > By Trees 

This report displays the hourly potential evapotranspiration by trees. Potential evapotranspiration is 

the sum of the evaporation from the soil and the transpiration from plants that would occur if an 

unlimited amount of water were available. Results are displayed in line chart and table formats for 

the user-designated weather year. 

 

Potential Evapotranspiration > By Shrubs 

This report displays the hourly potential evapotranspiration by shrubs. Potential evapotranspiration 

is the sum of the evaporation from the soil and the transpiration from plants that would occur if an 

unlimited amount of water were available. Results are displayed in line chart and table formats for 

the user-designated weather year. 
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UV Index Reduction by Trees > Effects in Tree Shade 

This report displays the daily reduction in UV index by trees in your study area. Ultraviolet (UV) 

radiation is emitted by the sun and while beneficial to humans in small doses, can have negative 

health effects when people are overexposed. The UV index scale was developed by the World 

Health Organization to more easily communicate daily levels of UV radiation and alert people to 

when protection from overexposure is needed most. UV index values are estimated from UV 

radiation and adjusted based on local elevation and cloud cover. Tree canopies help to reduce the 

amount of UV radiation that reaches the ground thus providing people with additional protection 

from the sun’s harmful rays. Effects in tree shade are changes in UV for a person who is always 

shaded by tree canopy. For example, someone who is sitting under a tree. Reduction in UV Index 

in tree shade is calculated as unshaded UV index minus shaded UV index. Results are displayed 

in line chart and table formats. UV data is from the same year as the user-designated weather and 

pollution year. It is presented as a daily reduction at solar noon when the sun is highest in the sky. 

 

UV Index Reduction by Trees > Effects Overall 

This report displays the daily reduction in UV index by trees in your study area. Ultraviolet (UV) 

radiation is emitted by the sun and while beneficial to humans in small doses, can have negative 

health effects when people are overexposed. The UV index scale was developed by the World 

Health Organization to more easily communicate daily levels of UV radiation and alert people to 

when protection from overexposure is needed most. UV index values are estimated from UV 

radiation and adjusted based on local elevation and cloud cover. Tree canopies help to reduce the 

amount of UV radiation that reaches the ground thus providing people with additional protection 

from the sun’s harmful rays. Overall effects are changes in UV for a person who is in both areas 

that are shaded by tree canopy and areas that are not. For example, someone who is walking 

down a street may find themselves under tree canopy at some times and exposed to full UV 

radiation at others. Reduction in UV Index overall is calculated as unshaded UV index minus 

overall UV index. Results are displayed in line chart and table formats. UV data is from the same 

year as the user-designated weather and pollution year. It is presented as a daily reduction at solar 

noon when the sun is highest in the sky. 

 

Isoprene > By Trees 
The table and chart seen in the action panel to the right provides total estimates of the isoprene 
emissions of trees sampled in your study area as oz / hr. 
 
 
Isoprene > By Shrubs 
The table and chart seen in the action panel to the right provides total estimates of the isoprene 
emissions of shrubs measured in your study area as oz / hr. 
 
Monoterpene > By Trees 
The table and chart seen in the action panel to the right provides total estimates of the isoprene 
emissions of trees sampled in your study area as oz / hr. 
 
Monoterpene > By Shrubs 
The table and chart seen in the action panel to the right provides total estimates of the isoprene 
emissions of shrubs measured in your study area as oz / hr. 
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Model Notes 

 

This report provides more information about the data processing that occurs within the Eco model. 

For example, notes here may indicate that energy data collected for a specific tree was invalid and 

therefore the estimated energy effects do not include that specific tree. The key below the 

processing notes can be used to decipher any errors that occurred and determine how to resolve 

them. 

 

 

 
The standard reports provided by Eco can easily be saved or printed so you can make use of them 
outside the application. After opening a report, a toolbar will become available in the action panel 
of the Eco window. Reports can be saved in pdf, xlsx, xls, rtf, or docx format.   
 

Pack Project 

 

The Pack Project option allows you to create a zip folder that includes all the necessary 

information to transfer your Eco project from one computer to another or to share the project with 

another user. To begin the process: 

 

1 Click File > Pack Project. 

2 Browse to the folder where you would like to save your zip file, enter a file name, and click 

Save. 

 

To unpack the project on the new computer: 

 
1 Navigate to the folder where you saved your zip file. 

2 Right-click on the zip file and extract files. 

The project can now be accessed from the Eco application by opening the project file. 

 

  

 Sharing Your Project 
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i-Tree Eco 

 

The user interface of the i-Tree Eco program is organized as shown below. Throughout the help 

text and User’s Manual, there will be references to the various features explained here. 

 

Features: 

1 File menu – This drop-down menu provides options to start a new project, open an existing 

project, save your project, etc. 

2 Tabs – i-Tree Eco has six tabs to choose from that bring up specific functions in the ribbon. 

Tab options include: 

• Project Configuration 

• Data 

• View 

• Reports 

Glossary 

1 2 

3 
5 

4 

6 7 
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• Forecast 

• Support 

3 Ribbon – The ribbon bar provides access to the groups and functions that are available for 

each selected tab. 

4 Group – Similar functions are organized into each group. 

5 Function – The various buttons or drop-down lists in the ribbon make project settings, data 

entry, and report features available in the action panel. 

6 Action Panel – This is where you input and edit your project settings and data, as well as 

view reports. 

7 Info Panel – This is where you can view help text for the many features of i-Tree Eco. The 

panel can be minimized and maximized as desired. 

 

Resource Structure 

 

Condition – Relating to the tree crown health (e.g., poor condition, good, dead/dying). This 

variable is assessed in the field by identifying a tree’s crown condition or dieback. 

 

Diameter at breast height (DBH) – The diameter of the tree stem measured at 1.37 meters 

above planted grade (breast height). 

 

Importance value (IV) –Relating to the dominance of a tree species in the urban forest. 

Importance value is calculated as the sum of the percent population and percent leaf area.  High 

importance values do not mean that these trees should necessarily be encouraged in the future; 

rather these species currently dominate the urban forest structure. 

 

Leaf area – The total one-sided surface area contributed by all of the leaves on the trees. Leaf 

area is estimated using measurements of crown dimensions and percentage of crown canopy 

missing. 

 

Leaf area index (LAI) – The total one-sided leaf surface area per unit of ground surface area. Leaf 

area index is estimated by dividing the leaf area by the ground area. Higher LAIs indicate a greater 

number of leaves per unit of ground area. 

 

Leaf biomass – The total living mass contributed by all of the leaves on the sampled trees. 

 

Origin – Relating to the continent or region that a particular tree species is native to (i.e., where 

the species developed or occurs naturally). 

 

Rarefaction – A technique used for assessing species richness of a sample of trees. Using this 

technique, species richness in estimated by plotting the number of species against the number of 

samples to create rarefaction curves. For i-Tree, the value produced using the rarefaction 

technique is the number of species one would expect to find if 4 trees were sampled in each 

stratum. For the entire study area, this value is the number of species one would expect to find if 

250 trees were sampled within the study area. 
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Species diversity – The number of different species that are represented in the study area. 

Species diversity takes into account both species richness and species evenness. 

 

Species dominance – A measure of the degree to which a species is more numerous than others 

or contributes more of the total biomass. 

 

Species evenness – A measure of how closely matched the numbers of each species are to each 

other. 

 

Species richness – The number of different species that are represented in the study area. 

 

Ecosystem Services 

 

Avoided runoff – A measure of the stormwater runoff that is avoided because of rainfall 

interception by trees, which partially intercept precipitation on their leaves and other surfaces. 

Avoided runoff is estimated by comparing the hourly precipitation processes and total annual 

surface runoff volume modeled for the study area as it occurs with trees present and as it would 

occur if there were no trees. 

 

VOC Emissions – A measure of the volatile organic compounds (VOC) released. Trees release 

VOC emissions, specifically isoprene and monoterpene, which can contribute to the formation of 

ozone and carbon monoxide. The amount of emissions depends on tree species, leaf, biomass, air 

temperature, and other environmental factors.  

 

Carbon sequestration – A measure of the carbon (in the form of carbon dioxide) that is removed 

from the atmosphere by trees. 

• Gross sequestration – A measure of the carbon sequestered by trees calculated as the 

difference in estimates of carbon storage between Year X and Year X +1. 

• Net sequestration – A measure of the carbon sequestered by trees calculated as the gross 

carbon sequestered minus the carbon emissions due to decomposition after tree death. 

 

Carbon storage – A measure of the carbon that is stored within trees. This is the amount of 

carbon that is bound up in both the above-ground and below-ground parts of woody vegetation. 

 

Energy effects – A measure of the seasonal effects of trees on residential building energy use 

and consequent emissions from power plants. Energy effects are estimated based on tree 

distance and direction to residential structures, tree height, and tree condition. 

• Energy use – Increases or decreases in the number of MBTUs and MWHs used for heating 

or cooling residential buildings that are affected by trees, which affect energy use by 

modifying local the immediate climate, producing shade, and reducing wind speeds. 

• Emissions – Increases or decreases in carbon emissions from power plants as a result of 

changes in energy use. 

 

Evaporation – The amount of water that is released to the atmosphere from the plant’s surface. 
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Oxygen production – A measure of the oxygen produced by trees during photosynthesis, taking 

into account the amount consumed during plant respiration. This net oxygen production is 

calculated from carbon sequestration estimates based on atomic weight. 

 

Pollution removal – A measure of the air pollution that is removed from the atmosphere by trees. 

Pollution removal is calculated for nitrogen dioxide (NO2), sulfur dioxide (SO2), ozone (O3), carbon 

monoxide (CO), and particulate matter less than 2.5 microns (PM2.5). Trees remove gaseous air 

pollution primarily by uptake via leaf stomata, though some gases are removed by the plant 

surface. Trees also remove pollution by intercepting airborne particles. Some particles can be 

absorbed into the tree, though most particles that are intercepted are retained on the plant surface. 

 

Potential evapotranspiration – The sum of the evaporation from the soil and the transpiration 

from plants that would occur if an unlimited amount of water were available. 

 

Transpiration – The amount of water moved through plants and released to the atmosphere. 

 

UV index – Ultraviolet (UV) radiation is emitted by the sun and while beneficial to humans in small 

doses, can have negative health effects when people are overexposed. The UV index scale was 

developed by the World Health Organization to more easily communicate daily levels of UV 

radiation and alert people to when protection from overexposure is needed most. 

 

Water intercepted – The amount of rainfall that fell on plants and was intercepted by the plant’s 

leaves. This water is eventually evaporated to the atmosphere. 

 

Values 

 

Avoided runoff value – A functional value provided by the trees (i.e., a value that results from an 

environmental function of trees). This is the monetary value of stormwater runoff that is avoided 

because of rainfall interception by trees. This value is estimated based on the economic damages 

associated with runoff and costs of stormwater control. 

 

Carbon sequestration value - A functional value provided by the trees (i.e., a value that results 

from an environmental function of trees). This is the monetary value associated with tree effects on 

atmospheric carbon. This value is estimated based on the economic damages associated with 

increases in carbon or carbon dioxide emissions. 

 

Carbon storage value – A structural value based on the tree itself. This is the monetary value 

associated with tree effects on atmospheric carbon. This value is estimated based on the 

economic damages associated with increases in carbon or carbon dioxide emissions. 

 

Compensatory value – A structural value based on the tree itself. The compensatory value is 

based on the cost of having to replace a tree with a similar tree. 

 

Energy effects value – A functional value provided by the trees (i.e., a value that results from an 

environmental function of trees). 
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• Energy use – The monetary value of increased or decreased energy costs as a result of a 

tree’s effect on residential building energy use. This value is estimated based on the dollar 

value per MBTU or MWH. 

• Emissions – The monetary value of increases or decreases in carbon emissions from 

power plants as a result of changes in energy use. This value is estimated based on the 

economic damages associated with increases in carbon or carbon dioxide emissions. 

 

Pollution removal value – A functional value provided by the trees (i.e., a value that results from 

an environmental function of trees). This is the monetary value associated with tree effects on 

atmospheric pollution. This value is estimated based on the economic damages associated with 

increases in pollution emissions and/or the impact of air pollution on human health. 
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i-Tree is a state-of-the-art, peer-reviewed software suite from the USDA Forest Service that 

provides urban and community forestry analysis and benefit assessment tools. The i-Tree tools 

help communities of all sizes to strengthen their urban forest management and advocacy efforts 

by quantifying the environmental services that trees provide and assessing the structure of the 

urban forest. 

 

i-Tree has been used by communities, non-profit organizations, consultants, volunteers, and 

students to report on the urban forest at all scales from individual trees to parcels, neighborhoods, 

cities, and entire states. By understanding the local, tangible ecosystem services that trees 

provide, i-Tree users can link urban forest management activities with environmental quality and 

community livability. Whether your interest is a single tree or an entire forest, i-Tree provides 

baseline data that you can use to demonstrate value and set priorities for more effective decision-

making. 

 

Developed by the USDA Forest Service and numerous cooperators, i-Tree is in the public domain 

and available by request through the i-Tree website (www.itreetools.org). The Forest Service, 

Davey Tree Expert Company, Arbor Day Foundation, Society of Municipal Arborists, International 

Society of Arboriculture, Casey Trees, and State University of New York College of Environmental 

Science and Forestry have entered into a cooperative partnership to further develop, disseminate, 

and provide technical support for the suite. 

 

 

The use of trade, firm, or corporation names in this publication is solely for the information and 

convenience of the reader. Such use does not constitute an official endorsement or approval by 

the U.S. Department of Agriculture or the Forest Service of any product or service to the 

exclusion of others that may be suitable. The software distributed under the label “i-Tree 2017 

Suite” is provided without warranty of any kind. Its use is governed by the End User License 

Agreement (EULA) to which the user agrees before installation. 

 

 

The i-Tree Development Team actively seeks feedback on any component of the project: the 

software suite itself, the manuals, or the process of development, dissemination, support, and 

refinement. Please send comments through any of the means listed on the i-Tree support page: 

www.itreetools.org/support/. 

  

About i-Tree 

 Disclaimer 

 Feedback 

http://www.itreetools.org/
http://www.itreetools.org/support/
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The 2019 i-Tree software international suite includes the following urban forest analysis tools and 

utility programs: 

 

 

i-Tree Eco provides a broad picture of the urban forest or trees in your study area. It is designed 

to use field data from complete inventories of trees or randomly located plots throughout a 

community along with local hourly air pollution and meteorological data to quantify urban forest 

structure, environmental effects, and value to communities. 

 

i-Tree Hydro is the first vegetation-specific urban hydrology model. It is designed to model the 

effects of changes in urban tree cover and impervious surfaces on hourly stream flows and water 

quality at the watershed level. 

 

 

 

i-Tree Canopy offers a quick and easy way to produce a statistically valid estimate of land cover 

types (e.g., tree cover) using aerial images available in Google Maps. The data can be used by 

urban forest managers to estimate tree canopy cover, set canopy goals, and track success; and to 

estimate inputs for use in i-Tree Hydro and elsewhere where land cover data are needed. Canopy 

also estimates tree benefits based on the amount of tree cover in your study area (US only). 

 

i-Tree Species is designed to help users select the most appropriate tree species based on the 

species potential environmental services and geographic area. Users select and rank the 

importance (0-10) of each environmental service desired from trees. The program then 

calculates the best tree species based on the user-provided weighting of environmental benefits 

of tree species at maturity. 

 

i-Tree Database is an online system designed for international users outside of the United States, 

Canada, Mexico, Australia United Kingdom and Europe, to submit properly formatted international 

pollution and weather data, location information, new species information, and other requirements 

needed for the i-Tree Eco model to process in a new, previously unsupported study area. The 

submitted information will be vetted by the U.S. Forest Service and integrated into the Eco model 

as a new international location that would be available for automated processing in future updates 

of Eco.  

i-Tree Products 

 Desktop Applications 

 Web Applications  

https://www.itreetools.org/eco/index.php
https://www.itreetools.org/hydro/index.php
https://canopy.itreetools.org/
https://species.itreetools.org/
http://www.itreetools.org/database/
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Components of the i-Tree software suite have been developed over the last few decades by the 

U.S. Forest Service and numerous cooperators. Support for the development and release of the 

2019 i-Tree software suite has come from USDA Forest Service Research, State and Private 

Forestry, and their cooperators through the i-Tree Cooperative Partnership of the Davey Tree 

Expert Company, Arbor Day Foundation, Society of Municipal Arborists, International Society of 

Arboriculture, Casey Trees, and State University of New York College of Environmental Science 

and Forestry. 

 

i-Tree Eco 

 

i-Tree Eco is an adaptation of the Urban Forest Effects (UFORE) model, which was cooperatively 

developed by the U.S. Forest Service Northern Research Station (NRS), USDA State and Private 

Forestry's Urban and Community Forestry Program and Northeastern Area, Davey Tree Expert 

Company, and SUNY College of Environmental Science and Forestry.  

 
The UFORE model was conceived and developed by David J. Nowak and Daniel E. Crane (USFS, 

NRS), and Patrick McHale (SUNY-ESF). The UFORE software was designed and developed by 

Daniel E. Crane and its graphical user interface (GUI) by Lianghu Tian and Mike Binkley (The 

Davey Institute). Many individuals contributed to the design and development process of the 

UFORE application including Mike Binkley (The Davey Institute), Jaewon Choi (SUNY-ESF), 

Daniel E. Crane (NRS), Greg Ina (The Davey Institute), Robert E. Hoehn (NRS), Jerry Bond and 

Christopher J. Luley (Urban Forestry LLC), Patrick McHale (SUNY-ESF), David J. Nowak (NRS), 

Jack C. Stevens (NRS), Lianghu Tian (The Davey Institute), Jeffrey T. Walton (Paul Smiths 

College), and Robert Sacks (Bluejay Software).  

 
New modeling functions, desktop processing capabilities, and updates for i-Tree Eco versions 

were developed and integrated by members of the USFS-NRS and The Davey Institute based on 

newly available research from NRS and feedback from i-Tree users. i-Tree Eco Development 

Team members and contributors include Satoshi Hirabayashi, Alexis Ellis, Daniel Crane, Lianghu 

Tian, Megan Kerr, David Ellingsworth, Allison Bodine, Daniel Vicarel, Mike Binkley, Al Zelaya, 

Jason Henning, Scott Maco, Heidi Siciliano, Michael Leff, Emmanuel Ong, Vidmantas 

Steponavicius, Robert Coville, Arielle Conti, and Erika Teach. 

 

International Support 

 

Many people have contributed to the development of i-Tree Eco to make the application functional 

for users in Canada, Mexico, Australia, the United Kingdom and Europe. Data for the Australian 

enhancements were provided, in part, by Craig Hallam and Chris Spencer (ENSPEC Environment 

and Risk) and with funding from Arboriculture Australia. Andy Kenney (University of Toronto) 

helped facilitate data acquisition for Canada. Kenton Rogers, Keith Sacre (Treeconomics), and 
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